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Prologue
Welcome

Welcome to Geing Started with Ubuntu, an introductory guide wrien to
help new users get started with Ubuntu.

Our goal is to cover the basics of Ubuntu (su as installation and working
with the desktop) as well as guide you through some of the most popular
applications. We designed this guide to be simple to follow with step-by-
step instructions and plenty of screenshots, allowing you to discover the
potential of your new Ubuntu system even if you are a novice computer user
or migrating from another operating system for the first time.

Please bear in mind that this guide is still very mu a work in progress
and always will be. It is wrien specifically for Ubuntu . lts, and al-
though we have tried to not limit our instructions to this version it is un-
avoidable that some things will ange over the life of Ubuntu. Whenever a
new version of Ubuntu is released, we will incorporate these anges and also
make available a new version of this guide.

Geing Started with Ubuntu . is not intended to be a comprehensive
Ubuntu instruction manual. It is more like a qui-start guide that will get
you doing the things you need to do with your computer quily and easily,
without geing bogged down in tenical details.

If you are aer more detail, there are excellent resources available at http:
//help.ubuntu.com. Ubuntu’s built-in system documentation is also very
useful for accessing help on specific topics, and can be found by cliing
System ‣Help and Support in Ubuntu. If something isn’t covered here,
ances are you will find the information you are looking for in one of those
locations. We will try our best to include links to more detailed help wherever
we can. More information about the online docs and

the system docs can be found in Chapter :
Learning more.

Ubuntu philosophy

e term “Ubuntu” is a traditional African concept that originated from the
Bantu languages of southern Africa. It can be described as a way of connect-
ing with others—living in a global community where your actions affect all
of humanity. Ubuntu as we know it is more than just an operating system:
it is a community of people that come together voluntarily to collaborate on
an international soware project that aims to deliver the best possible user
experience.

http://help.ubuntu.com
http://help.ubuntu.com
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The Ubuntu promise

As taken from the Ubuntu website, http://ubuntu.com.

‣ Ubuntu will always be free of arge, along with its regular enterprise
releases and security updates.

‣ Ubuntu comes with full commercial support from Canonical and hundreds
of companies from across the world.

‣ Ubuntu provides the best translations and accessibility features that the
free soware community has to offer.

‣ Ubuntu core applications are all free and open source. We want you to use
free and open source soware, improve it and pass it on.

A brief history of Ubuntu

Ubuntu was conceived in  by Mark Shuleworth, a successful South
African entrepreneur, and his company Canonical. Shuleworth recognized
the power of Linux and Open Source, but was also aware of weaknesses that
prevented mainstream use. Canonical, the financial backer of Ubuntu,

provides support for the core Ubuntu sys-
tem. Canonical has  paid staff members
worldwide who ensure that the founda-
tion of the operating system is stable, and
also check all the work submied by vol-
unteer contributors. To learn more about
Canonical, go to http://www.canonical.com.

Shuleworth set out with clear intentions to address these weaknesses
and create a system that was easy to use, completely free (see Chapter :
Learning more for the complete definition of “free”), and could compete with
other mainstream operating systems. With the Debian system as a base,
Shuleworth began to build Ubuntu. Using his own funds at first, installation
CDs were pressed and shipped worldwide at no cost to the end user. Ubuntu
spread quily and the size of the community rapidly increased, and it soon
became the most popular Debian-based Linux distribution.

Now with more people working on the project than ever before, Ubuntu
continues to see improvement to its core features and hardware support,
and has gained the aention of large organizations worldwide. For example
in , Dell began a collaboration with Canonical to sell computers with
Ubuntu pre-installed. Additionally in , the Fren Police began to tran-
sition their entire computer infrastructure to a variant of Ubuntu; a process
whi has reportedly saved them “millions of Euro” in Windows licensing
fees. By the year , the Fren Police expect that all of their computers will
be running Ubuntu. Canonical profits from this arrangement by providing
tenical support and custom-built soware. For information on Ubuntu Server Edition,

and how you can use it in your company,
visit http://www.ubuntu.com/products/
whatisubuntu/serveredition/features.

While large organizations oen find it useful to pay for support services,
Shuleworth has promised that the Ubuntu desktop system will always be
free. As of , Ubuntu Desktop is installed on nearly % of the world’s
computers. is equates to millions of users worldwide—and is growing ea
year.

http://ubuntu.com
http://www.canonical.com
http://www.ubuntu.com/products/whatisubuntu/serveredition/features
http://www.ubuntu.com/products/whatisubuntu/serveredition/features
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What is Linux?
Ubuntu is built on the foundation of Linux, whi is a member of the Unix
family. Unix is one of the oldest types of operating systems and has provided
reliability and security in professional applications for almost half a century.
Many servers around the world that store data for popular websites (su as
YouTube and Google.com) run some variant of a Unix system. Whilst modern graphical desktop envi-

ronments have generally replaced early
command-line based operating systems,
the command-line can still be a quick and
efficient way of performing many tasks. See
Chapter : The Command Line for more
information, and Chapter : The Ubuntu
Desktop to learn more about GNOME and
other desktop environments.

Linux was designed from the ground up with security and hardware com-
patibility in mind, and is currently the most popular Unix-based operating
systems. One of the benefits of Linux is that it is incredibly flexible and
can be configured to run on almost any device, from the smallest micro-
computers and cellphones, to larger super-computers. Initially, Unix was
entirely command-line based, until Graphical User Interfaces (guis) began to
emerge in the early s.

ese early guis were difficult to configure and clunky at best, and gener-
ally only used by seasoned computer programmers. In the past decade how-
ever, Graphical User Interfaces have come a long way in terms of usability,
reliability and appearance. Ubuntu is just one of many different Linux dis-
tributions, and uses one of the more popular graphical desktop environments
called GNOME. A Desktop Environment is a sophisticated

and integrated User Interface that provides
the basis for humans to interact with a
computer using a monitor, keyboard and a
mouse.

Is Ubuntu right for you?
New users to Ubuntu may find that it takes some time to feel comfortable
with the operating system. You will no doubt notice some similarities to both
Microso Windows and Mac OS X, as well as some things that work very
differently. Users coming from Mac OS X are more likely to notice similarities
due to the fact that both OS X and Ubuntu originated from Unix.

Before you decide whether or not Ubuntu is right for you, we suggest
giving yourself some time to grow accustomed to the way things are done
—and expect to find some things that are different to what you are used to.
We also suggest taking the following into account: A popular forum for Ubuntu discussion

and support is the Ubuntu Forums, http:
//ubuntuforums.org.‣ Ubuntu is community based. at is, Ubuntu is made, developed and

maintained by the community. Because of this, support is probably not
available at your local computer store. ankfully, the community is here
to help. ere are a lot of articles, guides, and manuals available, as well as
users on various Internet forums and Internet Relay Chat (irc) rooms that
are willing to help out beginners. Additionally, near the end of this guide
we include a troubleshooting apter: Chapter : Troubleshooting.

‣ Many Windows or Mac applications will not run on Ubuntu. For
the vast majority of tasks that people use their computers for everyday,
there are suitable alternative applications available in Ubuntu. However
many professional applications (su as the Adobe Creative suite) are not
developed to work with Ubuntu. If you rely on commercial soware that is

http://ubuntuforums.org
http://ubuntuforums.org
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not compatible with Ubuntu, yet still want to give Ubuntu a try you may
want to consider dual-booting. See Chapter : Soware Management to

learn more about the Soware Center. To
learn more about dual-booting (running
Ubuntu side-by-side with another operating
system), see Chapter : Installation. For
more information on Wine, go to http:
//www.winehq.org/.

‣ Many commercial games will not run on Ubuntu. If you are a heavy
gamer, then Ubuntu may not be for you. Game developers usually design
games for the largest market, where they can make the most profit. Since
Ubuntu’s market share is not as great as Windows or Mac, most game
developers will not allocate resources towards making their games compat-
ible with Ubuntu. If you just like to play a game every now and then, there
is active game development within the community, and many high quality
games can be easily installed through the Soware Center. Additionally,
some games developed for Windows will work in Ubuntu with a program
calledWine.

Contact details
Many people have contributed their time freely to this project. If you notice
any errors or think we have le something out, feel free to contact us. We will
do everything we can to make sure that this manual is up to date, informative
and professional. Our contact details are as follows:

e Ubuntu Manual Team
Website: http://www.ubuntu-manual.org/
Email: ubuntu-manual@lists.launchpad.net
IRC: #ubuntu-manual on irc.freenode.net

Conventions

http://www.winehq.org/
http://www.winehq.org/
http://www.ubuntu-manual.org/
ubuntu-manual@lists.launchpad.net
irc.freenode.net


 Installation
Geing Ubuntu
Before you can get started with Ubuntu, the first thing you will need to do is
get hold of the Ubuntu installation CD. ere are several options available to
you for obtaining a copy of the CD, as follows. Many companies (such as Dell and Sys-

tem) sell computers with Ubuntu prein-
stalled. If you already have Ubuntu installed
on your computer, feel free to skip to
Chapter : The Ubuntu Desktop.

Downloading Ubuntu
e easiest and most common method for geing Ubuntu is to download the
Ubuntu CD image directly from http://www.ubuntu.com. Simply head to the
website and cli the “Download Ubuntu” buon at the top. You will be asked
to select a download location, and then cli the “Begin Download” buon. Choose the nearest download location to

you to ensure maximum download speed.
CD stands for Compact Disc and is a
medium for storing data. One CD can store
just over MB of data.

-bit vs -bit
You may notice that the default download buon on the website says Ubuntu
Desktop . (-bit) underneath. If you are unsure what -bit means, don’t
worry. -bit will work on most computers, so if in doubt, simply proceed
with the download. However if you know that your computer is capable of
using -bit soware, you may wish to try the -bit version instead. Simply
cli the Alternative download options buon and make your selection.  bit and  bit are types of processor

architectures.  bit is newer, and most
recent computers will come with a  bit
capable processor. See Chapter : Learning
more for more information.

Downloading Ubuntu as a torrent
When a new version of Ubuntu is released, sometimes the servers can get
clogged up with large numbers of people downloading or upgrading at the
same time. If you are familiar with using torrents, you may wish to download
the .torrent file by cliing Alternative download options, and obtain your
copy of the CD image this way instead. You may see significant improve-
ments to your download speed, and will also be helping to spread Ubuntu to
other users worldwide. Again if you are unsure what a torrent is, simply sti
with the default download options on the website. Torrents are a way of sharing files and

information around the Internet via Peer to
Peer file sharing. When a new version of
Ubuntu is released, the Ubuntu servers can
become very busy. If you know how to use
torrents, we recommend that you download
the CD image this way to take the load off
the servers during periods of high demand.

Burning the CD image
Once your download is complete you will be le with a file called ubuntu-
.-desktop-i.iso or similar (note: the i refers to the -bit version).
is file is a CD image—a bit like a “snapshot” of the contents of a CD—whi
you will need to burn to a CD disc. To find out how to burn a CD image on
your computer, refer to your operating system or manufacturer help. You

http://www.ubuntu.com
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can also find detailed instructions at https://help.ubuntu.com/community/
BurningIsoHowto

Ordering a free CD
Note: You will be required to create a free
online account with Launchpad before you
can place your CD order. Once you have
Ubuntu installed and running, you might
need to use this account again for various
purposes.

e CD usually takes two to six weeks to arrive, depending on your location
and the current demand. If you would rather start using Ubuntu sooner, you
may prefer to follow the instructions above for downloading the CD image,
and then burn it to a disc instead.

You are able to order a free CD from Canonical. is option may be pre-
ferred if you don’t have access to a CD burner, have limited bandwidth, or
a slow Internet connection. ere are no shipping costs or other arges
when you order an Ubuntu CD. Simply visit http://shipit.ubuntu.com to
request your free Ubuntu Desktop Edition CD. It is possible to purchase Ubuntu on CD

from some computer stores or online shops.
Have a look around your local area or on
the Internet to see if someone is selling
it near you. Even though Ubuntu is free
soware, it’s not illegal for people to sell it.

The Live CD
e Ubuntu CD that you have downloaded and burnt to a disc (or had sent
to you) functions not only as an installation CD for puing Ubuntu onto
your computer, but also as a Live CD. A Live CD allows you to test Ubuntu
without making any permanent anges to your computer by running the
entire operating system straight from the CD.

e speed at whi your computer can “read” information from a CD is
mu slower than reading information from a hard drive. Running Ubuntu
from the Live CD also occupies a large portion of your computer’s memory,
whi would usually be available for programs to access when Ubuntu is
running from your hard drive. In some cases, your computer will simply

run as normal and appear not to recognize
the Ubuntu CD is present as it starts up.
This is ok, generally it means that the pri-
ority given to devices when your computer
starts up needs to be changed. For example,
your computer might be set to look for
information from your hard drive first, and
then to look for information on a CD sec-
ond. In order to run Ubuntu from the Live
CD, we need it instead to look for informa-
tion from a CD first. Changing your boot
priority is beyond the scope of this guide.
If you need assistance to change the boot
priority, see your computer manufacturers
documentation for more information.

Because of this, the Live CD experience will feel slightly slower than it
does when Ubuntu is actually installed on your computer. However, running
Ubuntu from the CD is a great way to test things out, and allows you to try
the default applications, browse the Internet, and get a general feel for the
operating system. It’s also a great way to e that your computer hardware
works properly in Ubuntu and that there are no major compatibility issues.

To try out Ubuntu using the Live CD, simply insert the Ubuntu CD into
your CD drive and restart your computer. Most computers are able to detect
when a “bootable” CD is present in your drive at startup—that is, a CD that
will temporarily take precedence over your usual operating system. As your
computer starts, it will run whatever information is stored on this bootable
CD, rather than the information stored on your hard drive whi your com-
puter usually looks for.

Once your computer finds the Live CD and aer a qui loading screen,
you will presented with the “Welcome” screen. Using your mouse, select your
language from the list on the le, then cli the buon labelled Try Ubuntu
.. Ubuntu will then start up, running straight from the Live CD.

https://help.ubuntu.com/community/BurningIsoHowto
https://help.ubuntu.com/community/BurningIsoHowto
http://shipit.ubuntu.com
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Figure .: The welcome screen allows you
to choose your language.
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Once Ubuntu is up and running, you will see in front of you the default
desktop. We will talk more about how to actually use Ubuntu in Chapter :
e Ubuntu Desktop, but for now feel free to test things out, open some
programs, ange seings and generally explore—any anges you make will
not be saved once you exit, so you don’t need to worry about accidentally
breaking anything.

Once you are finished exploring, simply restart your computer by cliing
the “Power” buon in the top right corner of your screen (circle with a line
through the top) and then select Restart. Follow the prompts that appear on
screen, including removing the Live CD and pressing Enter when instructed,
and then your computer will restart. As long as the Live CD is no longer in
the drive, your computer will return to its original state as though nothing
ever happened!

Minimum system requirements
Ubuntu generally runs well on most computers. If you are unsure whether it
will work on your computer, the Live CD is a great way to test things out first.
For the more tenically minded, below is a list of hardware specifications
that your computer should ideally meet as a minimum requirement.

‣ MHz x processor
‣ MB of system memory (ram)
‣  GB of disk space
‣ Graphics card capable of × resolution
‣ Sound card
‣ A network or Internet connection

Installing Ubuntu
e process of installing Ubuntu is designed to be qui and easy, however
we realize that some people may find the idea a lile daunting. To help you
get started we have included step-by-step instructions below, along with
screenshots so you can see how things will look along the way.

At least  GB of free space on your hard drive is required in order to install
Ubuntu, however GB or more of free space is recommended. at way you
will have plenty of room to install extra programs later on, as well as store
your own documents, music and photos.

Geing started
To get started, place the Ubuntu CD in your CD drive and restart your com-
puter. If you have already tested out the Ubuntu Live CD, you should now Alternatively, you can also use your mouse

to double-click the “Install Ubuntu .”
icon that is visible on the Desktop when
using the Live CD. This will start the Ubuntu
installer.

be familiar with the initial “Welcome” screen that appears (refer to e Live
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CD above for more information). Again select your language on the le-hand
side, then cli the buon labelled Install Ubuntu .. There are two other options presented on

the “Welcome” screen: release notes and
update this installer. Clicking on the blue
underlined release notes will open a web
page containing any important information
regarding the current version of Ubuntu.
Clicking update this installer will search
the Internet for any updates to the Ubuntu
Live CD that may have been released since
the time it was downloaded.

e next screen will display a world map. Using your mouse, cli your
location on the map to tell Ubuntu where you are. Alternatively, you can use
the drop-down lists underneath. is allows Ubuntu to set up your system
clo and other location-based features. Cli Forward when you are ready to
move on.

Figure .: Choose where you live.

Next, you need to tell Ubuntu what keyboard you are using. Usually, you
will find the suggested option is satisfactory. If you are unsure, you can cli
the Guess buon to have Ubuntu work out the correct oice by asking you
to press a series of keys. You are able to oose your own keyboard layout
from the list. If you like, type something into the box at the boom to make
sure you are happy with your selection, and then cli Forward to continue.



 getting started with ubuntu 10.04

Figure .: Check your keyboard layout is
correct.
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Prepare disk space
is next step is oen referred to as partitioning. Partitioning is the process of
allocating portions of your hard drive for a specific purpose. When you create
a partition, you are essentially dividing up your hard drive into sections that
will be used for different types of information. Partitioning can sometimes
seem complex to a new user, however it does not have to be. In fact, Ubuntu
provides you with some options that greatly simplify this process.

Figure .: Choose where you would like to
install ubuntu.Many people installing Ubuntu for the first
time are currently using either Microso
Windows (e.g. Windows , Vista, or XP)
or Mac OS X on their computer. Ubuntu
provides you with the option of either
replacing your existing operating system
altogether, or otherwise keeping your
existing system and installing Ubuntu side-
by-side. The laer is called dual-booting.
Whenever you turn on or restart your
computer, you will given the option to select
which operating system you want to use for
that session.

Erase and use the entire disk
Use this option if you want to erase your entire disk. is will delete any
existing operating systems that are installed on that disk (e.g. Windows XP),
and install Ubuntu in its place. is option is also useful if you have an empty
hard drive, as Ubuntu will automatically create the necessary partitions for
you.



 getting started with ubuntu 10.04

Guided partitioning
If you already have another operating system installed on your hard drive,
and want to install Ubuntu alongside it, oose the Install them side by side,
oosing between them ea startup option.

Specifying partitions manually
is option is for advanced users to create special partitions or format the
hard drive with other filesystems than the default one. It can also be used to
create a separate /home partition, whi is very useful in case you have to
reinstall the whole system one day. Ubuntu installs a home folder where

your personal files and configuration
data are located by default. If you choose
to have a separate home folder, then in
the unlikely scenario where you have to
reinstall Ubuntu, your personal files and
configuration data won’t be lost.

Once you are happy with the way the partitions are going to be set up,
cli the Forward buon at the boom to move on.

Enter your details
Ubuntu needs to know some information about you so it can set up the pri-
mary login account on your computer. Your name will appear on the login
screen as well as the MeMenu, whi will be discussed further in Chapter :
e Ubuntu Desktop.

On this screen you will need to tell Ubuntu:

‣ Your real name
‣ Your desired username
‣ Your desired password
‣ What you want to call your computer
‣ How you want Ubuntu to log you in.

Type in your full name under “What is your name?” e next text field
is where you select a username for yourself, and is the name that will be
displayed at the Ubuntu login screen when you turn on your computer. You
will see this is automatically filled in for you with your first name. Most
people find it easiest to sti with this, however you can ange it to whatever
you like.

Next, oose a password and enter it into the first password field on the
le. Avoid obvious passwords like your birthdate, wifes name, or the name
of your dog—a mixture of leers, numbers, punctuation, and uppercase/low-
ercase will make for a more secure password. Type the same password again
into the right field to verify (you should see a green ti appear if you have
done this correctly).

Now you need to decide on your computer’s name. Again, this will be
filled in for you automatically using the login name you entered above (it
will say something like “john-desktop” or “john-laptop.”), however you can
ange this to whatever you like. Your computer name will mainly be used To see how to set up a network, visit

Chapter : Working with Ubuntu.
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Figure .: Setup a user account.
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for identifying your computer if you are on a home or office network with
multiple other computers.

Finally, at the boom of this screen you have three options to oose from
regarding how you want to log in to Ubuntu.

Log in automatically
Ubuntu will log in to your primary account automatically when you start
up the computer, whi means you won’t have to enter your username and
password to get into your computer. is makes your login experience quier
and more convenient, however if privacy or security are important to you,
this option is not recommended. Anyone who can physically access your
computer will be able to turn it on and also access your files.

Require my password to login
is option is selected by default, as it will prevent unauthorized people from
accessing your computer without knowing the password you created earlier.

Require my password to login and decrypt my home folder
is option provides you with an extra layer of security. Your home folder
is where your personal files are stored. By selecting this option, Ubuntu will
automatically enable encryption on your home folder, meaning that files and
folders must be decrypted using your password before they can be accessed.
erefore if someone had physical access to your hard drive (for example, it
was removed from your computer and connected to someone elses computer),
they would still not be able to see your files without knowing your password.

If you oose this option, be careful not to enable automatic login at a later
date. It will cause complications with your encrypted home folder, and will
potentially lo you out of important files.

Migration assistant
. ..Need this section urgently .

Confirm your seings and begin installation
e last screen summarizes your install seings, including any anges that
will be made to the partitions on your hard drive. Note the warning about
data being destroyed on any removed or formaed partitions—if you have
important information on your hard drive that is not baed up, now would
be a good time to e that you have set up your partitions correctly. Once You should not need to click the Advanced

buon unless you wish to change your
bootloader seings or network proxy. These
are more advanced tasks and beyond the
scope of this guide.

you have made sure that all the seings are correct, simply cli on Install to
begin the installation process.
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Figure .: Check that everything is setup
right.
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Ubuntu will now install. As the installation progresses, you will be pre-
sented with a slideshow that gives you an introduction to some of the default
applications included with Ubuntu. ese applications are covered in more
detail in Chapter : Working with Ubuntu.

Figure .: The first slide of the installation.

Aer approximately twenty minutes, the installation will complete and
you will be able to cli Restart Now to restart your computer and start
Ubuntu. e CD will be ejected, so remove it from your CD drive and press
Enter to continue.

Figure .: You are now ready to restart
your computer.

Wait while your computer restarts, and you will then see the login window
(unless you selected automatic login).
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M I S S I N G S C R E E N S H O T
Installation: The Ubuntu login window

Figure .: Installation: The Ubuntu login
window

Cli your username and enter your password, then press Enter or cli
Log in. You will then be logged in to Ubuntu and will be presented with your
new desktop!

Using the Wubi installer
Wubi stands for Windows Ubuntu Installer, and it allows you to install
Ubuntu inside Windows. Once installed, Ubuntu will appear in your Ad-
d/Remove programs like any other application. When it installs Ubuntu, it
will set up a series of files (called loop files) whi you can specify in size,
where it stores all of Ubuntu’s data. It will also add an entry to the Windows
boot loader, so when you reboot your computer you will be able to oose
between Windows or Ubuntu.

It’s a very simple way to dual-boot and test out Ubuntu running natively
on your maine—and if you don’t like it just uninstall Ubuntu from the Win-
dows Add/Remove Programs menu. It won’t harm your Windows installation
in any way.
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M I S S I N G S C R E E N S H O T
Wubi in Windows 

Figure .: Wubi in Windows 



 The Ubuntu Desktop
Understanding the desktop
At first glance, you will notice many similarities between Ubuntu and other
operating systems su as Windows or Mac OS X. is is because they are
all based on the concept of a Graphical User Interface (gui)—that is, you use
your mouse to navigate the desktop, open programs, move files, and perform
most other tasks. In short, things are very visually oriented, whi means it is
important for you to become familiar with where and what to cli in Ubuntu. Ubuntu . has an emphasis on Social

from the Start and features social network
integration in the desktop for sites like
Twier and Facebook.GNOME

All gui-based operating systems use a desktop environment. e term “desk-
top environment” encompasses many things, su as the look and feel of your
system, as well as how the desktop is organized, laid out, and navigated by the
user. In Linux distributions (su as Ubuntu), there are a number of desktop
environments available for use. One of the more popular desktop environ-
ments is called gnome, whi is used by default in Ubuntu. kde, xfce, and
lxde are other popular desktop environments (used in Kubuntu, Xubuntu,
and Lubuntu, respectively), and there are many more. As Ubuntu is based on
gnome, we will limit our discussion in this guide to exploring your gnome
desktop. To read more about other variants of

Ubuntu, refer to Chapter : Learning more.
When you first log in to Ubuntu aer installing it to your hard drive, you

will see the gnome desktop. Ubuntu is highly customizable, as is the gnome
desktop, but for now let’s just explore the default layout that is in front of you.

Everything on a panel is an applet, even the
main menu.Firstly, you will notice there are two panels—one at the top of your desktop

and one at the boom. A panel is a bar that sits on the edge of your screen
and contains various applets. ese applets provide useful functions su as
running programs, viewing the time, or accessing the main menu.

The top panel
Starting from the le, you will see three menu headings—Applications,
Places, and System—followed by two program icons. e first of these icons
will open the Firefox web browser (see Chapter : Working with Ubuntu for
more info), and the next will open the Ubuntu Help Center. The Ubuntu Help Center is a highly

useful resource. It provides a wealth of
information about your Ubuntu system,
and is always at your fingertips by simply
clicking this panel icon (or navigating to
System ‣Help and Support).

On the right side of this panel you will find the Notification Area, whi
is similar in function to the system tray in Windows, or the “menu extras”
area on the Mac OS X menu bar. Next to this is theMeMenu, whi will
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Figure .: The Ubuntu . desktop.
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display your username (the name you entered during installation) and is
used to update social network sites like Twier and Facebook as well as set
your Instant Messaging status in Empathy. Finally, furthest to the right is the
power buon icon, whi provides menu options for loing your computer,
logging out, restarting, or shuing down completely. New notifications of emails and instant

messages appear in the messaging menu
applet. When you have a new message, the
envelope icon will turn green.The Notification Area

Inside the Notification Area you will find the network indicator, volume
adjustment, Bluetooth indicator (if your computer has Bluetooth capability),
messaging applet, and the date and time. Some programs will also place an
icon in the Notification Area when you open them. To remove an applet, right click on it and

select Remove From Panel.Le-cliing icons in the Notification Area will bring up a list of options,
and in some cases right-cliing an icon will also perform an action related
to that program. For example, to adjust the volume, simply le-cli once
on the icon and a volume slider will appear. Cli the date and time to open
a small calendar, and then cli a specific date to add a reminder to your
calendar through Evolution (see Chapter : Working with Ubuntu for more
information on Evolution). To add a new applet to a panel, right click in

a clear area on the panel and select Add to
Panel.When the calender is expanded there is a buon labelled Locations, whi

will open a small world map when clied. Here you can further set up your
location preferences by cliing Edit. In the window that appears, cli Add,
then type your location in the box. If you live in a major city it may be on
the list already; if not, you can enter your latitude and longitude manually
(try searing online if you don’t have this information). Make sure your time
zone is selected, then cli OK to return to the preferences screen.

Feel free to explore the other options available under the General and
Weather tabs if you like, then cli Close at the boom when you are done.
If temperature information is available for your city, you will now see the
current temperature displayed alongside the date and time in the Notification
Area.

The boom panel
Ubuntu uses most of the boom panel to display a list of all programs or win-
dows that are currently open. ese appear as horizontal buons whi can
be clied to minimize or restore the corresponding windows (see Managing
windows below for more information).

On the far le of the boom panel is a small icon that resembles a desktop.
is Show Desktop buon will minimize all open windows at once, giving you
clear access to your desktop. is is particularly useful when you have many
windows open at once and your desktop becomes cluered. Cliing the same
buon again will restore these windows to their original position.

On the right side of the panel you will see some small boxes in a row;
this is theWorkspace Switer. By default, Ubuntu . is set up with two
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workspaces. The  desktop environment used in
Ubuntu can provide two or more “virtual
desktops”, orworkspaces. Using these
workspaces can reduce cluer by opening
windows on separate desktops, without
needing a separate monitor. For example, in
order to organize your activities you may
have your email open in one workspace
and a text document you are working on in
another. To switch workspaces, simply click
on the boxes in theworkspace switcher
or use the keyboard shortcut Ctrl + Alt +
right arrow or Ctrl + Alt + right arrow
to switch workspaces quickly.

Finally, the icon furthest to the right is the Trash, whi performs a similar
function to the Recycle Bin in Windows or the Trash in Mac OS X. Any files
you delete are first sent to the Trash. To see the contents of the Trash, cli on
this icon. You can empty the trash by cliing on the Empty Trash buon in
the window that appears, or alternatively by right-cliing the Trash icon in
the boom panel and selecting Empty Trash from the menu.

Managing windows
When you open a program in Ubuntu (su as a web browser or a text ed-
itor—see Chapter : Working with Ubuntu for more information on using
programs), a window will appear on your desktop. If you have used another
operating system before, su as Microso Windows or Mac OS X, you are
probably familiar with the concept of a “window”—the box that appears on
your screen when you start a program. In Ubuntu, the top part of a window
(the titlebar) will have the title of the window in the center, and three buons
in the top le corner. From le to right, these buons maximize, minimize,
and close the window. Additionally, you can right-cli anywhere on the
titlebar for a list of other window management options.

Closing, maximizing, restoring, and minimizing windows

Figure .: The maximise, minimize, and
close window buons.

To close a window, cli on the “X” in the upper le corner of the win-
dow—this will be the third buon along. Immediately to the le of this is a
downward-pointing arrow that is used to minimize the window to the boom
panel of your desktop. Once minimized the window will no longer be visible,
however its corresponding buon in the boom panel will remain, indicat-
ing the program is still running in the baground. Cliing this buon will
restore the window to its original position. Finally, the buon furthest to the
le of the titlebar will maximize the window, making it fill the entire screen.
Cliing this buon again will return the window to its original size.

Moving and resizing windows
To move a window around the workspace, place the cursor on the top of the
window, then cli and drag the window while continuing to hold down the
le mouse buon. To resize a window, place the cursor on an edge or corner
of the window so that it turns into a larger arrow, the resize icon. You can
then cli and drag to resize the window.
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Switching between open windows
ere are two ways in Ubuntu to swit between open windows in a workspace.
You can find the window on the boom panel taskbar and cli to bring it up
on the screen, or you can use Alt+Tab to select the window you wish to work
on. Hold down the Alt key, and keep pressing the Tab buon until the win-
dow you’re looking for appears on the desktop.

Geing help
Many programs have their own help which
can be accessed by clicking the Help menu
in the application window.

Ubuntu, just like other operating systems, has a built-in help reference, called
the Ubuntu Help Center. To access it, cli on the Help buon, a blue circle
with a white question mark (?) in the middle. You can also access it as “Help
and Support” through the System menu on the top panel.

Figure .: This is the icon to click to look at
the built in system help.
The Help buon appears on the top panel
and under the System menu by default. A
similar icon may also appear in other places
offering help for specific programs or other
functions.

M I S S I N G S C R E E N S H O T
Ubuntu Help Center main window

Figure .: Ubuntu Help Center main
window

If you can’t find an answer to your question in this manual or in the Help
Center, you can rea out to the Ubuntu community through the Ubuntu
Forum (http://ubuntuforums.org). Many Ubuntu users open an account on
the Forum to receive help. Later, as they gain knowledge of Ubuntu, they
provide help to others. Another useful website is the Ubuntu Wiki (https:
//wiki.ubuntu.com), a website maintained by the Ubuntu community. You may find that there are programs

in the Applications menu that you don’t
use frequently, or just don’t want to be
displayed on the menu. To hide those
applications (without deleting the actual
programs), click on System menu and
select Preferences ‣Main Menu. Find the
applications in the right panel that you want
to remove from the Applications menu, and
click to un-check the box.

http://ubuntuforums.org
https://wiki.ubuntu.com
https://wiki.ubuntu.com
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Should you oose to get help by searing the Web, please e any
information you find using multiple sources, and only follow directions if you
understand them completely.

Using the Applications menu
ere are three menu headers in the top panel. Let’s take a look at those
menus in a bit more detail, starting with the Applications menu.

Accessories
e Accessories sub-menu has many programs that are suited for productiv-
ity, including Calculator and Tomboy Notes. See Chapter : Working with Ubuntu

for more information about the included
applications.Other programs in Accessories include the CD/DVD Creator, gedit Text

Editor (similar to Windows Notepad and OS X’s TextEdit), Sear for Files
(we’ll discuss that later), and Take Screenshot, whi allows you to take a
picture of your desktop screen.

Games
Ubuntu has several games built in for your entertainment. If you enjoy card
games, e out AisleRiot Solitaire. Perhaps you’re looking for more of a
allenge: in that case, there’s gBrainy and Sudoku. e Games menu also
includesMahjongg,Mines (similar to Windows Minesweeper game) and
adrapassel (similar to Tetris).

Graphics
Under the Graphics sub-menu, you’ll find the F-Spot photo manager where
you can view, edit and share pictures you’ve downloaded from your camera.
OpenOffice Drawing allows you to create images using the OpenOffice suite,
and Simple Scan is a program for scanning images and documents from your
scanner.

Internet
e Internet sub-menu is where you will find the Firefox web browser where
you can surf the Internet, the Empathy Instant Messenger client to allow you
to talk to your friends and family, and Ubuntu One, a program that allows
you to sync and baup your files across many different computers. Instant Messaging (IM) is a means of text-

based communication where you can hold
a conversation with someone over the
Internet, instantly.Office

e Office sub-menu is where you will find most of the OpenOffice suite
to help you create formal documents, presentation or slideshows. Also un-
der Office is the Evolution email client and an online dictionary. e full
OpenOffice suite installed in Ubuntu by default consists of: To learn more about OpenOffice and to

get help with using the OpenOffice suite of
applications, visit http://openoffice.org

http://openoffice.org
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‣ OpenOffice Word Processor
‣ OpenOffice Spreadsheet
‣ OpenOffice Presentation
‣ OpenOffice Drawing (located under the Graphics sub-menu)

Sound and video
e Sound and Video sub-menu has programs for working with multimedia,
su as:

‣ Brasero disc burner
‣ Totem movie player
‣ Pitivi video editor
‣ Rhythmbox music player
‣ Sound Recorder

More information on all of these programs can be found in Chapter :
Working with Ubuntu.

Ubuntu Soware Center
Learn more about the Ubuntu Soware
Center in Chapter : Soware Management.At the very boom of the Applications menu is the Ubuntu Soware Center.

is application gives you access to a library of soware that you can down-
load. e main screen in the Soware Center is similar to your Applications
menu, for easy searing. If you know the name of the program you’re look-
ing for, just enter it in the sear box on the top right of the Soware Center
window. e Soware Center keeps tra of programs that are installed on
your computer. If you’re simply curious as to what is available, you can ex-
plore the soware available using the categories listed on the le side of the
window.

Using the System menu
e system menu, located on the top panel, contains two important sub-
menus. ose sub-menus, Preferences and Administration, make it possible
for you to make modifications to how your system looks and works. rough
the System menu, you can also open the Ubuntu Help Center (Help and
Support), find out more about your GNOME desktop environment (About
GNOME), and find out more about Ubuntu in general (About Ubuntu). e
System menu and its sub-menus are the equivalent of the Control Panel in
Windows and OS X’s Systems Preferences. See Chapter : Hardware for more informa-

tion on seing up Ubuntu.

Preferences
You can use the Preferences sub-menu to modify the appearance of the desk-
top and windows, assign a default printer, designate keyboard shortcuts,
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ange the entries listed in the Applications menu, edit network connections,
and ange mouse seings, among other options.

Administration
Most of the options in the Administration
menu will prompt you to enter your user
password when you click on them. This
is a security feature to make sure that
only authorized people are allowed to
change system seings. To learn more about
security in Ubuntu, see Chapter : Security.

e Administration sub-menu contains programs you can use to monitor
computer performance, ange disk partitions, activate third-party drivers,
manage all installed printers, and manage how your computer receives up-
dates from Ubuntu. is sub-menu also has the Synaptic Paage Manager,
whi is a more tenical resource for locating and downloading soware
paages.

Browsing files on your computer
ere are two ways to locate files on your computer. You can use the Sear
for Files tool in the Applications menu, under Accessories. You can also use
the Places menu on the top panel. See Nautilus file browser for more details.

Places
e Places menu is a list of commonly-used folders (su as Home Folder,
Documents, Music, Downloads). You can also browse all disks on the com-
puter by cliing on Computer in the Places menu. If you set up a home
network, you will find a menu item to access shared files/folders. You can also
access the Sear for Files tool from the Places menu, and browse a list of
recently opened documents.

Your home folder
e home folder is where ea user’s personal files are located. When you
installed Ubuntu, you entered a name to set up your user account. at same
name is assigned to your Home Folder. When you open your personal folder,
you will see that there are several folders there—Desktop (any files that are
located on the Desktop), Documents, Downloads, Music, Pictures, Public,
Templates, and Videos. You should open the example content to see

how different types of files are displayed in
Ubuntu.You will also see a link named Examples. Double-cli on that link to open

a folder full of example documents, spreadsheets, and multimedia.

Nautilus file browser
Just as Windows has Windows Explorer and OS X has Finder to browse files
and folders, Ubuntu uses the Nautilus file browser by default. We will now
look at the features offered in Nautilus.
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The Nautilus file browser window
When you open a folder on the Desktop or from the Places menu, the Nau-
tilus file browser window opens up. e standard browser window contains
the following features:
‣ Menubar: e menubar is located at the top of the window. ese menus
allow you to modify the layout of the browser, navigate, bookmark com-
monly used folders and files, and view hidden folders and files. If you bookmark a folder, it will appear in

the Places menu.‣ Toolbar: e toolbar has tools for navigation and a tool to make the con-
tents of the window larger or smaller. A drop-down list gives you the
option of switing the view from Icon View to List View or Compact
View. e sear icon (whi looks like a magnifying glass) opens up a box
so you can sear for a file by name. If you start typing a location, Nautilus will

change the navigation buons into a text
field labeled Location.‣ Additional Navigation Tools: Just below the toolbar, you will see a repre-

sentation of where you are currently browsing. is is similar to the his-
tory function of most browsers; it keeps tra of where you are and allows
you to batra if necessary. You can cli on the locations to navigate
ba through the file browser.

‣ e le pane of the file browser has shortcuts to commonly-used folders.
When you bookmark a folder, it appears in the le pane. No maer what
folder you open, the le pane will always contain the same folders. is
le pane can be anged to display different features by cliing the down
arrow beside “Places” near the top.

‣ e largest, central pane shows the files and folders in the directory that
you’re currently browsing.

Opening files
To open a file, you can either double-cli on its icon or right-cli and select
Open With (program).

Copying and moving files and folders
You can also use the keyboard shortcuts
Ctrl + C and Ctrl + V to copy and paste
files and folders.

You can copy files through the Edit menu in Nautilus (either using Copy or
Copy To), or by right-cliing on the file and selecting Copy or Copy to from
the popup menu. When using the Edit menu in Nautilus, make sure you’ve
selected the file (cli on it to select it) before you cli on the Edit menu.
Multiple files can be selected by holding the le mouse buon down while
dragging the cursor across the files you want. e cli-drag move is good
when you are selecting files whose icons are grouped together. To select files
that are not grouped together, hold down the Ctrl key while cliing on ea
file you wish to select.

To move files and folders around, locate the file or folder you want to
move. Cli-and-hold on the file or folder and drag it to the new location.
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Figure .: The default user folder layout.
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Another way of moving folders or files is to use the Cut command, followed
by Paste in the new location. If you click on a file or folder with both

the le and right mouse buons at the
same time, keep holding and drag it to your
destination folder. When you let go of both
mouse buons, a menu will appear asking
whether you want to copy, move or link the
item.

Navigating between directories
To navigate between directories, use the bookmarks in the le pane of the
Nautilus file browser. You can also retrace your steps by cliing on the name
of a folder where it is listed just below the navigational icons. Double-cliing
on a visible directory will cause you to navigate to it in Nautilus.

Creating new folders
To create a new folder, you can either right-cli on the file browser window
(or on the Desktop) and select Create Folder from the popup menu, or select
Create Folder from the File menu in Nautilus. If you wish to hide certain fold-
ers or files, place a dot (.) in front of the file name (i.e. “.Personal Finances”).

Note that you can easily view hidden files
by clicking the “View” menu and then
clicking on “Show Hidden Files” or by
pressing Ctrl+H, so this isn’t a security
measure but a way of keeping folders tidy.

Using multiple tabs and multiple Nautilus windows
Cut removes the file from the source and
pastes it into the destination.

e Nautilus file browser gives you the option to do tabbed browsing as
an alternative to opening several Nautilus windows. To open new tabs in
Nautilus, select New Tab from the File menu. If you prefer having separate
Nautilus windows open, select New Window from the File menu. Copy leaves the original file in the source

folder and duplicates it to the destination.You can move files and folders using the drag method using either separate
windows or tabbed browsing. When you open a new tab, it will produce a
second window of the current directory that you’re working in. To select a
different directory for the new tab, navigate to the desired location using the
le pane.

Searching for files on your computer
Search for files quickly by pressing Ctrl +
F in Nautilus and then typing what you
want to find.

Earlier, we mentioned that you can sear for files on the computer by using
the Sear for Files feature on the Places menu in the top panel. You can also
use the Nautilus browser to sear for files, as explained above.

Customizing your desktop
Now that you’ve been introduced to the GNOME desktop environment, let’s
take a look at customizing its features.

e desktop itself will have a wallpaper that is part of the default Ubuntu
theme, known as Ambience. e desktop is highly customizable. You can
move the panels to the sides of the desktop, set the panels to autohide, and
you can remove or add panels as you desire. By default, Ubuntu requires
that you maintain at least one panel on the desktop. If you prefer a Windows
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look, a panel at the boom of the desktop can be set up to open and do
programs. If you prefer a Mac OS X look, you can keep the top panel and add
an applications do. Some docks you can check out include

Docky, Avant Window Navigator (AWN),
and Cairo-Dock, all of which are available
in the Ubuntu Soware Center. See
Chapter : Soware Management for
detailed instructions on how to find and
install soware.

You can ange the wallpaper and place program launers or file shortcut
icons on the desktop. For now, we will look at the default desktop and the
options that it offers. As we move forward in this apter, you will learn how
to make some basic modifications to the desktop.

e top panel is customizable. Right-cli on any open area of the panel
to access the options menu. You can add applets to the panel for reference,
information, or fun. You can also add program launers to the top panel
by opening the Applications menu. Once you find the program, drag it to
an open space on the panel. In this way, the panel also serves as an applica-
tions do. You can also adjust panel properties, su as orientation of the
panel on the screen (top, boom, le, right), panel size, and panel color and
transparency.

To add more workspaces, right-cli on theWorkspace Switer applet and
select Preferences. For example, if you would like to have four workspaces
you could select  rows by  columns (or  row by  columms).

Appearance
ere are many things you can do with the desktop appearance. e panels
can be moved from their top or boom positions to the sides of the screen,
they can be set to hide, or you can ange the panel color. To access these
features, right-cli the panel you want to modify and select Properties from
the pop-up menu. e General tab has options to autohide, position the panel,
and ange the panel size. By default, the panels cover the entire length of
the desktop. To ange that, un-e the Expand box. To hide the panel
on the le or right corner of the desktop, select the Show Hide Buons. To
put arrows on the hide buons, e the Arrows on Hide Buons box (by
default, this box will be eed when you select Show Hide Buons). To
make the panel disappear, select Autohide. e panel will reappear when
you place the cursor near the edge of the screen where the panel was before
it hid. e Baground tab in Panel Properties allows you to use the system
theme (default seing), or select a color of your oosing. You can also set the
transparency of the panels, or even select a picture or design from your files as
a panel baground.

Changing the desktop baground is quite simple. You can either right-
cli on the desktop and select Change Desktop Baground from the pop-up
menu, or, from the top panel, select System ‣ Preferences ‣Appearance.
When the Appearance Preferences window opens up, cli on the Baground
tab. You will see some sto bagrounds to oose from. If you are look-
ing for something beyond these, you can use any picture on your computer
as a desktop baground. Cli on the Add… buon and find the picture
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you wish to use. Double-cli on it, and the ange will take effect immedi-
ately. Once you do this, the picture will become available in the Appearance
Preferences. To find even more great desktop bagrounds, cli on the “Get
More Bagrounds Online” link at the boom of the Appearance Prefer-
ences window. is link will open your web browser, and direct you to the
http://gnomelook.org website.

You can also ange the fonts through the Appearance Preferences win-
dow. Just cli on the Fonts tab. You can individually set the font style and
size for applications, documents, desktop items, window titles, and for any-
thing using fixed width fonts. e Rendering section at the boom of the
Fonts window gives you four options for anging the way that fonts are
drawn on your screen. Changing these may improve the appearance of text
on different types of screens.

Windows
e Appearance Preferences window has a eme tab, where you can select a
theme that will control the appearance of your windows, buons, scroll bars,
panels, icons, and other parts of the desktop. Ubuntu comes with nine themes
to oose from, and the Ambience is selected by default. You can download
additional themes by cliing the “Get More emes Online” link on the
boom of the emes window. e link will take you to the http://gnomelook.
org website, where you can download from a large selection of themes. To
add downloaded themes to the emes tab, drag the downloaded file into
the emes window (this will work for most themes). You can customize
any theme: select the theme, and cli on the Customize buon. is will
allow you to mix elements of different themes, thus creating your own special
theme.

Screensaver
Ubuntu offers a selection of screensavers. By default, Ubuntu displays a blank
screen aer a period of inactivity. To select a different screensaver, cli on the
System menu on the top panel, select Preferences, and select Screensaver. is
will open the Screensaver Preferences window. e available screensavers are
listed on the le side of the window. When you select a screensaver, you will
see a mini-preview in the window. To see how it will look on your screen,
cli the Preview buon. To exit the preview, cli on the Leave Fullscreen
buon on the top of the screen. e le and right arrow buons in Fullscreen
allow you to scroll through the available screensavers while still in full screen
mode. Make sure that the “Activate Screensaver When Idle” option is selected
to activate the screensaver. e slider can be adjusted to set the idle time. For
added security, you can select the “Lo Screen When Screensaver Is Active”
option. Ubuntu will ask you for your login password when you return to

http://gnomelook.org
http://gnomelook.org
http://gnomelook.org


 getting started with ubuntu 10.04

Figure .: You can change the theme in the
appearance preferences window.
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using the computer. If the screensaver is active, you can return to work by
pressing any key or moving your mouse.

Accessibility
Ubuntu has built-in tools that make using the computer easier for people
with certain physical limitations. You can find these tools by opening the
System menu, then oosing Preferences, then Assistive Tenologies. In
addition to the Assistive Tenologies, certain appearance tweaks, su as
selecting high contrast themes and larger on-screen fonts can assist those with
limited vision. You can also adjust keyboard and mouse seings through the
Assistive Tenologies window. Just cli on the Keyboard Accessibilty or
Mouse Accessibility buons in the Preferences section to access those features.

M I S S I N G S C R E E N S H O T
Screenshot of the Assistive Technologies window.

Figure .: Screenshot of the Assistive
Technologies window.

Assistive Technologies
Orca, a tool for persons with visual impairments, is pre-installed on Ubuntu.
To run Orca, Press ALT + F2, type Orca in the command box, and cli on the
Run buon. Orca’s voice synthesizer will activate to navigate you through
the various voice options, Braille, and screen magnification. Once you have
selected all seings, log out of the computer. Once you log ba in, the Orca
seings you ose will automatically run every time you use your computer.



 getting started with ubuntu 10.04

Shuing down your computer
When you’re done working on your computer, you can shut down the com-
puter or place it in sleep mode through the Session Indicator applet on the far
right end of the top panel. You can also access these options by pressing the
Ctrl+Alt+Del keys.

Logging out
To log out and leave the computer running, select Log Out from the Session
Indicator menu.

Sleeping
To save energy, you can put your computer into sleep mode, whi will save
its current condition and allow you to start more quily while remaining on
but using very lile energy.

Rebooting
To reboot your computer, select Restart from the Session Indicator menu.

Shut down
To totally power down your computer, select Shut Down from the Session
Indicator menu. You can also lock your screen quickly by

using the keyboard shortcut Ctrl + Alt +
L.Other options

From the Session Indicator menu, you can also select Lo Screen to require
a password before using the computer again—this is useful if you need to
leave your computer for some duration. You can also use the Session Indicator
menu to set up a guest session for a friend to try Ubuntu, or to swit the
desktop to let another use another user account without closing your running
applications.
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Geing online
Before you can use your computer to its fullest, you must make sure that you
are connected to the Internet. is section of the manual will help you e
or configure you Internet connection. While this manual discusses only the

Internet, connecting to office or other
networks is usually performed in a similar
manner.

Ubuntu can connect to the Internet using a wired, wireless, or dialup
connection. It also supports some more advanced connection methods.

A wired connection is used when your computer is physically connected
to a router or an ethernet port via a cable. is is the most common connec-
tion for desktop computers.

A wireless connection is used when your computer is connected to the
Internet via a wireless radio network, also known as Wi-Fi. It is common for
laptop computers to use wireless connections, especially when on the go. In
order to connect to a wireless connection you must have a working wireless
network. is is usually the case if you’ve previously purased and installed
a wireless router or access point, or if you are in a place where a wireless
network is already established.

A dialup connection is when your computer uses a modem and a tele-
phone line to connect to an Internet service provider.

Ubuntu can also connect using mobile broadband, VPNs, or DSLs. Note: A VPN is a “Virtual Private Network”,
and is sometimes used to help secure
connections. DSLs are “Digital Subscriber
Lines”, a type of a broadband connection.NetworkManager

In order to connect to the Internet in Ubuntu, you need to use the Network-
Manager utility. NetworkManager allows you to turn all networking on or
off, and helps you manage your wired, wireless, and other connections.

Figure .: This icon will show in the top
panel when you are connected to a wired
network.

You can access all the functions of NetworkManager using its icon in the
top panel. Its icon may look different if you already have a connection, or
if your connection is wired or wireless. If you hover your mouse over the
icon, it should read “Wired connection…” or “No connection” or “Networking
disabled” or something else related to networking or connections.

If you are currently connected to the Internet, you can cli on the icon.
is will bring up a list of network connections that are available to you, with
your current connection highlighted in bold.
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Figure .: You can see the auto eth
connection listed in the menu.

Figure .: This is the menu when you right
click the networking icon.

You can also right-cli on the NetworkManager icon. is will open a
menu where you can enable or disable networking, view tenical details
about your current connection, or edit all connection seings. In the image
above, the e box next to “Enable Networking” is currently selected; you
can deselect it to disable all network connections. is may be useful when
you must shut off all wireless communication, for example in an airplane.

Establishing a connection
In order to get online, you need to make sure that you have established a
connection. ere are many different ways to connect to the Internet with
Ubuntu—some of these we will cover below.

Wired
If you have an Ethernet wire running from a wall soet, a router, or some
other device, then you will want to create a wired network connection
in Ubuntu. is is the most common way for desktop and other stationary
computers to connect to the Internet. Note: Are you already online? If the Net-

workManager icon in the top panel shows a
connection, then you may have successfully
connected during the installation process. If
so, you do not need to follow the rest of this
section.

In order to connect with a wired connection, you need to know whether
your network connection supports DHCP. is stands for “Dynamic Host
Configuration Protocol”, and is a way for computers on your network to auto-
matically receive IP addresses and related configuration. If you are unsure, try
DHCP set up first; if this does not work then ask your network administrator
for static address information.
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Automatic connections with DHCP
If your network supports DHCP, you may already be online. To e if you
are online, right-cli on the NetworkManager icon in the top panel and select
the Connection Information option.

Figure .: you can see you ip address and
other information in this window.

You should see a window showing details about your connection. If your
IP address is ..., or starts with ., then DHCP did not successfully
provide your computer an address. If it shows another address then most
likely your connection was configured correctly.

If you cannot display the Connection Information window because the op-
tion on the NetworkManager menu is gray then your connection is not active.
To see if your connection is turned on, verify that the Enable Networking
option in the menu is selected.

en, cli on the NetworkManager icon. ere should be an option for
“Wired Network” in the menu that is displayed. If this option is followed by
a gray word “disconnected” then find the option called “Auto eth” in the list
and oose it to aempt a connection. If “Auth eth” is shown directly under
“Wired Network” then your computer is set up correctly for DHCP.

If aer following these steps you are still not online, you may want to
e with your network administrator and possibly proceed with manual
configuration with a static IP address.

Manual configuration with static addresses
If your network does not support DHCP, then you need to know a few items
of information before you can get online.
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‣ IP Address—this will be your computer’s address. It is always given in the
form of four numbers separated by decimal points. For example, ...

‣ Network mask—this tells your computer how large your local network
is. It takes the same form as an IP address, but is usually something like
...

‣ Gateway—this is an IP address of your network’s router: where your
computer sends data whi gets sent on to the Internet

‣ DNS servers—one or more IP addresses of “Domain Name System”
servers, whi convert names like www.ubuntu.com into IP addresses
like ...; one server is required, and any additional ones are used
in case the first one fails.
If you do not already have these seings, you will need to consult your

network administrator to receive them.
To manually configure a wired connection, right-cli on the Network-

Manager icon, and select Edit Connections. Make sure you are looking at the
“Wired” tab in the “Network Connections” window that is displayed.

e list may already have an entry, su as “Auto eth”, or having some
other name. If a connection is listed, cli on it and then cli the Edit buon.
If no connection is listed, cli the Add buon instead.

If you are adding a connection, you first need to provide a name. In the
“Connection name” field, please provide some name su as “Wired connec-
tion ”.

Figure .: In this windwo you can manualy
edit a connection.

To set up the connection:
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. Under the connection name, make sure that the Connect automatically
option is selected.

. Swit to the IPv Settings tab.
. Change theMethod to “Manual”.
. Cli on the Add buon next to the empty list of addresses.
. Type in your IP address in the field below the IP Address header.
. Cli to the right of the IP address, directly below the Network Mask

header, and type in your network mask. If you are unsure of your network
mask, a mask of “...” is the most common.

. Cli to the right of the network mask, directly below the Gateway header,
and type in your gateway address.

. In the DNS servers field below, type in the addresses of your DNS server.
If your network has more than one DNS server, enter them separated by
spaces or commas.

. Cli Apply to save your anges.

In some cases, you may need to enter a MAC address as well. is is entered
on the “Wired” tab of the editing screen. A MAC address is a hardware
address for your computer’s network card, and entering it is sometimes
important for cable modem and similar connections.

When you are once again at the “Network Connections” screen, your
newly-added connection should now be listed. Cli Close to return to the
desktop. If you configured the connection correctly, the NetworkManager icon
should have anged to show an active connection. Use instructions in the
DHCP section, above, to e if your connection looks properly set up.

e final test of seing up your connection will come when trying to use a
web browser, as described later in this apter.

Wireless
If your computer is equipped with a wireless (Wi-Fi) card, and you have a
wireless network nearby, you should be able to set up a wireless connection in
Ubuntu.

Connecting to a wireless network for the first time
If your computer has a wireless network card, you should be able to connect
to a wireless network. Most laptop and netbook computers have a wireless
network card.

Ubuntu will usually detect available wireless networks. To see a list of
wireless networks, cli on the NetworkManager icon. Under the “Wireless
Networks” heading, you should see a list of available wireless networks. Ea
network will be shown with a name on the le, and a signal meter on the
right. A signal meter looks like a series of bars—the more bars that are shown
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filled in, the stronger is the connection that your computer has to that wireless
network.

A wireless network may be open to anyone to connect, or may be pro-
tected with network security. e list of available wireless networks should
show a small icon of a “lo” next to the signal meter to the right of the name.
You will need to know the correct password in order to connect to a secured
wireless network.

To connect to a wireless network, cli on one of the network names in the
list. You should know whi network you wish to connect to—it should be
the one that you had set up when you installed your wireless router or access
point. If you are in a place of business or education, the wireless network may
be named with the name of the place.

If the network is open (the network signal meter did not have a lo next
to it), a connection should be established within a few seconds. e Network-
Manager icon in the top panel will display an animation while Ubuntu tries
to connect to the network, and should then ange to show signal meter bars
once the connection is established.

Ubuntu will also show a notification message in the upper right of your
screen informing you that a connection was established.

If the network is secured, Ubuntu will display a window called “Wireless
Network Authentication Required”. is window means that the wireless
network requires a password to allow a connection.

Figure .: Type in your wireless network
passphrase.

If you know the password, enter it in the Password field, and cli on the
Connect buon. When typing, a password will be obscured to prevent people
looking over your shoulder from seeing the typed-in password. If you prefer
to see the password when typing it in, select the Show password option when
typing your password.

Aer you cli the Connect buon, the NetworkManager icon in the top
panel will display an animation while it tries to connect to the network. If
you had entered the correct password, the NetworkManager icon should then
ange to show signal meter bars when the connection is established.
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Mu like for open wireless networks, Ubuntu will show a pop up mes-
sage in the upper right of your screen informing you that a connection was
established.

If you did not provide the correct password then the NetworkManager
icon will display an animation, and then eventually once again display the
“Wireless Network Authentication Required” window. You will now be able
to provide the correct password, or cli Cancel to abort your connection. If
you do not know the password to the network you had selected, you will need
to get the password from the network administrator.

.Once you have a successful network connection established, Ubuntu will
.

.Will users get prompted for a
keyring password here some-
where⁇ .

save this connection. is will make it easier to connect to the same wireless
network in the future.

Connecting to a saved wireless network
If you have previously successfully established a wireless connection, that
connection’s password will be saved on your computer. is will allow you to
connect to the same network without having to re-enter the password.

In addition, Ubuntu will automatically try to connect to a wireless network
within range if it has is seings saved. is will work for both open and
secured wireless network.

If you have multiple saved wireless networks in range, Ubuntu may oose
to connect to one of them, while you may prefer to connect to another. In
this case, cli on the NetworkManager icon. You should see a list of wireless
networks in range, along with their signal meters. Cli on your desired
network.

If the password and other seings have not anged, Ubuntu will connect
to the wireless network you ose. If the password did ange, Ubuntu will
open the “Wireless Network Authentication Required” window. In this case,
please follow instructions in the previous section.

Connecting to a hidden wireless network
In some circumstances, you may need to connect to a hidden wireless net-
work. ese hidden networks do not broadcast their names—whi means
that they will not show up in the list of wireless networks in the Network-
Manager menu. In order to be able to connect to a hidden network, you will
need to get its name and its security seings from your network administra-
tor.

To connect to a hidden network:
. Cli on the NetworkManager icon in the top panel.
. Choose the Connect to Hidden Wireless Network option. Ubuntu should

open the “Connect to Hidden Wireless Network” window.
. By default, the Connection field should show “New…”—you can leave this

unanged.
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. In the Network name field, enter the name of the wireless network. is
name is also known as an “SSID”. Please enter the network name exactly
as it was given to you.

. In theWireless security field, select one of the options. If the network is
open, leave this field as “None”. If you do not know the correct seing for
the network you will not be able to connect to the hidden network.

. Cli on the Connect buon.

.e rest of the process should work exactly as in the section on the initial
.

.verify that the hidden network
does show up as described .

connection to wireless networks. Once set up according to the instructions
above, the hidden network should show up in the list of saved networks.

Disabling and enabling your wireless network card
Wireless access in Ubuntu is enabled by default if you have a wireless net-
work card in your computer. In certain cases, for example on airplanes, you
may need or be required to turn your wireless radio off.

To do this, right-cli on the NetworkManager icon, and deselect the En-
able Wireless option. Your wireless network will be turned off, and your
computer will no longer sear for available wireless networks.

To turn wireless networking ba on, right-cli on the NetworkManager
icon, and cli on the Enable Wireless option to re-select it. Your wireless
network will be turned ba on. Ubuntu will then sear for nearby wireless
networks and will connect to any saved networks within range.

Changing an existing wireless network
At times, you may want to ange the seings for a wireless connection that
you have previously saved. Its password may have anged, or your system
administrator asked you to ange some networking or security seings.

To edit a saved wireless network connection:

. Right-cli on the NetworkManager icon and select Edit Connections…
. A “Network Connections” window should open. Cli on theWireless tab

to see a list of saved wireless connections
. By default, this list shows connections in the order of most recently used to

least recently used. Find the connection you want to edit, cli on it, and
then cli Edit.

. Ubuntu should open a window called “Editing connection name”, where
connection name is the name of the connection you are editing. e win-
dow should display a number of tabs.

. Above the tabs, you may ange the Connection name field if you want to
give the connection a more recognizable name

. If the Connect automatically option is not selected, Ubuntu will detect
the wireless network but will not automatically connect to it without you
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oosing it from the NetworkManager menu. Select or deselect this seing
as needed.

. On theWireless tab of the “Editing connection name” window, you may
need to edit the SSID field. A “SSID” is the wireless connection’s network
name—if set incorrectly, the network may not be detected and a connection
may not be made. Please make sure that the SSID is set according to your
network administrator’s instructions.

. Below the SSID, you should see theMode field. e “Infrastructure” mode
means that you would be connecting to a wireless router or access point.
is is the most common mode for wireless networks. e “Ad-hoc” mode
is a computer-to-computer mode and is oen only used in advanced cases.

. On theWireless Security tab of the “Editing connection name” window,
you may need to ange the Security field to the correct seing. A selec-
tion of None means that you are using an open network with no security.
Other selections may require slightly different additional information:
‣ WEP /-bit Key is an older security seing still in use by some
wireless networks. If your network uses this security mode, you will
need to enter a key in the Key field that should appear aer you select
this mode. e key is usually entered as a sequence of digits  through 
and leers A through F. .

.
.is this true? or will it support a
passphrase too here? .

‣ WEP -bit Passphrase is the same older security seing as the entry
above. However, instead of a key, your network administrator should
have provided you with a text passphrase—a password—to connect to
the network. Once you select this security mode, you will need to enter
your passphrase in the Key field.

‣ WPA &WPA Personal is the most common security mode for wire-
less network connections at home and at businesses. Once you select
this mode, you will need to enter a password in the Password field.

‣ If your network administrator requires LEAP, Dynamic WEP, or WPA
& WPA Enterprise security, you will need to have the administrator
help you set up those security modes

. On the IPv Settings tab, you may need to ange theMethod field from
“Automatic (DHCP)” to “Manual”, or one of the other methods. For seing
up manual seings (also known as static addresses), please see the section
above on manual set up for wired network connections.

. When you finish making anges to the connection, cli Apply to save
your anges and close the window. You can cli Cancel to close the
window without making anges.

. Finally, cli Close on the “Network Connections” window to return to the
desktop.

Aer making anges, your new seings should go into effect immediately.
. ..TODO confirm if this is true .
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Troubleshooting common problems with wireless connections
. ..Needs to be wrien or removed .

Dialup
Other connection methods
ere are other ways to get connected with Ubuntu.

With NetworkManager, you can also configure Mobile Broadband con-
nections to keep online through your cellular or other mobile data carrier.
. ..expand; it’s actually prey simple .

You can also connect to DSLs (Digital Subscriber Lines), whi are a
method of Internet connection that uses your telephone lines and a “DSL
modem”. . ..expand .

You can also use NetworkManager to establish a VPN (Virtual Private
Network) connection. ese are commonly used to create secure connectivity
to a workplace. . .

.I think that in some areas, VPNs
are used in addition to normal
DSL/Cable/fibre connections to
the home… if so, need to cover
them here at least briefly .

Browsing the web
Once you have connected to the Internet, you should be able to browse the
web with Ubuntu. Mozilla Firefox is the default application for browsing the
web in Ubuntu.

Starting Firefox
To start Firefox, open the Applications menu, then oose Internet, and
oose Firefox Web Browser.

If your keyboard has a “WWW” buon, you can also press that buon to
start Firefox.

Navigating web pages
Viewing your homepage
When you start Firefox, you will see your home page. By default, you will see
the Ubuntu Start Page.

To display more web content on the screen, you can use Full Screen mode.
Full Screen mode condenses the Firefox’s toolbars into one small toolbar. To
enable Full Screen mode, simply oose View ‣ Full Screen or press F11.

To go to your home page quily, press Alt+Home.

Navigating to another page
To navigate to a new web page, you need to type its Internet address (also
known as a URL) into the Location Bar. URLs normally begin with “hp://”
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Figure .: This is the default home page for
Firefox web browser.
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followed by one or more names that identify the address. One example is
“hp://www.ubuntu.com/”.

Figure .: You can enter a web address in
the location bar.To navigate:

. Cli on the Location Bar to select the URL that is already there.
. Type the URL of the page you want to visit. e URL you type replaces

any text already in the Location Bar.
. Press Enter.

To quily select the URL of the Location Bar, press Ctrl+L.
If you don’t know a URL, try typing something specific to the page you

want to visit (for example a name or other sear request) into the Location
Bar and press Enter. is will sear your preferred sear engine—Yahoo by
default—for that term, and take you to the web page that is the top result from
the sear.

Clicking a link
Most web pages contain links you can cli to move to other pages.

To cli a link:

. Move the mouse pointer until it anges to a pointing finger. is happens
whenever the pointer is over a link. Most links are underlined text, but
buons and pictures on a web page can also be links.

. Cli on the link once. While Firefox locates the link’s page, status mes-
sages will appear at the boom of the window.

Retracing your steps
If you want to visit a page you have seen before, there are several ways to do
so.

‣ To go ba or forward one page, cli on the Ba or Forward buon.
‣ To go ba or forward more than one page, cli on the small triangles
on the Ba and Forward buons. You should see a list of pages you’ve
recently visited. To return to a page, select it from the list.

‣ To see a list of any URLs you’ve typed into the Location Bar, cli on the
down arrow at the right end of the Location Bar. To view a page, select it
from the list.

‣ To oose from pages you’ve visited during the current session, open the
History menu and oose from the list in the boom section of the menu.
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‣ To oose from pages you’ve visited during the past several sessions, open
the History menu and oose Show All History. Firefox should open a
“Library” window, whi should a list of folders. Cli on the folders to
displays subfolders, or titles of web pages you’ve visited in the past. Cli
on a page’s title to view that page.

Stopping and reloading
If a page is loading too slowly or you no longer wish to view a page, cli on
the Stop buon.

To reload the current page or to get the most up-to-date version, cli on
the Reload buon or press Ctrl+R.

Opening new windows
At times, you may want to have more than one browsing window. is may
help you organize your browsing session beer, or separate web pages that
you are viewing for different reasons.

ere are two ways to create a new window:
‣ On the menubar, open the File menu, then oose NewWindow
‣ Press Ctrl-N
Once a new window has opened, you can use it just like the first window

—including navigation and opening tabs.

Opening a link in a new window
Sometimes, you may want to cli on a link to navigate to another web page,
but do not want the original page to close. To do this, you can open the link
you’d like to cli in its own window.

ere are two ways to open a link in its own window:
‣ Right-cli on a link to open its popup menu. Choose the Open Link in
New Window option. A new window should open, containing the web
page for the link you clied.

‣ Press-and-hold the Shift key while cliing the link. A new window
should open, containing the web page for the link you clied.

Tabbed browsing
If you would like to visit more than one web page at a time, you can use
Tabbed Browsing to navigate the web.

Tabbed browsing lets you open several web pages within a single Firefox
window, ea displaying in its own tab. is frees up space on your desk-
top since you don’t have to have a window open for every web page you’re
currently visiting. You can open, close, and reload web pages in one place
without having to swit to another window.
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Opening a new blank tab
ere are three ways to create a new blank tab:
‣ Cli on the New Tab buon on the right side of the last tab.
‣ On the menubar, open the File menu, and then oose New Tab.
‣ Press Ctrl+T.
When you create a new tab, it will contain a blank page with the Location

Bar focused. Start typing a web address (URL) or other sear term to open a
website in the new tab.

Opening a link in its own tab
Sometimes, you may want to cli on a link to navigate to another web page,
but do not want the original page to close. To do this, you can open the link
you’d like to cli in its own tab.

ere are three ways to open a link in its own tab:
‣ If your mouse has a middle buon, or a wheel, cli on the link with the
middle mouse buon or wheel. A new tab should open, containing the web
page for the link you clied.

‣ Cli on the link with the le mouse buon, and keep holding down the
mouse buon. Drag the link up to a blank space on the tab bar, and release
the mouse buon. A new tab should open, containing the web page for the
link you dragged.

‣ Press-and-hold the Ctrl key while cliing the le mouse buon on the
link. A new tab should oepn, containing the web page for the link you
clied.

Closing a tab
Once you are done viewing a web page in a tab, you can close that tab.

ere are three ways to close a tab:
‣ Cli on the Close buon on the right side of the tab you want to close.
‣ On the menubar, open the File menu, and then oose Close Tab.
‣ Cli on the tab you want to close with the middle mouse buon, or the
mouse wheel, if you have one.

‣ Press Ctrl+W.

Restoring a closed tab
Sometimes, you have closed the wrong tab by accident, or for another reason
would want to bring ba a tab that you’ve recently closed.

To bring ba a tab you’ve closed:
‣ On the menubar, open the History menu, oose Recently Closed Tabs,
and then oose the name of the tab you want to restore.
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‣ Press Ctrl+Shift+T to re-open the most recently closed tab.

Changing the tab order
To move a tab to a different location on the tab bar, drag it there using your
mouse. Cli-and-hold on the tab and drag the tab to a new place on the tab
bar. While you are dragging the tab, Firefox will display a small indicator to
show where the tab will be moved.

Moving a tab between windows
If you have more than one Firefox window open, you can move an open tab to
a different window. You can also split a tab off to become its own window.

To move a tab from one Firefox window to another already open window,
cli-and-hold on the tab and drag it to the tab bar on the other Firefox win-
dow. When you release the mouse buon, the tab will be aaed to the new
window.

To move a tab from one window into its own window, cli-and-hold
on the tab and drag the tab below the tab bar. When you release the mouse
buon, the tab will become a new window.

Searching
You can sear the web, or other collections, from within Firefox without first
visiting the home page of the sear engine.

By default, Firefox will sear the web using the Yahoo sear engine.

Searching the web
To sear the web in Firefox, type a few words into the Firefox Sear Bar.

For example, if you want to find information about the world cup:

. Cli on the Sear Bar.
. Type the phrase “world cup”. Your typing replaces any text currently in the

Sear Bar.
. Press Enter to sear.

Sear results from Yahoo for “world cup” should appear in the Firefox
window.

Selecting search engines

If you do not want to use Yahoo as your sear engine in the Sear Bar,
you can ange the sear engine that Firefox uses.

To ange the sear engine, cli on the icon on the le side of the Sear
Bar. Choose one of the other sear engines in the list. Some sear engines,
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Figure .: These are the other search
engines you can use from the search Firefox
bar.

like Yahoo, sear the whole web; others, like Amazon.com, only sear spe-
cific sites.

Searching the web for words selected in a web page
Sometimes, you may want to sear for a phrase that appears on a different
web page. Instead of copying and pasting the phrase into the Sear Bar,
Firefox allows you to sear the web for words you select within a web page.
. Highlight any words in a web page using your le mouse buon.
. Right-cli on the text you’ve highlighted to open a popup menu. Choose

the option Sear [Sear Engine] for “[your selected words]”.
Firefox should open a new tab whi should contain sear results for your

highlighted words using the currently selected sear engine.

Searching within a page

Figure .: You can search within webpages
using the find toolbar.You may want to look for specific text within a web page you are viewing.

To find text within the page you are currently viewing in Firefox:
. Press Ctrl+F or oose Edit ‣ Find to open the Find Toolbar at the boom

of Firefox.
. Enter the text you want to find into the Find field in the Find Toolbar. e

sear automatically begins as soon as you type something into the field.
. Once some text has been mated on the web page, you can:

‣ Cli Next to find text in the page that is below the current cursor
position
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‣ Cli Previous to find text that is above the current cursor position.
‣ Cli on the Highlight all buon to highlight occurrences of your
sear words in the current page.

‣ Select theMat case field to limit the sear to text that has the same
capitalization as your sear words.

To find the same word or phrase again, press F3 or oose Edit ‣ Find
Again from the menubar.

Copying and saving pages
With Firefox, you can copy part of a page so that you can paste it elsewhere,
or save the page or part of a page as a file on your computer.

Copying part of a page
To copy text from a page:

. Highlight the text with your mouse.
. Choose Edit ‣Copy from the menubar.

You can paste the text into other programs.
To copy a link (URL) or an image link from a page:

. Position the pointer over the link or image.
. Right-cli on the link or image to open a popup menu.
. Choose Copy Link Location or Copy Image Location. If an image is also

a link, you can oose either menu item.

You can paste the link into other programs or into Firefox’s Location Bar.

Saving all or part of a page
To save an entire page in Firefox:

. Choose File ‣ Save Page As from the menubar. Firefox should open the
“Save As” window.

. Choose a location for the saved page.
. Type a file name for the page, and cli Save.

To save an image from a page:

. Position the mouse pointer over the image.
. Right-cli on the image to display a popup menu.
. Choose Save Image As. Firefox should open the “Save Image” window.
. Choose a location for the saved image.
. Enter a file name for the image and cli Save.
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Changing your homepage
Bu default, Firefox will show the Ubuntu Start Page when you start Firefox.
If you prefer to display another page when you start Firefox, you will need to
ange your homepage preference.

Figure .: You can change Firefox seings
in this window.

To ange your homepage:

. Navigate to the page that you would like to become your new homepage.
. Choose Edit ‣ Preferences from the menubar.
. In the “Startup” section on theMain tab, whi is shown by default, cli

on the Use Current Pages buon. If you had more than one tab open then
all the tabs will be opened when Firefox starts.

. Cli Close.

Bookmarks
When browsing the web you may want to come ba to certain web pages
again without having to remember the URL.

In Firefox, you can create Bookmarks, whi are saved in the web browser
and whi you can use to navigate ba to your pied web pages.
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Bookmarking a page
If you have navigated to a web page and would like to bookmark it for future
visits, you will need to add the page as a bookmark.

ere are two ways to bookmark a page:
‣ From the menubar, oose Bookmarks and then Bookmark is Page. A
window will open. Provide a descriptive name for the bookmark, and cli
on the Done buon.

‣ Press Ctrl+D. A window will open. Provide a descriptive name for the
bookmark, and cli on the Done buon.

Navigating to a bookmarked page
To navigate to a bookmarked page, open the Bookmarks menu from the
menubar, and then oose your bookmark’s name. Firefox should open the
bookmark in the current tab.

You can also press Ctrl+B to display bookmarks in a sidebar on the le side
of the browser window. Press Ctrl+B again to hide the sidebar

Deleting a bookmark
If you would like to delete a bookmark that you have previously made, open
the Bookmarks menu from the menubar, and then right-cli on your book-
mark’s name. Firefox should open a popup menu for your bookmark. Choose
the Delete option from the menu. Your bookmark should then be deleted.

History
Whenever you are browsing the web, Firefox is saving your browsing history.
is allows you to come ba to a web page that you have previously visited
without needing to remember the page’s URL, or even bookmarking it.

To see your most recent history, open the History menu from the menubar.
e menu should then display several of the most recent web pages that you
were viewing. Choose one of the pages to return to it.

To see history from an older time, press Ctrl+H. Firefox should open a
“sidebar” on the le side of the browser window, whi should contain your
browsing history categorized as Today, Yesterday, Last  days, is month,
and then monthly for the times before that.

Cli on one of the item categories in the sidebar to expand this category,
and see the pages you’ve visited during that time period. en, once you find
the page you need, cli on its title to return to it.

You can also sear for a page by its title. Enter a few leers, or a word,
in the Sear field at the top of the history sidebar. e sidebar should then
display a list of web pages whose titles mat your sear words. Cli on the
title of the page you need to return to it.
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If you would like to hide the history sidebar again, press Ctrl+H again.

Clearing private data
At times, you may want to delete all private data that Firefox stores about
your browsing history. While this data is stored only on your computer, you
may want to remove it if you share access to your computer.

To delete your private data, open the Tools menu from the menubar, and
oose Clear Recent History. In the drop down list for the Time range to
clear, oose how far ba you would like Firefox to delete.

If you would like more control over what you clear, cli on the Details
text to display a list of options.

When done, cli on the Clear Now buon.

Using a different web browser

Figure .: You can change the default
browser in this window.

If you install a different web browser on your computer, you may want to
have Ubuntu use that new browser by default when you cli on links from
emails, instant messages, and other places.

To ange your preferred web browser, open the System menu from
Ubuntu’s main menubar. en, oose System, and oose Preferred Ap-
plications. Ubuntu should then open the “Preferred Applications” window.

In the “Web Browser” section, oose your new preferred web browser, and
cli Close.
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Reading and composing email
To send and receive email in Ubuntu, you can use the Evolution mail appli-
cation. To start Evolution, open the Applications menu, then oose Internet
and then Evolution Mail.

In addition to email, Evolution also can help manage your contact list, your
calendar, and a list of tasks.

You do not need to use Evolution if you are using a webmail system, su as
Yahoo Mail, Hotmail, or Gmail. To access these services, use the Firefox web
browser to access them on the web.

Running Evolution for the first time
When you start Evolution for the first time, you will need to configure it to
connect to your email account.

When Evolution starts you should see the “Evolution Setup Assistant”
window, welcoming you to Evolution. Cli Forward to continue with the
setup.

Next, on the “Restore from baup” screen, Evolution may ask you to
restore from a previous baup. Since this is the first time you are running
Evolution, you can cli Forward to skip this step.

On the next screen, “Identity”, you need to enter your name and the email
address you wish to use with Evolution. Enter your full name in the Full
Name field, and the full email address in the Email Address field. You can
fill in the optional information, or leave it unanged if you desire. Cli
Forward when you are done.

Next, you should see the “Receiving Email” screen. On this screen, you
need to provide Evolution with the details of your email servers. If you do not
know these details, you will need to ask your network administrator or e
with your email provider.

ere are two common types of Internet email connections: IMAP, and
POP. ese are described below. In work environments there are sometimes
other types, su as Microso Exange or Novell GroupWise—for more
information on those types of connections, please see the documentation for
Evolution.

Seing up an IMAP connection
IMAP connections allow you to manage your email remotely—the actual
email and folders reside on your email server, while Evolution allows you to
view, edit, and delete the messages and folders as needed.

If your email provider recommends an IMAP connection, oose IMAP
from the Server Type drop-down list. In the Server field, enter the Internet
name of your mail server. For example, imap.example.com. In the Username



 getting started with ubuntu 10.04

field, enter the username that you use to log into your email system, for
example joe.x.user.

Your email provider may specify the security seings you will need to use
in order to receive email. If your connection does not use security, leave the
Use Secure Connection drop-down list set to No encryption. Otherwise,
oose either TLS encryption or SSL encryption as recommended by your
email provider.

Aer oosing these options, cli Forward to proceed to “Receiving Op-
tions” screen. While it is normal to leave all options unselected, you may
want to select the Che for new messages option to have Evolution auto-
matically e email on a regular basis.

When you are finished seing the options, cli Forward to continue to
the next screen.

Seing up a POP connection

POP connections let you manage your email locally—Evolution will connect
to your email provider and download any new messages you may have re-
ceived, and store them in folders on your computer. e messages will be
deleted off the server.

If your email provider recommends an POP connection, oose POP from
the Server Type drop-down list. In the Server field, enter the Internet name
of your mail server. For example, pop.example.com. In the Username field,
enter the username that you use to log into your email system, for example
joe.x.user, or joe.x.user@example.com.

Your email provider may specify the security seings you will need to use
in order to receive email. If your connection does not use security, leave the
Use Secure Connection drop-down list set to No encryption. Otherwise,
oose either TLS encryption or SSL encryption as recommended by your
email provider.

Aer oosing these options, cli Forward to proceed to “Receiving Op-
tions” screen. While it is normal to leave all options unselected, you may
want to select the Che for new messages option to have Evolution auto-
matically e email on a regular basis.

You may also wish to adjust the Message Storage options, whi determine
what Evolution does aer downloading email to your computer. Select the
Leave messages on server option to have Evolution keep the messages on
your email system aer downloading them. is will allow you to use another
computer to redownload all of your new messages. Select the Delete aer 
days option to have Evolution keep the messages for a few days, and delete
them aer a while. You can adjust the number of days that Evolution keeps
the messages.

When you are finished seing the options, cli Forward to continue to
the next screen.
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Seing up your Sending options
e next screen should be the “Sending Email” screen. Here, you will need to
configure your connection for sending email through your email provider.

e most common type of sending connection is SMTP, whi is the de-
fault server type selected.

In the Server field, type in the name of the outbound mail server (also
known as the SMTP server), as described by your email provider. For example,
mail.example.com.

If your email provider requires authentication, select the Server requires
authentication option. is is common for commercial email providers. In
the “Authentication” section of the screen, oose the type of authentication
from the Type drop-down list—the most common authentication type is
“PLAIN”. Enter your username below, in the Username field, for example
joe.x.user, or joe.x.user@example.com.

Your email provider may specify the security seings you will need to use
in order to send email. If your connection does not use security, leave the Use
Secure Connection drop-down list set to No encryption. Otherwise, oose
either TLS encryption or SSL encryption as recommended by your email
provider.

Aer oosing these options, cli Forward to proceed to the next screen.

Finalizing account options
On the next screen, “Account Management”, enter a descriptive name for this
account. If you plan to use more than one email provider with Evolution, you
will use this name to distinguish between the different accounts.

When finished, cli Forward. is should open the “Done” screen. If you
believe that you’ve entered the correct options, cli Apply to finish setup.
Otherwise, cli Ba to go ba one or more screens to correct your seings,
or cli Cancel to abort setup and discard your account seings.

Aer you finish setup, Evolution may ask you if you would like to make it
your default email client. Cli Yes if you plan on reading and sending email
only with Evolution. Cli No if you plan on installing or using a different
email program.

Around the Evolution workspace

e Evolution window is divided into four parts. At the top are the
menubar and toolbar. e menubar lets you access most of the functional-
ity of Evolution, while the toolbar provides some convenient shortcuts to
some of the most frequently used features.

On the le side of the window is the folder list. Every message that you
send or receive will reside in one of the folders in this list.



 getting started with ubuntu 10.04

Figure .: Evolution allows you to manage
your mail, contacts and tasks.
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Below the folder list on the le side of the window are theMail, Contacts,
Calendars, Tasks, andMemos buons. When working with email, theMail
buon is selected. e other buons take you to other parts of Evolution.

On the right side of the window are the message list, and the message
preview beneath it. e message list shows all of the messages in the currently
selected folder, or mating your sear request. e message preview shows
the contents of your currently selected message in the list above the preview.

Understanding the folder list
e folder list is the way that Evolution separates and categorizes your email.
e first group of folders in the list is titled “On is Computer”. is set of
folders are you local folders—they reside on your computer only. If you use
POP servers to retrieve your email, any new message will be placed in the
Inbox local folder.

You can cli on any folder to see its contents appear in the message list on
the right side of the window.

Ea of the initial folders in the list is special:
‣ Inbox stores your incoming messages.
‣ Dras stores messages that you’ve worked on, but have not yet sent.
‣ Junk stores messages that have been identified as being junk. Junk mail is
also known as “spam”.

‣ Outbox contains messages that you’ve finished composing, but whi have
not been sent yet. For example, if you are working on your email whlie
offline (su as in an airplane), you can still cli the Send buon on an
email message that you finish writing. e message will be moved to the
Outbox, and will remain there until the next time you are able to send
and receive messages. Once you can send and receive messages, all email
messages in the outbox will be sent out.

‣ Sent contains copies of messages that you had sent. Once a message from
an Outbox is sent, it is copied to the Sent folder.

‣ Templates stores email message templates—partial messages that you have
composed and saved as templates. You can use a message stored in the
template folder as a starting point for other messages.

‣ Trash contains messages that you have deleted. By default, the trash will
be emptied every time you exit Evolution.
If a folder contains any unread messages, the folder’s name will be dis-

played in bold, and the number of unread messages will be displayed in
parentheses following the folder name.

If you use an IMAP server to retrieve your email, then your remote IMAP
folders will be shown in the folder list below the “On is Computer” section.
e list of remote folders will be shown with a heading of the name that you
have given to the account. With IMAP, your email messages will arrive in
your remote Inbox.
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Towards the boom of the folder list, Evolution will show a list of “Sear
Folders”. ese are special folders that represent certain messages that mat
sear rules. Please see the section on Finding Messages for more on sear
folders.

Managing folders
In addition to the initial folders, you can create your own folders to manage
your email.

To create a new folder, open the Folder menu, and then oose New. Enter
a name for the folder that you would like to create. en, from the list of
folders below, select the parent folder. For example, if you would like your
new folder to be placed under the Inbox then select the Inbox folder. If you
select “On is Computer”, then your new folder will be placed under “On
is Computer” in the folder list.

Once you’ve made your selection, cli on the Create buon to create the
folder. Your new folder should now be in the folder list.

You can move folders that you have created. To do so, cli on the folder
that you would like to move, hold down the mouse buon, and drag the folder
to a new parent folder. Once the mouse cursor highlights a new parent folder,
release the mouse buon to finish the move.

You can also right-cli on a folder, and oose theMove… option. en,
select the new parent folder, and cli on theMove buon.

To delete a folder, right-cli on the folder and oose the Delete option.
To confirm that you want to delete the folder, cli on the Delete buon.

Checking and reading messages
Checking mail
When you finish setup, or when you start Evolution in the future, Evolution
will first try to connect to your email provider to e your email. In order to
connect, Evolution will need to know your email account password, and will
ask you for it.

Figure .: You need to enter your pass-
word to authenticate your account.
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In the “Enter Password” window, enter your password and cli “OK”. If
you wish for Evolution to remember this password and not ask you in the
future, you can select the Remember this password option.

Evolution will then show a “Send and Receive” window, showing the
progress of the operation su as how many messages are being retrieved.

Listing messages
e top right portion of the Evolution window is the message list. Here, you
can see email messages for your currently selected folder, or mating your
sear terms.

M I S S I N G S C R E E N S H O T
Small view of the message list, showing column headers and a few email messages

Figure .: Small view of the message list,
showing column headers and a few email
messages

By default, the message list shows six columns of information for ea
message. e first column is a read/unread indicator. If a message has been
read, the column shows an icon of an open envelope. If a message has not
been read, the icon will show a closed envelope.

e second column is an aament indicator. If a message contains an
aaed file, Evolution will show an icon of a paperclip in this column. Oth-
erwise, the column will be blank.

e third column is an importance indicator. If someone sends you a
message marked with high importance, Evolution will show an exclamation
mark in this column. Otherwise, this column will be blank.

e fourth column contains the sender of the message. Both the name and
email, or just the email address, may be displayed in this column.

e fih column contains the subject of the email message.
Finally, the sixth column is the date that the email was sent.
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When you cli on a message, its contents will be displayed in the preview
pane below the message list. Once you select a message by cliing it, you can
cli on the Reply buon in the toolbar to begin composing a reply message
to be sent to the sender, or cli on the Reply to All buon to begin com-
posing a reply message to be sent to the sender and other recepients of your
selected message.

You can also cli on the Trash buon in the toolbar in order to put the
message in the Trash folder, or on the Junk buon to put the message as in
the Junk folder. Note that Evolution, or your mail server, may automatically
classify some mail as Junk.

In addition to the buons on the toolbar, you can right-cli on a message
in the list. Evolution will open a menu with actions that you can perform for
the message.

Sometimes, you may wish to take an action on multiple email messages
(for example, delete multiple messages, or forward them to a new recepient).
To do this in Evolution, press-and-hold the Ctrl key while cliing on multi-
ple messages—the messages you cli on will be selected. You can also cli
on one message to select it, then press-and-hold the Shift key and cli on
another message in the list. All messages in the list between the original selec-
tion and the one you just clied on will be selected. Once you have multiple
messages selected, right-cli on one of them to perform your desired action.

Directly above the message list are the Show drop-down list, and the
sear options. You can use the Show drop-down list to filter your view to
show only unread messages, or only messages with aaments, etc.

e sear options will be covered in a later section.

Previewing messages
When you select an email message, its contents will be shown in the preview
pane below the message list.

e top of the preview pane will show the message header, whi contains
the sender, recepients, and subject of the message, as well as the date the
message was sent. Below the header, Evolution shows the contents of the
message itself.

If a message was sent with HTML formaing, some of the images may not
be displayed when a message is previewed. To display the missing images,
open the View menu from the menubar, then Load Images, or press Ctrl+I.
If your Internet connection is active, the missing images should then load. Note that loading images may provide a

way for the sender to track your receipt of
the message. We do not recommend loading
images in messages that you suspect are
Junk.

Opening messages
At times, you may want to display multiple messages at the same time. To do
so, you can open ea message in a separate window instead of just viewing it
in the preview pane.

e open a message in its own window, double cli a message in the
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message list. e message should then open in a separate window. You can go
ba to the message list and open another message, if needed.

In the open message window, you can use the options in the menubar or on
the toolbar to reply to the message, categorize it, delete it, as well as perform
other message actions.

Finding messages

ere are three ways to sear for messages in Evolution: you can use the
sear option at the top of the message list, use the Advanced Sear function,
or create a sear folder.

To use message list sear, enter the text you want to find in the Sear
field at the top right of the message list, and press Enter. e list of messages
will ange to show only those messages containing the text you entered.

To the right of the sear field you should be able to see a drop-down list
of options su as “Current Folder”, “Current Account”, and “All Accounts”.
By default, Evolution will use the “Current Folder” option and will only
show you results within the folder you’ve got selected in the folder list on
your le. If you oose the “Current Account” option, Evolution will sear
for messages in all folders within the current email account—su as all the
folders “On is Computer” or in your IMAP folders, depending on your
email setup. If you have multiple email accounts added to Evolution, oosing
the “All Accounts” option lets you sear for messages in all of your accounts.

If no messages mat the text you’ve entered, you can edit the text and
try searing again. To return to the folder display, open the Sear menu
from the menubar and then oose Clear, or instead erase all the text you’ve
entered in the Sear field and press Enter.

In some cases, you may want to sear for messages using multiple criteria.
For example, you may want to find a message from a particular user with
some specific words in the subject of the message. In Evolution, you can
perform this sear using the Advanced Sear function.
Sear.png

To use Advanced Sear, oose Sear ‣Advanced Sear. Evolution
should open the “Advanced Sear” window. In the middle section of the
window, specify your sear criteria. For our example, to find messages from
myfriend@example.com that contained “boat” in the subject, you would enter
myfriend@example.com in the text field to the right of the drop-down list with
“Sender” selected, and would enter boat in the text field to the right of the
drop-down list with “Subject” selected. en, cli on Remove to the right of
all lines that are unused, and cli OK to perform the sear. e message list
should then only display messages that mat your advanced sear criteria.

When specifying the criteria for advanced sear, you can cli on the Add
Condition buon to add additional lines. You can also ange the selection
in the drop-down list at the beginning of ea line to specify a different field
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Figure .: To use more search terms you
can use the advanced search window.

to be eed, or ange the drop-down with “contains” selected by default
in order to have a different type of a mat. Please refer to the Evolution help
documents for more information.

In some cases, you may want to perform the same sear request on a reg-
ular basis. For example, you may want to always be able to see all messages
from myfriend@example.com regardless of whi folder you’ve used to store
the message. To help with this type of a sear, Evolution allows you to create
Sear Folders.

To create a sear folder, oose Sear ‣Create Sear Folder From
Sear from the menubar. Give the folder a name by entering it in the Rule
name field at the top. en, specify sear criteria in the same way as in
Advaned Sear. Below the criteria, pi whi folders should be seared by
this sear folder—for example, you can oose “All local and active remote
folders” to sear in all of your account’s folders. When you are finished, cli
OK.

e new sear folder should now be added to the list of sear folders
towards the boom of the message list. If you cli on the sear folder to
select it, you should be able to see a list of messages that mat your sear
criteria.

Subscribing to IMAP folders
If you use IMAP to retrieve your email, you should see a set of folders in the
folder list on the le side of the window that is titled with the name of your
IMAP account. Folders like Inbox, Dras, Junk and others should be displayed
in the folder list.
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If you have other folders in your IMAP account, you will need to subscribe
to them. If you subscribe to a folder, Evolution will download messages for
that folder whenever you e your email.

To subscribe to a folder select Folder ‣ Subscriptions from the menubar.
Evolution should open the “Folder Subscriptions” window. From the Server
drop-down list oose your account name. Evolution should then show a list
of folders in the list below.

Choose the folders you would like to subscribe to by selecting the e
box to the le of the folder name. When you are finished, cli Close. e
folders will be updated the next time you e your email.

Composing and replying to messages
In addition to reading email, you will likely want to reply to the email you
read, or compose new messages.

Composing new messages
To compose a new message, cli on the New buon on the toolbar. Evolution
should open a “Compose message” window.

In the To: field, enter the email address of the destination—the contact to
whom you are sending this email. If there is more than one contact to whom
you are writing, separate multiple recipients with commas.

If a contact that you are addressing is in your address book, you can ad-
dress them by name. Start typing the name of the contact; Evolution will
display the list of mating contacts below your text. Once you see the con-
tact you intend to address, cli on their email address or use the down arrow
key and then Enter to select the address.

If you would like to carbon-copy some contacts, enter their email addresses
in the Cc: field in the same manner as the To: recipients. Contacts on the To:
and Cc: lines will receive the email, and will see the rest of the contacts to
whom an email was sent.

If you would like to send an email to some contacts without disclosing to
whom your email was sent, you can send a blind carbon-copy, or “Bcc”. To
enable Bcc, select View ‣Bcc Field from the menubar. A Bcc: field should ap-
pear below the Cc: field. Any contacts entered in the Bcc field will receive the
message, but none of the recipients will see the names or emails of contacts on
the Bcc line.

Instead of typing the email addresses, or names, of the contacts you are
addressing in the message, you can also select the contacts from your address
book. To do so, cli on the To:, Cc: or Bcc: buons to the le of the text
fields. Evolution should open the “Select Contacts from Address Book” win-
dow. Use the list on the le side of the window to select your contact, or type
a few leers from your contact’s first or last name in the Sear field to filter
the list to only show mating contacts.
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Once you identify the contact you would like to address, cli on their
name in the list. en, cli on the Add buon to the le of either the “To:”,
“Cc:”, or “Bcc:” fields on the right of the screen. Your selected contact will
be added to that list. If you’ve added the contact in error, cli their name in
the list on the right, and cli on the Remove buon. When you are finished
piing contacts, cli Close to return to the composing screen.

Enter a subject for your email. Messages should have a subject to help the
recepient to identify the email while glancing at their message list; if you do
not include a subject, Evolution will warn you about this.

Enter the contents of your message in the big text field below the subject.
ere is no practical limit on the amount of text you can include in your
message.

By default, new messages will be sent in “Plain Text” mode. is means
that no formaing or graphics will be shown to the recepient, but the message
is least likely to be rejected or displayed illegibly to the receipients. If you
know that your recipient uses a contemporary computer and a modern email
program, you can send them messags that include formaing. To swit to
this mode, cli the drop-down list buon on the le side directly above the
text field for the message contents. Change the selection from “Plain Text”
to “HTML” to enable advanced formaing. When using HTML mode, a new
toolbar should appear right under the mode selection that will allow you to
perform advanced advanced font styling and message formaing.

When you have finished composing your email, cli on the Send buon
on the window’s toolbar. Your message will be placed in the Outbox, and will
be sent when you next e your email.

Aaching files
At times, you may want to send files to your contacts. To send files, you will
need to aa them to your email message.

To aa a file to an email you are composing, cli on the Add Atta-
ment buon at the boom right of the email message window. Evolution
should show the “Add aament” window.

Select the file you would like to include in your message and cli on the
Atta buon. Evolution will return you to the email message window, and
your selected file should be listed in a section below the Add Attament
buon.

Replying to messages
In addition to composing new messages, you may want to reply to messages
that you receive.

ere are three types of email replies:
‣ Reply (or “Reply to Sender”)—sends your reply only to the sender of the
message to whi you are replying.
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‣ Reply to All—sends your reply to the sender of the message, as well as
anyone else on the To or Cc lines.

‣ Forward—allows you to send the message, with any additional comments
you may add, to some other contacts.

To use any of these methods, cli on the message to whi you want
to reply and then cli the Reply, Reply to All, or Forward buon on the
toolbar.

Evolution should open the reply window. is window should look mu
like the window for composing new messages, but the To, Cc, Subject, and
main message content fields should be filled in from the message to whi you
are replying. Ea line in the message should be prefixed with a “>” aracter.

Edit the To, Cc, Bcc, Subject or main body as you see fit. When your reply
is finished, cli on the Send buon on the toolbar. Your message will be
placed in the Outbox, and will be sent when you next e your email.

Using signatures
In order to give your messages a footer, Evolution allows you to use a “signa-
ture”. Signatures in email are a bit of standard text that is added to the boom
of any new messages or replies.

When composing of replying to a message, cli on the Signature drop-
down list below the toolbar just above the To: field. is list should contain
any signatures that you have created, as well as an “Autogenerated” signature.
If you select Autogenerated, Evolution will add two dashes, and then your
name and email address to the boom of the email message.

You can also specify some custom signatures. To create a signature, open
the “Evolution Preferences” window by selecting Edit ‣ Preferences from
the menubar. On the le side of the Evolution Preferences window, select
Composer Preferences and then select the Signatures tab.

Cli on the Add to add a new signature. Evolution should then open
the “Edit Signature” window. Give your signature a name, and enter the
contents of your signature in the big text field below. When finished, cli
on the Save buon on the toolbar (the buon’s icon looks like a floppy disk).
Your new signature’s name should appear in the list in preferences. Close the
preferences window. Note that the two dashes are added auto-

matically by Ubuntu, so there is no need to
include them in your custom signatureYour signature should now show up in the drop-down list in the com-

pose/reply window.

Staying organized
e Evolution application in Ubuntu can let you keep and manage a list of
your contacts, maintain a calendar, and a task list.

If you have already set up Evolution with an email account, you do not
need to do any further setup to use these features. If you do not wish to
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use Evolution for email, you can still use it for managing your contacts or
maintaining a sedule, as well as keep tra of tasks and memos that you can
create for yourself.

To start Evolution, open the Applications menu, then oose Internet and
then Evolution Mail.

Managing your contacts

Figure .: You can view,edit and add
contacts.If you would like to keep a list of your contacts—personal or professional

contact information for people and organizations—you can manage these
contacts in Evolution.

To view contacts, cli on the Contacts buon below the folder list on
the le side of the Evolution window. e folder list on the le will be re-
placed by a list of address book types. Cli on an address book, for example
“Personal”.

e right side of the window will display a list of contacts. Cli a contact
to show the contact’s details in the lower portion of the right side of the
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window. An address book is a collection of contacts
and contact lists. It can either be stored on
your computer, or on a remote server.If you use Ubuntu One, you may have two address books—a “Personal”

address book stored on your computer, and an “Ubuntu One” address book.
You can add contacts to either address book, though only the “Ubuntu One”
address book is synronized to your Ubuntu One account.

Searching for contacts
To find a contact, type in a few a few leers from the contact’s first or last
name in the sear text box on the upper right of the window, and press
Enter. e list below should ange to only show contacts whose name
mates your sear term.

Adding or editing a contact
To make anges to an existing contact, find the contact in the list and double-
cli on the entry. Evolution should open a “Contact Editor” window for the
contact.

Swit between the different tabs in the contact editor to make anges to
the contact. Cli OK when you have finished making your anges.

To add a new contact, cli on the New on the toolbar. Evolution should
open the “Contact Editor” window. Enter the contact’s details in the contact
editor window, and cli OK when finished.

Managing your schedule
If you like to manage your sedule with a computer, you can maintain this
sedule in Ubuntu using Evolution.

To view your calendar, cli on the Calendars buon below the folder
list on the le side of the Evolution window. e folder list on the le will
be replaced by a list of calendars, and a mini-calendar showing the current
month.

Evolution allows you to manage more than one calendar. For example, you
could have a personal calendar and a sool or work calendar. You can also
subscribe to the calendar of a friend or family member who may oose to
share their calendar with you.

Cli on one of the calendars in the list. By default, you should have a
“Personal” calendar in the list. e middle of the window should now show a
view of the current day, showing all the hours of the current day.

If the calendar already has some events, Evolution will show the event in
the day view between the hours when the event starts and finishes. You can
double-cli on the event to open its details, or drag the event to a different
time or date to resedule it.

In the day view, you can cli on a different day on the mini-calendar on
the le side of the screen. Evolution will then display that day in the day
view.
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You may also wish to see more than one day at a time. is will allow you
to compare sedules on different days, or find a free day for an event you
wish to sedule. In Evolution, you can cli on theWork Week orWeek
buons on the toolbar to see an entire week at the same time. Cli on the
Month buon on the toolbar to see a view of the entire month—if an event
is difficult to read due to the small space aloed to ea day, you can hover
your mouse over the event to have Evolution show the full title of the event.
Finally, the List buon on the toolbar shows upcoming appointments in a list,
allowing you to see all of your upcoming appointments at a glance.

On the right side of the window, Evolution displays a list of tasks and
memos. You can add a new task or memo to Evolution

Adding a new event
e simplest way to add a new task is to cli a time in the day view, and
begin typing. An event “bubble” will appear, containing the text that you are
typing. If you want to add a longer event, drag your mouse from the first time
slot to the last before starting to type.

M I S S I N G S C R E E N S H O T
visual example of adding an event in the day view by typing

Figure .: visual example of adding an
event in the day view by typing

To add a new event without using the day view, cli on the New buon
on the toolbar. Evolution should open the “Appointment” window. In the
Summary field, enter a short title for the event as you want it to appear on
the calendar. Optionally specify the location and enter a longer description if
you would like. Make sure that the time and date, as well as the duration, are
as you want them. Finally, cli on the Save buon on the toolbar to save this
new event (the buon looks like a floppy disk, and is the first buon on the
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toolbar).

Scheduling a meeting
If you would like to sedule a meeting with one of your contacts, Evolution
can assist you in sending out an invitation and processing replies.

To create a meeting invitation, oose File ‣New ‣Meeting from the
menubar. Specify the subject, location, time and duration, and description as
when you create a regular event.

You will then need to add aendees to this meeting. To add an aendee,
cli on the Add buon. In the list of aendees, Evolution will add a new row
—type the aendee’s email address or contact name.

When you are finished adding aendees, cli on the Save buon on the
toolbar. Evolution should then ask you if you would like to send meeting invi-
tations to your selected participants. Cli Send to send out these invitations.
e invitations will be sent the next time you e email in Evolution.

If your contact ooses to reply to the meeting invitation, Evolution will
show you a new email message. In the body of the email message, Evolution
will display an Update Attendee Status buon. Cli on that buon to mark
your contact as aending the meeting.

Using instant messaging
Instant messaging allows you to communicate with people you know in real
time. Ubuntu includes the Empathy application that lets you use instant
messaging features to keep in tou with your contacts. To start Empathy,
open the Applications menu from the menubar, then oose Internet and
then Empathy IM Client.

Empathy lets you connect to many instant messaging networks. You
can connect to AIM™, Gadugadu, Google Talk, Groupwise, ICQ®, Jabber®,
MSN®, Myspace®, qq®, XMPP™, Sametime®, Silc, SIP, Yahoo®, or Zephyr.

Running Empathy for the first time
When you open Empathy for the first time you will need to configure it with
the details of your instant messaging accounts.

When Empathy starts you will see the “Welcome to Empathy” window.
Choose the option corresponding to your situation.

You have an account
If you have an account that you have used previously with another instant
messaging program then select the Yes, I’ll enter my account details now
option. en, cli Forward to continue.

On the next screen, oose your account type from the drop-down list
belowWhat kind of at account do you have?. en, enter your account
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details in the field below.
Depending on the account type that you oose, Empathy may request that

you enter a username, or an ID for your account, followed by a password.

Figure .: Creating a new instant messen-
ger account in Empathy.

If you do not remember your account information, you will need to visit
the website of the instant messaging network to retrieve that information.

If you have another account to add then select the Yes option, and cli
Forward to repeat the above process. When you have entered all the accounts
leave the No, that’s all for now option selected, and cli Apply to finish the
setup process.

Next, Empathy should display the “Please enter personal details” screen. If
you oose to fill out this information, you will be able to communicate with
people who are on your local network either at home or in an office.

Enter your first name in the First name field, and your last name in the
Last name field. Type in a way that you would like to be identified on your
local network in the Niname field. When you have filled all of the informa-
tion, cli Apply.

If you don’t want to communicate with people on your local network,
select the I don’t want to enable this feature for now option and cli
Apply.

You would like an account
If you don’t have an account that you can use, then you can create one by
selecting the No, I want a new account option. Cli Forward to display the
next set of options.

Choose the account type that you would like to create from the drop-down
list belowWhat kind of at account do you want to create? You can
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create either a Jabber® or a Google Talk account. Note: If you wish to create another account
type then you will need to visit the relevant
website and follow the “You have an
account” section.

Next, enter the account name that you would like in the text field, and in
the proceeding text field enter a password of your oice. If you would like
to set up another account then select the Yes option, and repeat the above
process.

When you have entered all the accounts leave the No, that’s all for now
option selected, and cli Forward.

Empathy should display the “Please enter personal details” window. Pro-
viding this information allows you to communicate with people who are on
your local network either at home or in the workplace.

Enter your First name in the text field, and enter your Last name in the
next field. In the Niname field enter a niname by whi you would like
to be identified. When you have filled all of the text fields cli Apply to save
your seings.

If you don’t want to talk to people on your local network then select the I
don’t want to enable this feature for now option and cli Apply.

You want to talk to people nearby

If you would only like to communicate with people on your local network
either at home or in the workplace, then you should select the No, I just want
to see people online nearby for now option.

Cli Forward to display the next set of options. en enter your First
name in the text field, and enter your Last name in the next field. In the
Niname field enter a niname by whi you would like to be identified.
When you have filled all of the text fields, cli Forward.

Figure .: You can talk to people nearby
by entering you information.



 getting started with ubuntu 10.04

Changing account seings
If you need to add more accounts aer the first laun, then open the Edit
menu, then oose Accounts. Empathy will then display the “Accounts”
window.

Adding an account
To add and account cli on the Add buon. Empathy should display some
options on the right hand side of the window. Choose your account type from
the Protocol drop-down list. Next, enter your account name in the first text
field. en enter your password in the Password text field. Finally cli on
the Log in buon to save and verify your seings.

Editing an account
You might need to edit and account if you ange the password or get the
password wrong. Select the account you want to ange on the le side of
the “Accounts” window. Empathy should show the current seings for the
account. Once you have made your anges, cli Save.

Removing an account
To remove an account select the account on the le hand side of the window
and cli on the Remove buon. Empathy should open the “Do you want to
remove” window. Cli on the Remove buon to confirm that you want to
remove the account, or cli Cancel to keep the account.

Editing contacts
Adding a contact
To add an account open the Chat menu, then oose Add contact. Empathy
should open the “New Contact” window.

In the Account drop-down list oose the account that you want to add
the contact to. Your must add you contact to an account type that mated
theirs.

For example if your contact’s address ends in “@googlemail.com” then you
will need to add it to an account that ends in “@googlemail.com”. Likewise if
the contact’s email ends in “@hotmail.com” then you would need to add it to
an account ending in “@hotmail.com”.

When you have osen the account that you wish to add the contact to,
you will need to enter either their login id, username, screen name or email
address in the Identifier text field.

en, in the Alias text field, enter the contact’s name as you would like to
see it in your contact list. Cli Add to add the contact to your list of contacts.



working with ubuntu 

Removing a contact

Cli on the contact that you want to remove and then open the Edit menu,
then oose Contact, then Remove. is will open the “Remove contact”
window.

Cli on the Remove buon to confirm that you want to remove a contact,
or cli Cancel to keep the contact.

Communicating with contacts
Text

To communicate with a contact, select the contact in Empathy’s main window
and double-cli their name. Empathy should open a new window where you
can type messages to your contact, and see a record of previously exanged
messages.

To send a message to the contact, type your message in the text field below
the conversation history.

When you have typed your message press the Enter key to send the mes-
sage to your contact. If you are communicating with more than one person
then all of the conversations will be shown in tabs within the same window.

Audio

If your contact has audio capabilities then there will be an icon of a micro-
phone next to their name. Cli on the microphone icon to open a popup
menu. Choose the Audio call option from the menu. Empathy should then
open the “Call” window.

is window shows your picture on the right and your contact’s picture
on the le. Ensure that your microphone and speakers are connected, and
proceed with the audio conversation. You can finish the conversation by
cliing on the Hang up buon.

Video

If your contact has video at capabilities then there will be an icon of a
webcam next to their name. Cli on the icon to open a popup menu. Choose
the Video call option from the menu. Empathy should then open the “Call”
window.

is window shows your webcam view in the top right and your contact’s
webcam will be in the middle.

If you don’t have a webcam then your picture will be shown instead. You
can finish the call by cliing on the Hang up buon.
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Sending and receiving files
Sending a file
When you are in a conversation with a contact and you would like to send
them a file, open the Contact menu and then oose Send file.

Empathy should open the “Select file” window. Find the file that you wish
to send and cli on the Send buon. A “File Transfers” window will open
showing the osen file and its transfer progress.

When the file transfer is complete, you can close the “File Transfers” win-
dow.

Receiving a file
When a contact wants to send you a file, the status icon to the le of the
contact’s name will flash with an icon of a paper plane.

To receive the file double-cli the contacts name. Empathy will open
the “Select a destination” window. Choose a location where you would like
Empathy to save the file, and cli Save. Empathy should open the “File
Transfers” window.

e “File Transfers” window shows you the progress of current file trans-
fers. You can stop file transfers by cliing on the Stop buon, open trans-
ferred files by cliing on the Open buon, and clear the list of completed
transfers by cliing on the Clear buon.

Changing your status
You can use your status to show your contacts how busy you are or what you
are doing. You can use the standard statuses, whi are “Available”, “Busy”,
“Invisible” and “Off-line”. ese can be anged in the main Empathy window
from the drop-down list at the top of the window.

e same drop-down list lets you set a custom status by oosing “Custom
Message…” next to the icon thats mates your status. Type what you would
like your status to say, and cli on the green e mark.

Changing your picture
Your picture is what your contacts will see next to your name in their contact
list. e default picture is the outline of a person. You can ange your picture
by opening the Edit menu, then oosing Personal Information.

Emapthy should open the “Personal Information” window. From the Ac-
count drop-down list oose the account that you want to ange, then cli
on the picture on the right hand side of the window.

Empathy should open the “Select Your Avatar Image” window. Find the file
containing your picture, and cli Open. If you would like to return it to the
default avatar, cli on the No Image buon instead.
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Microblogging
You can connect several microblogging services by opening the Applications
menu, then oosing Internet and then Gwibber Social Client. Until you add
accounts the “Social Accounts” window will open.

Aer you have added accounts you will see the “Social broadcast mes-
sages” window.

In this window in the Add new drop-down list you can oose the from
Flikr™, Twier™,StatusNet™, Qaiku, Facebook®, Friendfeed, Digg™and
Identi.ca .

Figure .: Gwibber lets you add many
different account types.

Me menu
If you cli you name in the top panel you will see the “me menu,” in the box
below your name you can type a message to post on the sites that you have
set up with Gwibber.

You can also ange your account seings by cliing Broadcast Ac-
counts…, this opens the “Social accounts” window.

Changing accounts
To add more accounts aer you have already added some. Cli Edit then
Accounts, the “Social Accounts” window will open.

Adding accounts
In the “Social Accounts” cli Add…, ea account will need you to enter your
account details. e details that you require for ea account is detailed as
follows.

Flir: To set up a flikr account all you need is the account login id.
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Twitter: Requires a user name and password.
StatusNet: A login id, domain and password is needed.
Qaiku: You will need an api-key, instructions for this are provided in the

gwibber window. You will also need your login id.
Facebook: Cli Authorize, then enter your email address and password

and cli Connect. If you want to be able to post on facebook from gwibber
cli Allow publishing, otherwise cli Don’t allow.

If you want gwibber to show your news feed you will need to cli Al-
low access, otherwise cli Don’t allow. You will also need to allow status
updates cli Allow status updates, if you don’t want gwibber to be able to
update your status cli Don’t allow.

So that Gwibber can interact with facebook ea time it is used it will need
to have constant authorization. If not you will have to authorize it ea time
you use it. To allow constant authorization cli Allow.

FriendFeed: A remote key is required for friend feed, Gwibber provides
information on where to get one from. You will also need a login id.

Digg: A login id is all that is required for digg.
Identi.ca: A login id and password is required for Identi.ca

Removing accounts
In the “Social accounts” window cli the account that you want to remove
and cli Remove.

How Gwibber displays accounts
Gwibber allows you to post to either all, one or a selection of accounts. is
can be set at the boom of the “Social broadcast message” window, ea of the
accounts that you can post with will have an icon. Cliing an icon so that it
is greyed out means that you will not post to that account.

Once you have decided on whi accounts you want to post to you can
type your message in the text field above the icons, then cli Send.

Ea one of you accounts will have a set of icons to go with it, these are
displayed on the le hand size of the “Social broadcast message” window. e
set of icons that goes with an account has a baground color, ea one of
these icons allows you to do tasks for that specific account.

Viewing and editing photos
To view and edit photos in Ubuntu, you can use the F-Spot Photo Manager
application. To start F-Spot, open the Applications menu, then oose Graph-
ics, then F-spot Photo Manager. When you start F-Spot for the first time you
will see the “Import” window—how to use this is covered in ’Importing’.

By default, F-Spot displays your photos by date. You can view photos from
a specific month by cliing on that month in the timeline near the top of the
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window.
You can also play slide shows of your pictures by cliing on the Play

buon on the toolbar (this buon looks like a green triangle).

Figure .: F-Spot lets you store, tag, and
edit your photos.

A lot of this guide refers to the side bar on the le. If you can’t see it, open
the View menu, then oose Components, and oose Sidebar—making sure
the option is selected.

Version system
When you edit a photo, F-Spot creates a new version so that the original is not
lost. You can create a new version by opening the Photo menu, then oosing
Create New Version…. is opens the “Create New Version” window. In the
Name text field you can type what you would like to call the version and then
cli OK. A new version will then be created.

You can view previous versions of photos by cliing on the photo that
you wish to view, then cliing on the Edit Image buon. is anges the
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side bar on the le to the “Edit” side bar. In the boom le, the Version drop-
down list allows you to oose previous versions of the photo.

You might want to rename a version so that you remember whi version
is whi. To rename a version, cli on the photo that you want to ange,
then cli on the Edit Image buon. is anges the side bar on the le
to the “Edit” side bar. In the boom le the Version drop-down oose the
version of the photo that you want to rename. en open the Photo menu,
then oose Rename Version. is will open the “Rename Version” window.
Enter the new name in the New name text field, then if you want to rename
the version cli OK. If you don’t want to rename the version, cli Cancel.

When editing photos, you may make a mistake and may decide to remove
that version as you no longer need it. To delete a version, cli on the photo
that you want to ange, then cli on the Edit Image buon. is anges
the side bar on the le to the “Edit” side bar. In the boom le the Version
drop-down list oose the version of the photo that you want to delete. en
open the Photo menu, then oose Delete Version. is will open the “Really
Delete?” window. If you want to delete the version cli Delete. If you don’t
want to delete the version, cli Cancel.

Importing
When you laun F-Spot for the first time you will see the “Import” window.
Aer the first laun you can import more photos by cliing on the Import
buon.

When you import some photos, only the photos that you have just im-
ported are shown. To show all of your photos, cli on the grey X to the right
of the blue Find.

Choosing where F-Spot saves photos
When importing pictures in the “Import” window, the Copy files to the
Photos folder option determines where the photos are saved.

If the Copy files to the Photos folder option is selected then F-Spot will
copy the photos into the Photos folder, whi is within your Pictures folder.
e pictures are then sorted by year, month and then date.

If the Copy files to the Photos folder option is unselected then F-Spot will
not copy the pictures into the Photos folder.

Importing from file

To import photos that are saved on you computer, oose Select Folder
from the Import Source drop-down list. is opens the “Import” window.
Navigate to the folder containing your photos and cli Open.

When the loading bar says “Done Loading” all the photos in that folder
and any sub-folders are then displayed in the “Import” window. You can
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Figure .: You can import all of your
photos.

exclude importing photos from sub-folders by deselecting the Include sub-
folders option.

All of the photos are imported by default, but you can oose to import
only some photos. To do so, press-and-hold the Ctrl key while cliing the
photos you do not want to import. Duplicates are automatically detected
when the Detect duplicates option is selected.

You can aa tags by typing the names of the your current tags in the
Atta Tags text field. If you want to use multiple tags then separate them
with a comma.

Once you have osen the photos that you want import, cli on the Im-
port buon.

From digital camera
To import photos from a digital camera, plug your camera into the USB port
of your computer, and turn your camera on. If your camera is detected,
Ubuntu should open a new window propmpting you to import photos. En-
sure that Open F-Spot is osen in the drop-down list and cli OK. is will
show the “Import” window. In the Import Source drop-down list oose the
option that looks like …Camera.

A “Select Photos to Copy from Camera…” window will open. You can
then cli the photos that you want to copy. All of the photos are selected by
default but you can add or remove individual photos by pressing-and-holding
the Ctrl key while cliing on photos to deselect them.

You can aa tags to all of them by cliing on the Atta tag option and
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oosing the tag in the Atta tag: drop-down list. For more information
about tags see “Organizing photos”

You can ange where the files are saved in the Target location drop-down
list. e default is the Photos folder—this is where F-Spot saves the photos.

Once you have osen the photos that you want to import, cli on the
Copy buon. e “Transferring Pictures” window should open, and will show
the copying progress. When copying is complete, the progress bar will display
Download Complete. Finally, cli OK to show your photos in F-Spot

Organizing photos
F-Spot makes finding photos of the same type easier by using tags. You can
apply as many tags to a photo as you like.

To apply tags to photos, first select the photos. en right-cli on the
photos and oose Atta Tag. Cli the tag you want add to your photos.
You can aa tags when importing photos, as covered in the “Importing”
section.

You can make new tags by opening the Tags and oosing Create New
Tag…. is will open up the “Create New Tag” window. Enter the name of
the tag in the Name of New Tag: text field. e Parent Tag: drop-down list
allows you to oose the “parent” tag for your new tag.

Editing Images
You may want to edit some of the photos you import into F-Spot. For exam-
ple, you may want to remove something at the edge, some discoloring, fix red
eyes, or straighten a photo. To edit a photo, cli on the photo that you want
to edit and then cli on the Edit Image buon. is anges the side bar on
the le of the “F-Spot” window. e panel will show eight options: Crop,
Red-eye Reduction, De-saturate, Sepia Tone, Straighten, So Focus, Auto
Color, and Adjust Colors. Some of these options are explained in more detail
in the next section.

Cropping photos
You might want to crop a photo to ange the framing or remove part of the
edge of the photo. Cli on the Crop on the le panel, then in the Select an
area to crop drop-down list oose the ratio that you would like to crop with.
You might want oose the ratio that mates the ratio that you would like to
print, so that the photo is not streted.

You can create custom constraints if one of the defaults does not meet your
requirements. is is done by oosing Custom Ratios from the Select an
area to crop drop-down list. is opens the “Selection Constraints” window.
Cli Add to place a new entry on the le of the window.

Once you have osen your constraint, move the cursor to one conner of
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the section of the photo that you want to keep. Cli-and-hold the le mouse
buon and drag it to the opposite corner of the section that you want to keep.
Release the the mouse buon to finish your cropping selection.

To resize the cropping selection box, move the mouse until an arrow points
to the side of the cropping selection box that you want to move. Cli-and-
hold the le mouse buon, and move the mouse until the edge is in the right
place.

All ratios work in portrait and landscape mode. To ange between the
two, you need to cli on the edge of the cropping selection box as if you
were to resize the box. Moving the cursor between top right and boom le
swites between portrait and landscape modes.

Red-eye Reduction
If you have taken a photo and the flash caused the subject to have red eyes,
you can fix this problem in F-Spot. First, cli on the Red-eye Reduction
buon. Move the cursor to the one corner of the subject’s eye and cli-and-
hold the le mouse buon as you drag the cursor to the opposite corner of the
eye. en, release the mouse buon.

is box can be moved by placing the cursor into the middle of the red
eye selection box until a hand cursor is shown. en, cli-and-hold the le
mouse buon and move the selection box into the correct place. When it is in
the correct place you can release the le mouse buon.

To resize the box, move the mouse until an arrow points to the side of the
red eye selection box that you want to move. Cli-and-hold the le mouse
buon, move the mouse until the edge is in the right place.

When the box covers all of the red in one eye, cli the Fix buon. You
will need to repeat the process for ea of the subject’s eyes that is affected.

Straighten
If you have a photo where the subject is at an angle, you can straighten the
photo with F-Spot. First, cli on the Straighten buon. en move the slider
until the picture is straight again. F-Spot will auto crop the picture to remove
any white parts that occur due to the rotation. When you are happy that the
picture is straight, cli on the Straighten buon.

Auto Color
To automatically correct the coloring of a photo, cli on the Auto Color
buon.

Exporting to web services
F-Spot allows you to export you photos to a Web Gallery, Folder or CD
and the following services; SmugMug©, PicasaWeb™, Flir™, hq and



 getting started with ubuntu 10.04

Zooomr™.
You can export to these services by selecting a picture and then opening

the Photo menu, then oosing Export to and cliing the service that you
require. is will open a window in whi you can enter your account name
and password for the service. is will allow you to upload pictures to this
service.

Watching videos and movies

To wat videos or DVDs in Ubuntu, you can use theMovie Player applica-
tion. To start the Movie Player, open the Applications menu, then oose
Sound & Video, then ooseMovie Player. is will open the “Movie
Player” window.

Figure .: Totem plays music and videos.
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Codecs
Wating DVDs may require Ubuntu to install a “codec”, whi is a piece of
soware that allows your computer to understand the contents of the DVD,
and display the video.

Legal Notice Patent and copyright laws operate differently depending on
whi country you are in. Please obtain legal advice if you are unsure
whether a particular patent or restriction applies to a media format you wish
to use in your country.

So that you can play all videos and DVDs, you will need to install some
codecs. is is done by enabling theMultiverse repositories (for how to do
this see Chapter⁇: ⁇).

Once you have enabled the repositories, open the Applications menu, then
oose Ubuntu Soware Center. When the “Ubuntu Soware Center” win-
dow opens, use the sear box in the top right and sear for the following:
‣ gstreamer.-ffmpeg
‣ gstreamer.-plugins-bad
‣ gstreamer.-plugins-ugly
‣ gstreamer.-plugins-base
‣ gstreamer.-plugins-good
‣ libdvdread
‣ libdvdnav
‣ libdvdcss
When you find ea one, cli on it and then if there is an Install buon,

cli on it. If there is a Remove buon, then it is already installed. Cliing
on the Install buon may open the “Authenticate” window. Enter you pas-
sowrd in the Password text feild. Once you have entered your password, cli
on the Authenticate buon to will start the installation. For more information on the terminal see

Chapter : The Command LineTo finish codec installation, you also need to run a command in the termi-
nal. Open the Applications menu, then oose Accessories and then oose
Terminal. is will open the “Terminal” window.

Type the command as shown below.

$ sudo /usr/share/doc/libdvdread4/install-css.sh

Once you have typed the command, press Enter. You will be asked for
your password—to authorize this action, type in you password and press
Enter. Wait for the process to finish. Once it has finished you can close the
“Terminal” window.

Playing videos from file
Open theMovie menu, then oose Open…. is will open the “Select Movies
or Playlists” window. Find the file or files that you want to play and cli on
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the Add buon. e video or videos will start playing.

Playing a DVD
When you insert a DVD in the computer, Ubuntu should open the the “You
have just inserted a Video DVD. Choose what application to laun” window.
Make sure that Open Movie Player is osen in the drop-down list and then
cli OK. e “Movie Player” window will open and the movie will start.

If the “Movie Player” window is already open, openMovie menu, then
oose Play Disc …. and the movie will start.

Listening to audio and music
Ubuntu comes with the Rhythmbox Music Player for listening to your mu-
sic, streaming Internet radio, managing playlists and podcasts, and purasing
songs.

Starting Rhythmbox
To start Rhythmbox, open the Applications menu, then oose Sound &
Video, then Rhythmbox Music Player.

To quit Rhythmbox, ooseMusic ‣it or press Ctrl+Q. Rhythmbox
will continue to run if you ooseMusic ‣Close or close the window. A
few Rhythmbox tools (su as Play, Next, and Previous) are available from
the Rhythmbox Music Player icon in the notification area (typically the top
right of your screen). You can also ooseit from this menu to shotdown
Rhythmbox.

Playing music

In order to play music, you must first import music into your library.
ChooseMusic ‣ Import Folder or press Ctrl+O on your keyboard to import a
folder of songs or Import File for single songs.

e Rhythmbox Toolbar contains most of the controls that you will use for
browsing and playing your music.

If you want to play a song, select a tra and oose the Play buon
(Control ‣ Play or Ctrl+Space) from the Toolbar. Cliing the Play buon
again will pause the song.

Next and Previous buons are next to the Play buon. ese will play the
next and previous songs in your library.

e Rhythmbox Toolbar also has options to enable or disable Repeat
((Control ‣Repeat or Ctrl+R), Shuffle ((Control ‣ Shuffle or Ctrl+U), the
Artist/Album browser ((Control ‣Browser or Ctrl+B), and Visualization.

When you insert a CD into your computer, it will appear in the list of
Devices in the Side Pane. Select the CD in the Devices list. Enable and disable
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M I S S I N G S C R E E N S H O T
Rhythmbox application with a CD inserted

Figure .: Rhythmbox application with a
CD inserted

the Side Pane by oosing View ‣ Side Pane or F9. Rhythmbox will aempt to
find the correct artist, album, and tra names. To play the songs on the CD,
oose the tra and press Play.

To import the songs into your library, select the CD in the Devices list.
You can review information about the CD, make any anges if needed, or
un-e songs that you do not want to import.. e toolbar will display
additional options to reload album information, eject the CD, and copy the
tras to your library. Press the Copy buon to import the songs.

Listening to streaming radio
Streaming radio are radio stations that are
broadcast over the Internet.Rhythmbox is pre-configured to enable you to stream radio from various

sources. ese include Internet broadcast stations (Radio from the Side Pane)
as well as Last.fm. To listen to an Internet radio station, oose a station from
the list and cli Play. To listen to music from Last.fm, configure your Account
Seings.

Connect digital audio players
Rhythmbox can connect with many popular digital audio players. Connected
players will appear in the Devices list. Features will vary depending on the
player but common tasks like transferring songs and playlists should be sup-
ported.
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Listen to shared music
If you are on the same network as other Rhythmbox users (or any music
player soware with DAAP support), you can share your music and listen
to their shared music. Choose Shared from the Side Pane for a list of shared
libraries on your network. Cliing a shared library will enable you to browse
and play songs from other computers.

Manage podcasts
Rhythmbox can manage all of your favorite podcasts. Select Podcasts from
the Side Pane to view all added podcasts. e toolbar will display additional
options to Subscribe to a new Podcast Feed and Update all feeds. Choose
Music ‣New Podcast Feed, Ctrl+P, or press the Subscribe buon in the
toolbar to import a podcast URL. Podcasts will be automatically downloaded
at regular intervals or you can manually update feeds. Select an episode and
cli Play. You can also delete episodes.

Figure .: You can add and play your
podcasts in Rythambox.
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Rhythmbox preferences
e default configuration of Rhythmbox may not be exactly what you want.
Choose Edit ‣ Preferences to alter the application seings. e Preferences
tool is broken into four main areas: General, Playba, Music, and Podcasts.

‣ General options include music filtering and sorting options and a configu-
ration seing for toolbar buon labels.

‣ Playba options allow you to customize the crossfading feature and define
the buffer seing for streamed music from sources su as Internet radio
and shared libraries.

‣ Music options define the Library Location on your computer where im-
ported music is added, the Library Structure of how folders are created
based on your imported music, and the Preferred format for imported
music.

‣ Podcasts options define the Download location podcast episodes and the
frequency to Che for new episodes.

Managing your music
Rhythmbox supports creating playlists. Playlists are either static lists of songs
that are played in order or can be automatic playlists based on your specific
filter criteria. Playlists contain references to songs in your library. ey do
not contain the actual song file. If you remove a song from a playlist (Remove
from Playlist, it will remain in your library.

To create a playlist, ooseMusic ‣ Playlist ‣New Playlist or Ctrl+N and
give the new playlist a name. You can then either drag songs from you library
to the new playlist in the side pane or right-cli on songs and oose Add to
Playlist and pi the playlist.

Automatic Playlists are created almost the same way as static playlists —
ooseMusic ‣ Playlist ‣New Automatic Playlist. Next, define the filter
criteria. You can add multiple filter rules. Finally, oose Close and give
the new automatic playlist a name. Automatic Playlists will appear in your
side pane with a different icon than any static playlists. You can update any
playlist by right-cliing on the name and oosing Edit….

Rhythmbox supports seing song ratings. Select a song in your library and
ooseMusic ‣ Properties, Alt+Return, or right-cli on the file and oose
Properties. Select the Details tab and set the rating by piing the number of
stars. Other song information su as Title, Artist, and Album can be anged
from the Basic tab. Choose Close to save any anges.

To delete a song, select it in your library and oose Edit ‣Move to Trash
or right-cli on the song and oose Move to Trash. is will move the song
file to your trash.

If you ever want to move a song (for example to another computer), oose
the song (or group of songs) from your library and drag it to a folder or to
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your desktop. is will make a copy in the new location.

Rhythmbox plugins
Rhythmbox comes with a variety of plugins. ese are tools that you can
enable and disable that add more features to Rhythmbox. Examples include
Cover art, Song Lyrics, and various music stores. A few plugins are enabled by
default.

To view the list of available plugins, oose Edit ‣ Plugins. e Configure
Plugins window allows you to enable or disable individual plugins, view
descriptions, and configure additional options if they are available for the
plugin.

Music stores
Rhythmbox has three music stores whi give you access to an extremely
large catalog of music with a variety of licensing options.

e Jamendo store sells free, legal and unlimited music published under
the six Creative Commons licenses. You can browse the catalog and play
songs by oosing Jamendo in the Stores list in the side pane. More informa-
tion about their catalog can be found at http://www.jamendo.com/.

e Magnatune store sells music from independent musicians. ey work
directly with artists and hand-pi the songs available. eir catalog is com-
posed of high quality, non-DRM (no copy protection) music and covers a
variety of genres from Classical and Jazz to Hip Hop and Hard Ro. You can
browse the catalog and play songs by oosingMagnatune in the Stores list in
the side pane. More information about their catalog and subscription service
can be found at http://www.magnatune.com/.

e Ubuntu One Music Store sells music from major and minor music
labels around the world. e store offers non-DRM (no copy protection) songs
encoded in either high quality MP or AAC format. Ubuntu does not come
with support for MP playba, but the store will install the proper codecs
automatically for free. You can browse the catalog, play previews, and buy
songs by oosing Ubuntu One in the Stores list in the side pane.

e Ubuntu One Music Store integrates with the Ubuntu One service. All
purases are transfered to your personal cloud storage and then automati-
cally copied to all of your computers so an Ubuntu One account is required.
e catalog of music available for purase will vary depending on where you
live in the world. More information about the Ubuntu One Music Store can be
found at http://one.ubuntu.com/

Audio codecs
Different audio files (e.g., MP, WAV, AAC) require unique tools to decode
them and play the contents. ese tools are called codecs. Rhythmbox will

http://www.jamendo.com/
http://www.magnatune.com/
http://one.ubuntu.com/
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aempt to detect any missing codecs on your system so you can play all of
your audio files. If a codec is missing, it will try to find the codec in online
resources and guide you through installation.

Rhythmbox support
Rhythmbox is a very popular music application used by many throughout the
world. ere are a variety of support resources available in many languages.

‣ Choose the Help buon for a variety of support optiont and information
about reporting Rhythmbox bugs.

‣ e Rhythmbox website - http://projects.gnome.org/rhythmbox/
‣ e Multimedia & Video category of Ubuntu Forums - http://ubuntuforums.
org/forumdisplay.php?f=

Working with documents, spreadsheets, and presentations
ite oen, you may need to use your computer for work. You may have a
need to use a word processor to write a document. You may need to work on
a spreadsheet, do calculations on a table of data or create a data art. You
may want to work on slides for a presentation.

In Ubuntu, you can use the OpenOffice.org suite of applications for these
tasks.

Working with documents
If you need to work with documents, you can use the OpenOffice.org Word
Processor. To start the word processor, open the Applications menu, oose
Office, and then oose OpenOffice.org Word Processor. Ubuntu should
then open the main window for the word processor. . The OpenOffice.org Word Processor is

also known as the OpenOffice.org Writer.
Spreadsheet is also known as Calc, and
Presentation is known as Impress.Working with spreadsheets

If you need to work with spreadsheets, you can use the OpenOffice.org
Spreadsheet. To start the spreadsheet application, open the Applications
menu, oose Office, and then oose OpenOffice.org Spreadsheet.

Working with presentations
If you need to work with slides for a presentation, you can use the OpenOf-
fice.org Presentation. To start the presentation application, open the Applica-
tions menu, oose Office, and then oose OpenOffice.org Presentation.

Geing more help
Ea of these applications comes with a comprehensive set of help screens. If
you are looking for more assistance with these applications, press the F1 key

http://projects.gnome.org/rhythmbox/
http://ubuntuforums.org/forumdisplay.php?f=334
http://ubuntuforums.org/forumdisplay.php?f=334
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aer starting the application.

Taking notes
You can take notes in a program called Tomboy Notes, you can use it to make
a shopping or a to do list. Cli Applications, then cli Accessories and cli
Tomboy Notes

Figure .: You can record information that
you need to remember.You can sear all of your notes by typing a word in the Sear: text field

in the main tomboy window.

Making notes
To create a new note cli File, then cli New, the “New Note” window will
open.

e “New Note” window will contain a blue title “New Note” this can
be deleted and anged to a title that makes the note more memorable. e
main content of the note can be typed where it says “Describe your new note
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here.” Once you have entered your text just close your note as all anges are
automatically saved.

To delete the note cli the red delete note buon, this will open a “Really
delete this note?” window. If you do want to delete the note cli the Delete
buon, otherwise cli the Cancel buon.

You can add a note to a notebook by cliing the Notebook buon and
cliing the option next to the notebook that you want to move the note to.

Organizing notes
You can organize your notes in Tomboy using “Notebooks,” is makes find-
ing you notes quier and in a more logical location. To create a new note
book cli File, then Notebooks, and cli New Notebook….

e “Create a new notebook” window will open, type the name of the
notebook in the Notebook name: text field. Once you have typed the note-
book name cli the Create buon.

e notebook will now show up in the sidebar of Tomboy Notes. You can
cli and hold on the note of your oice and drag it on top of the notebook
that you want to move it to.

Synchronizing
You can synronize you notes with your Ubuntu One account, this means
that you can access them across all of your ubuntu computer. You can also
access them from https://one.ubuntu.com/.

To synronize you notes cli the Edit, then cli Preferences, this will
open the “Tomboy Preferences” window. Cli the Synronization tab and
then in the Service drop down cli Tomboy Web.

Next cli the Connect to Server buon, this will open a web page in
Firefox you will need to enter the email address that you use for ubuntu one
and your password. en cli the Continue buon, then in the Computer
Name text field enter a name that reminds you of that computer and cli
the Addis Computer buon. Firefox will then display a page that says
something similar to “Tomboy Web Authorization Successful”

Now ba at the “Tomboy Preferences” window cli the Save buon. A
new window will pop up asking if you want to “synronize your notes now,”
cli the Yes buon and the “Synronizing Notes …” window will show, once
the synronization is complete cli the Close buon.

If you want to synronize the notes again cli Tools and cli Synro-
nize Notes. Your notes will start synronizing, when they are done cli the
close

https://one.ubuntu.com/




 Hardware
Using your devices
Ubuntu supports a wide range of hardware, and support for new hardware
improves with every release.

Hardware identification
To identify your hardware you can install the following application: Cli
Applications, scroll down to Ubuntu Soware Center. When the “Ubuntu
Soware Center” window opens, use the sear box in the top right and
sear for the following: “sysinfo.” Now cliMore Info and then cli Install
to install the application.

Now to run the application go to Applications System Tools Sysinfo the
program should open up providing you with access to information about all
your hardware on your system.

Keyboard and mouse
e keyboard and mouse are essential input devices for a large number of
computer users today. Being a very common piece of kit for many computer
users has led to some variation in the mouses and keyboards on offer today. In
this section we will look at the different seings of your keyboard and mouse
whi will be of great use to international users.

Keyboard
e keyboard is likely to be one of the main ways that you interact with your
computer. Without a keyboard this manual couldn’t be wrien by the Ubuntu
Manual team! Unfortunately not all keyboards are uniform in design, they can
differ by country, by language or even by style. As an American if by mistake
you purase a keyboard from a UK retailer, then not only will you find that
the

Displays
Hardware drivers
A hardware driver is a small bit of code paaged in a file, whi tells your
computer how to utilize a piece of hardware. Every component in a com-
puter requires a hardware driver to function, whether it’s the printer, DVD
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player, hard disk, or graphics card. Your graphics device is the component in
your computer that powers your display. When you’re wating videos on
YouTube or DVDs or simply enjoying the smooth transition effects when you
maximize/minimize your windows, your graphics device is doing the hard
work behind the scenes.

Majority of the Graphics Devices are manufactured by three well known
companies: Intel®, AMD/ATI®and NVIDIA®corp. You can find your device
manufacturer by referring to your computer manual or looking for the spec-
ifications of your particular model over the Internet. e Ubuntu Soware
Center houses a number of programs that allow detailed system information
to be obtained. SysInfo is one su program that you can use to find rele-
vant information about your System devices. Ubuntu comes with support for
graphics devices manufactured by above companies, and many others, out
of the box. at means that you don’t have to find and install any drivers by
yourself, Ubuntu takes care of it on its own.

In keeping with Ubuntu’s philosophy, the drivers that are used by default
for powering graphics devices are open source. is means that the drivers
can be modified by the Ubuntu developers and problems with them can be
fixed. However in some cases the proprietary driver (restricted driver) pro-
vided by the company may provide beer performance or features that are
not present in the open source driver wrien by the developer community. In
other cases, your particular device may not be supported by the open source
drivers yet. In those scenarios, you may want to install the restricted driver
provided by the manufacturer.

For both philosophical and practical reasons, Ubuntu does not install
restricted drivers from the start but allows the user to make an informed
oice. Remember that restricted drivers, unlike the open source drivers for
your device, are not maintained by Ubuntu. Problems caused by those drivers
will be resolved only when the manufacturer wishes to address them. To see if
restricted drivers are available for your system, cli System in the top panel,
go to Administration and find Hardware Drivers. If a driver is provided by
the company for your particular device, it will be listed there. You can simply
cli Activate and use the driver if you want. is process will require an
active Internet connection and will ask for your password.

e Ubuntu developers prefer open source drivers because they allow the
problem to be identified and fixed by anyone with knowledge in the com-
munity. Ubuntu development is extremely fast and it is a good ance that
your device will be supported by open source drivers. You can use the Ubuntu
Live CD to e for your device compatibility before installing Ubuntu or
go online in the Ubuntu forums to ask about your particular device. Another
useful resource is the official online documentation (help.ubuntu.com), whi
contains detailed information about various graphics drivers and known
quirks.
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Seing up your screen resolution
One of the most common display related tasks is seing up your screen reso-
lution. ink of Screen Resolution in terms of displayable information on the
your monitor/LCD; the higher the resolution, the beer the result. Your mon-
itor/LCD has a “native resolution,” whi is the highest resolution it designed
to work at. Ubuntu correctly identifies that screen resolution by itself and sets
it for you. However, due to a huge variety of devices out there, sometimes it
can make a mistake and set up an undesirable resolution.

To set up or just e your screen resolution, go to System. Cli Pref-
erences and find Display. e Display application shows you your monitor
name and size, the screen resolution and refresh rate. Cliing on the dis-
played resolution for e.g.  x  (:), would open a drop-down menu
from where you can select the resolution of your oice.

Connecting and using your printer
You can add, remove, and ange printer properties by cliing System
then cliing Administration and then Printing. is shows the “Printing-
localhost” window.

When you use and add printer it will need to be plugged in with a usb lead
or connected to you network. It will also need to be swited on.

Adding a local printer
If you have a printer that is connected to your computer with a usb cable then
this is a local printer. You can add a printer by cliing Server, then cliing
New then Printer. e “New Printer” window will open.

In the le hand pane of the “New Printer” window any printers that you
can install will be listed. Select the printer that you would like to install and
cli Forward.

If your printer can automatically do double sided printing and it will
probably have a duplexer. Please refer to the instructions that came with the
printer if you are unsure. If you do have a duplexer you will need to make
sure the Duplexer Installed option is eed and then cli the Forward
buon.

You can now specify the printer name, description and location. Ea of
these should remind you of that particular printer so that you can oose the
right one to use when printing. Finally cli Apply.

Adding a network printer
Make sure that your printer is connected to network with an Ethernet cable
and is turned on. To add the printer You can add a printer by cliing Server,
then cliing New then Printer. e “New Printer” window will open. Cli
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the “+” sign next to Network Printer.
If you printer is found automatically it will show under Network Printer.

Cli the printer name and then cli Forward. en in the text fields you can
now specify the printer name, description and location. Ea of these should
remind you of that particular printer so that you can oose the right one to
use when printing. Finally cli Apply.

Otherwise you will need to know the protocol or details of your network
printer.

Seing default printer
e default printer is the one that is automatically selected when you print a
file. To set a printer as default right cli the printer that you want to set as
default and cli Set As Default

Changing printer options
If you want to print on different size paper, ange the printing quality or
the media type this can be done by anging the printer options. e printer
options can be anged by right cliing the printer and oosing Properties.
e “Printer Properties” window will show, in the le pane oose Printer
Options.

You can now ange any of the options by anging the drop-down next to
it, some of the options that you might see are explained.

Media Size
is is the size of the paper that you put into your printer tray

Media source
is is the tray that the paper comes from.

Output mode
is is very useful if you want to print in Bla Only Greyscale to save on
ink, or to print in Color, or Highality Greyscale

Media type
Depending on the printer you can ange between Plain Paper, Automatic,
Photo Paper, Transparency Film, CD or DVD Media.

Printality
is specifies how mu ink is used when printing, Fast Dra using the least
ink and High-Resolution Photo using the most ink
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Sound

Ubuntu usually detects the audio hardware of the system automatically dur-
ing installation. e audio in Ubuntu is provided by a sound server named
PulseAudio. e audio preferences is easily configurable with the help of a
very easy to use GUI whi comes pre-installed with Ubuntu.

A volume icon whi sits on the top right corner of the screen, provides
qui access to different audio related functions. Le cliing on the vol-
ume icon shows up a slider buon whi you can move horizontally to in-
crease/decrease volume. Right cliing on the volume icon allows you to
oose between muting the sound and sound preferences. Selecting sound
preferences opens up another window whi provides access to sound themes,
hardware, input and output preferences for sound. e sound preferences can
also be found if you go to the System menu and highlight Preferences, you
will see Sound in the drop down list.

e first tab whi shows up by default is the sound themes.You can dis-
able the existing sound theme or configure it with the options available. You
can also add new sound themes by installing them from Soware Center e.g.
Ubuntu Studio Sound theme. You will get the installed sound themes from the
drop down menu. You can also enable window and buon sounds.

e hardware tab will have a list of all the sound cards available in your
system. Usually there is only one listed, however, if you have a graphics
card whi supports HDMI audio it will also show up in the list. is section
should be configured only if you are an advanced user.

e third tab is for configuring input audio. You will be able to use this
section when you have an inbuilt microphone in your system or if you add
an external microphone. A microphone is used for making audio/video calls
whi are supported by applications like Skype or Empathy.It is also used
for the purpose of sound recording. You can increase/decrease and mute/un-
mute input volume from this tab. If there are more than one input devices
(microphones), you will see them listed in the white box whi reads “Choose
a device for sound input.” You must note that by default in any Ubuntu in-
stallation, the input sound is muted. So, you will have to manually unmute to
enable your microphone to record sound or use it during audio/video calls.

e next tab is used for configuring the output audio. You can increase/de-
crease and mute/unmute output volume and select your preferred output
device. By default, the volume in Ubuntu is set to maximum during installa-
tion. Here, again,if you have more than one output devices, it will be listed
in the section whi reads “Choose a device for sound output.” e default
output hardware, whi is automatically detected by Ubuntu during start-up
will be selected. If you wish to ange to another sound source, once the se-
lection is made, that device will become default unless anged. ere is a
new pulseaudio equaliser whi is available from Launpad for configuring
different sound effects. It comes in handy while listening to music and/or
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wating movies.
e last tab is for configuring volume options for ea running application.

is comes in very handy if you have multiple audio programs running e.g.
if you have Rhythmbox,Totem movie player and a youtube video running at
the same time, you will be able to increase/decrease, mute/unmute volume for
ea application from this tab.

USB drives

Burning CDs and DVDs
To create a CD or DVD cli the Applications then cli Sound and Video
and cli Brasero Disc Burner. is opens the “Brasero” window, this win-
dow has a side bar that gives you five options to oose from. Ea one of
these is explained.

Figure .: Brasero burns music, video, and
data DVDs and CDs.
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Universal options
ese options apply for all projects except Disc copy and Burn Image

Adding files to a project
To add files to the list cli the Green + buon, this opens the “Select Files”
window. en navigate you way to the file that you want to add and cli it
and then cli the Add buon. Repeat this process for ea file that you want
to add.

Saving a project
To save a project so that you can finish it later, cli Project then cli Save.
e “Save Current Project” window will show, oose where you would like
to save the project. en in the Name: text field name the project so that you
will remember it. en cli the Save buon.

Removing files
If you want to remove a file from the project, cli the file in the list and cli
the Red - buon. To remove all the files in the list cli the Broom shaped
buon.

Burning the disc
When you cli the burn buon you will see the “Properties of …” window.

You can specify the burning speed in the Burning speed drop down. It is
best to specify the highest speed of the disc.

To burn your project directly to disc, cli the Burn the image directly
without saving it to disc option. With this option selected, no image file is
created and no files saved to the hard disk.

e Simulate before burning option is useful if you encounter problems
burning discs. Selecting this option allows you to simulate the disc burning
process without actually writing data to a disc—a wasteful process if your
computer isn’t writing data correctly. If the simulation is successful, Brasero
will burn the disc aer a ten second pause. During that ten second pause, you
have the option to cancel the burning process.

Temporary files are saved in the /tmp folder by default. Should you wish to
save these files in another location, you will need to ange the seing in the
Temporary files drop down menu. Under normal conditions, you should not
need to ange this seing.

Blanking a disk
If you are using a disc that has “RW” wrien on it and you have used it be-
fore, then you can blank it so that you can use it again. Doing this will cause
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you to lose all of the data currently on the disc. To blank a disc, cli the
Tools menu, then cli Blank. e “Disc Blanking” window will appear. In
the Select a disc drop down oose the disc that you would like to blank.

You can enable the Fast blank option if you would like to shorten th
amount of time necessary to perform the blanking process. However, se-
lecting this option will not fully remove the files; if you have any sensitive
data on your disc, it would be best not to enable the Fast blank option.

Once the disc is blank the “e disc was successfully blanked” window is
shown cli the close buon to finish.

Audio project
If you record your own music, then you may want to transfer this music onto
an audio cd so your friends and family can listen. You can start an audio
project by cliing Project then cliing New Project and then New Audio
Project.

So that ea file does not play straight aer ea other you can add a
two second pause aer a file. is can be done by cliing the file and then
cliing the || buon.

You can slice files into parts by cliing the Knife like buon, this opens
a “Split Tra” window. eMethod drop down gives you four options ea
one of these lets you split the tra in a different way. Once you have split the
tra cli the OK.

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli
the Burn… buon.

Data project
If you want to make a ba up of your documents or photos it would be best
to make a data project. You can start a data project by cliing Project then
cliing New Project and then New Data Project

If you want to add a folder you can cli the Folder picture, then type the
name

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli
the Burn… buon.

Video project
If you want to make a dvd of your family videos it would be best to make a
video project. You can start a video project by cliing Project then cliing
New Project and then New Video Project

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en cli
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the Burn… buon.

Disc copy
You may want to copy a disc so that you have another copy of

You can copy a disc cliing Project then cliing New Project and then
Disc copy. is opens the “Copy CD/DVD”

If you have two CD/DVD drives you can copy a disc from one to the other,
the disc that you want to copy to must be in the CD-RW/DVD-RW drive. If
you have only one drive you will need to make and image and then burn it to
a disc. In the Select disc to copy drop-down oose the disc to copy. In the
Select a disc to write to drop-down either oose image file or the disc that
you want to copy to.

Image file
You can ange where the image file is saved by cliing Properties, this
shows the “Location for Image File”. You can edit the name of the file in the
Name: text field.

e default save location is your home folder, you can ange this by
cliing the + next to Browse for other folders . Once you have osen
where you want to save it cli Close.

en ba in the “Copy CD/DVD” window cli Create Image. e “Cre-
ating Image” window will open and show the job progress. When it is com-
plete cli Close.

Copy to disc

Burn image
To burn an image, cli Project, then New Project, and then Disc copy. is
opens the “Image Burning Setup” window. Cli the Select a disc image to
write drop-down and the “Select Disc Image” window will appear. Navigate
your way to the image you wish to burn, cli it, and then cli Open.

In the Select a disc to write to drop-down menu, cli the disc to whi
you’d like to write, then cli Burn.

Using a webcam
Webcams come inbuilt into most laptops and netbooks these days. Apple
desktops also have webcams inbuilt into the monitors. e other webcams are
plug and play. Almost all new webcams are detected by Ubuntu automati-
cally. You can configure webcams for individual applications su as skype
and empathy from the application’s interface.
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Scanning text and images
Most of the time, Ubuntu will simply detect your scanner and you just be able
to use it. To scan a document, you need to follow these steps:

. Place what you want to scan on the scanner.
. Go to Applications ‣Graphics ‣ Simple Scan.

Does my scanner work with Ubuntu?
ere are three ways to see if you scanner works in Ubuntu:

. Simply plug it in. If it is a newer USB scanner, it is likely that it will just
work.

. Che https://wiki.ubuntu.com/HardwareSupportComponentsScanners
whi is Ubuntu specific.

. SANE project listing of support scanners. e SANE (Scanner Access Now
Easy) project provides most of the baends to the scanning soware on
Ubuntu.

Ubuntu can’t find my scanner
ere are a few reason why Ubuntu may give you a “No devices avaliable
message”:

‣ Your scanner is not supported in Ubuntu. e most common type of scan-
ner not supported is old parallel port or Lexmark All-in-One printer/scan-
ner/faxes.

‣ e driver for your scanner is not being autoloaded.

Other devices
Two very important devices whi comes preinstalled with most laptops and
desktops these days are Firewire and Bluetooth.

Firewire
Firewire port is a special type of port that make use of FireWire tenology to
transfer data. is port is generally used by camcorders and digial cameras.
is port facilitates high speed data transfer. If you want to import video from
your camcorder you can do so by connecting your camcorder to the firewire
port. You will need to install a soware called Kino whi is available in
Ubuntu Soware Center. ere is a very beautiful video tutorial available on
how to use Kino at http://www.youtube.com/watch?v=vtpfSZVgWE.

https://wiki.ubuntu.com/HardwareSupportComponentsScanners
http://www.youtube.com/watch?v=vtpfS8ZVgWE
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Bluetooth
Bluetooth is widely used on GPS devies, mice, mobile phones, headsets, music
players, desktops and laptops for data transfer, listening to music, playing
games and for various other activites. All modern operating systems support
bluetooth and Ubuntu is no exception. Bluetooth is easily configurable in
Ubuntu via simple, easy to use gui. Be it your system has inbuilt bluetooth
hardware or you are using a bluetooth dongle, Ubuntu can recognize it all.

You can quily access the bluetooth preferences by right cliing on the
bluetooth icon on the right hand side of the top panel. It usually sits beside
the volume icon. Right cliking the bluetooth icon gives a lot of oices whi
includes a one-cli Turn off bluetooth option.

Figure .: The Bluetooth applet menu.

e bluetoth preferences can also be accessed from System ‣ Preferences ‣
Bluetooth. is System menu can be found on the top panel.If you want to
setup a new device su as a mobile phone to synronise with your com-
puter, cli on the option that reads Setup new device...

is will open up a new window for a new device setup.e setup is fairly
straight forward.

When you cli on forward, you will headover to the second screen whi
will show you how many bluetooth devices are present within the range of
your system. e list of available devices might take a minute or so to appear
on the screen as your system will be scanning for the devices. e scan and
display is in real time, whi means, it will show up the device the m oment
it finds one. Cli on the required bluetooth device from the list of devices.
en, select the PIN number by selecting PIN options.

ree predefined PIN numbers are available but you can create a custom
PIN if you like. is PIN you will need to enter on the device you will be
pairing with thie Ubuntu system.

Once the device has been paired, you will receive a “Setup completed”
screen.

In Ubuntu, your laptop/desktop is hidden by defaul for security reasons.
is means that your Ubuntu system can sear other bluetooth enabled
systems but they cannot sear the Ubuntu system. You will have to enable
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the option, if you want your bluetooth device to find your Ubuntu system.
You can do this by selecting the option “Make computer discoverable” under
bluetooth preferences. You can also add a fancy name for your bluetooth
enabled Ubuntu system by anging the text under Friendly Name.



 Soware Management
Soware management in Ubuntu
On occasion, you might find that you need some additional soware. You
may decide to get an alternative web browser, or a different email client. You
might need to do audio editing, or install some games.

Ubuntu is designed to make it easy to find and install soware. Ubuntu
keeps tra of tens of thousands of different soware paages, helps you
install the ones you want, and then keeps them up to date.

Differences from other operating systems
In most other operating systems, installing soware requires you to purase
it in a store, or find and install soware from a site on the Internet.

In Ubuntu, it is possible install soware in the same manner. However,
the best way is to make use of the soware paages from the Ubuntu So-
ware Center. e Soware Center is a central location for soware that the
developers of Ubuntu have tested and determined to work with Ubuntu.

While other operating systems do not differentiate in the source of various
soware, Ubuntu has a concept of repositories. A repository is a catalog of
soware that is available to an operating system.

When you install Ubuntu, you will automatically have access to the offi-
cial Ubuntu repositories. You can add additional repositories to access more
soware.

Using the Ubuntu Soware Center
e Ubuntu Soware Center is the recommended way to install soware
in Ubuntu. e Soware Center can help you install most of the applications
that are available in the official repositories. Some soware, such as command-line

utilities and some advanced server tools
may not be installed using the Soware
Center. You will need to use the Synaptic
Package Manager to install these packages.

To start the Soware Center, open the Applications menu and oose
Ubuntu Soware Center.

e Soware Center window has two parts—a list of sections on the le,
and a set of icons on the right. Ea icon represents a department, whi
is a category of soware. For example, the “Games” department contains
“Sudoku.”

e sections on the le side of the window represent your current view of
the Soware Center’s catalog. Choose the “Get Free Soware” section from
the list to see soware in the catalog, or “Installed Soware” to see a list of
soware that is already installed on your computer.



 getting started with ubuntu 10.04

Figure .: You can install and remove
applications from your computer using the
Soware Center.
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Finding soware
If you are looking for some soware to install on your computer, you may
already know the name of the soware (for example, “underbird” is a
popular email client), or you may just know the category of soware (for
example, “audio editor” describes a number of soware applications that can
edit audio files).

To find soware, you can either browse the Soware Center catalog by de-
partment, or use the built-in sear to look for soware by name or keywords. Check out the Featured Applications depart-

ment to see a list of highly recommended
applications.To browse the Soware Center’s catalog, oose the “Get Free Soware”

section from the list on the le. e Soware Center will display a list of
departments su as “Office,” “Games,” or “Sound & Video.”

When you select a department, you will be shown a list of applications
that fall into that category. Some departments have sub-categories—for ex-
ample, the “Games” department has subcategories for “Simulation” and “Card
Games.”

To move ba or forth through categories, you can use the ba and for-
ward buons or the navigational “breadcrumbs.”

Installing soware
Note that you will need to be connected
to the Internet for the Soware Center
to work. To learn how to set up your
connection, see Chapter : Working with
Ubuntu.

Installing applications is one cli away, literally. Once you find the paage
you were looking for,

. Cli on the Install buon to the right of the selected paage. If you’d
rather read more about the paage before installing it, cli onMore Info
instead; there is another install buon embedded in the paage’s page for
you.

. Input your password on the authentication dialog. is is one of the built-
in security features that will only let authorized people to install soware
on your computer. Note: If your password does not work,

you are probably not authorized to install
soware on the computer. If you have
further problems, please go to Chapter :
Troubleshooting.

. Wait until the paage is finished installing. When operations—su as
application installations and removals—are currently running, you will see
an animated icon of rotating arrows to the le of the In Progress section
in the sidebar. While waiting for the application to be downloaded and
installed, you can head to that section to read details about the current
operation, wat the progress bar fill out, or cli the X icon to cancel the
operation. You can also go ba to the main soware browsing window
and queue other soware to be installed.

Once everything is completed, your paage is ready for usage. Ubuntu
will place a launer for it on your menu, filed under a mating category.
Remember that if your application does not appear under the Applications
menu, it may be located in System ‣ Preferences or System ‣Administration,
according to its usage intention.
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Removing soware
Removing applications is just as easy as installing them. Once you find the
application you wish to remove,
. Cli on the Remove buon to the right of the selected application. Note: To completely remove a package and

all its configuration, you will need to purge
it. You can do this with the Chapter ⁇: ⁇,
or read more about purging on Chapter ⁇:
⁇.

. Input your password in the authentication dialog. If your authentication is
granted, the application will be queued for removal under the In Progress
section on the list to the le. Needless to say, you will also need adminis-
trator rights to remove paages.
Naturally, when you remove a paage your menus will be updated ac-

cordingly.

Different ways to obtain soware
Even though Ubuntu provides the Soware Center and the official repositories
to help you install soware, there are other ways to get soware installed. To see more information about Security in

Ubuntu, visit Chapter : Security.
. Official repositories, the standard method of downloading soware. By

geing soware through the official repositories you ensure that your
soware is free of viruses or any other malware, that it is stable, and that it
works with Ubuntu.

. ird-party repositories that you can add to expand your soware
sources. ese repositories are not as reliable as the official ones: the
repository maintainer can put whatever they want into them. ere is
no solid guarantee that the soware inside them is secure, stable, or that it
works with your system. Read more instructions on this maer at Soware
Sources.

. Installers / deb paages that you can download from soware websites,
CDs, USB drives, etc. is method is the most insecure of all. You should
only obtain soware this way when you trust the source. If you are new to
Ubuntu, then you are probably accustomed to obtain soware this way as
it’s similar to .exe files in Windows.

Making more soware available
Note: You can open Soware Sources
from the Soware Center. Simply go to
Edit ‣ Soware Sources.

e Soware Center will only list the applications available in the reposito-
ries of your soware sources. To add more, or learn more about this, visit the
Chapter⁇: ⁇ section.

Synaptic Package Manager
Note: If you are not very familiar with
advanced computing in Ubuntu you may
wish to stick with the Soware Center.

e Synaptic Paage Manager serves a similar purpose as the Ubuntu
Soware Center, but gives you more control over dependencies and libraries.
It also gives you more control about the actions you can perform on paages;
it is the most complete visual paage manager available.
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‣ Install any paage in your repositories. You can even select whi version
of a paage to install, but note that this option is not available for all the
paages.

‣ Reinstall in case the paage’s contents have been damaged, or you just
want to get the default version ba.

‣ Update every time a new version of the paage is released.
‣ Remove any paage you no longer need.
‣ Purge when you wish to remove completely a paage, including saved
preferences and stored configuration files.

‣ Fix broken paages.
‣ Che properties of any paage, su as version, contained files, paage
size, dependencies, and mu more.

‣ Read and save markings in your computer.

Usage
Using this paage manager is very simple once you understand the basics
behind it. Ideally, you will mark different actions to perform on different
paages first, and then apply your anges. When you cli the Apply but-
ton, the Synaptic Paage Manager will do ea of your marked actions, one
by one. en you will be free to close the program, or wait until the process is
complete to make more anges.

To open the Synaptic Paage Manager go to System ‣Administration ‣
Synaptic Paage Manager.

Finding what you want

If you are having difficulties finding the paage you are looking for, you may
try thei sear box, the Sear buon (whi opens a sear dialog) or
sort by the categories in the le side pane.

You can use the Reload buon when you have made anges to your
soware sources, su as adding or removing repositories, so that the paage
manager can notice the anges and act accordingly.

Applying your changes

Once you find the paage you are looking for, you can just open its right-
cli menu and there you will see listed all the actions you can perform on it.
You can alternatively access these options through the Paage menu.

When you are ready marking actions, cli the Apply buon and wait
until the anges are made. Aerwards, you can close the application or mark
more anges.
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Soware Sources
e Soware Center—or the paage manager you are using—will list only
applications that are available in the repositories of your soware sources.
You can add or remove repositories to your soware sources with the So-
ware Sources application.

To start off, let’s open the Soware Sources application in the System ‣
Administration ‣ Soware Sources.

Configuring the Ubuntu repositories
Ubuntu has four main repositories—whi classify as the official repositories
—whi contain different types of paages.
‣ Canonical-supported open source soware (main) - is repository
contains all the open source paages that Canonical helps maintain.

‣ Community-maintained open source soware (universe) - is reposi-
tory contains all the open source paages that the community helps write
and maintain.

‣ Proprietary drivers for devices (restricted) - is repository contains
all the drivers available to devices or hardware you may use with your
computer, whi are non-free.

‣ Soware restricted by copyright or legal issues (multiverse) - is
repository contains all other soware that, as the name suggests, might
be illegal to use in some countries or states, so it’s not enabled by default.
However, you can still use it if you enable this repository, under your own
responsibility.
e Source codeebox should not be enabled unless you are used to

building applications from source. Building applications from source is an
advanced process that developers do to
create packages. The only time you would
ever need to build from source would be
if you were using a custom kernel or want
the latest version of an application that
hasn’t been packaged for Ubuntu yet. It’s
considered an advanced skill and therefore
we don’t cover building from source in this
manual.

Selecting the best soware server
Ubuntu grants permission to many servers all across the world to host exact
copies of the Ubuntu official repositories. Ubuntu does this so that wherever
you are you may have a server that is close to you to guarantee the best
download speed possible.

If your downloads are slow, you might be geing your soware from the
wrong server. ere are some aspects you should consider before selecting
your server:
‣ Connection speed. Depending on the physical distance between you and
your server, the connection speed may vary. Luily for you, Ubuntu had
thought about this long ago, and thus provides a tool to select the server to
whi your computer connects the best.
To select the fastest server available for you, cli the combobox of the

current server and select the Other menu option. Aer you are taken to
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the server selection window, cli on the Select Best Server buon, to the
upper right. You will have to wait for your computer to connect to all the
servers and then select the server with whi it had the fastest connection.

‣ Location. You should oose the server closest to your location to provide
the best connection speed.
To select a server by country, cli on the drop-down menu of the cur-

rent server. A window with all the countries with Ubuntu servers and the
respective servers registered to them will appear.

‣ Security. is should not concern you at all, as Canonical ensures the third
party servers are trustworthy. However, if you still think you might be at
risk with just any server, you could select one of the Ubuntu secure servers,
su as theMain server or the http://ubuntu.securedservers.com server.

If you are not connected to the Internet, you may insert your CD to your
computer and select the ebox in the Installable from the CD-ROM/DVD
box. Expect no more than the Cdrom with Ubuntu . inside the box.

Updates and Upgrades
Because Ubuntu is a very customizable operating system, it lets you specify
whi kinds of updates you want to download. To customize your updates, go
to the Updates tab in the Soware Sources window.

Ubuntu updates
is is where you can specify what kinds of updates you will like to get in-
stalled in your system.

‣ Important security updates - ese ensure that you get all the updates
that make Ubuntu su a secure operating system time and time again
when they are released. As the title suggests, it is important that you
enable these updates.

‣ Recommended updates - ese updates are not mandatory or important,
but if you wish to keep your whole system up-to-date, you should consider
enabling them.

‣ Pre-released updates - ese updates are for those who just cannot wait
whenever new versions of applications are out. Note that these updates
have not being tested enough, so you may encounter problems with the
updated applications. However, if you did encounter a problem, you could
easily roll-ba to the previous version, using the Synaptic Paage Man-
ager.

‣ Unsupported updates - ese are the updates that the Ubuntu staff has
not reviewed. Even though they are secure, as with the previous ones, you
may encounter problems when using them.
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Automatic updates
Here you can customize your systems behaviour towards updates. You can
customize whether it es for updates or not, if it should install important
updates right away (without asking for your permission), if it should only
download them, or if it should only notify you about them. You can also
customize the frequency with whi your system es for new updates.

Release upgrade
Note: Every  months, Ubuntu releases
a new version of the operating system.
These are called normal releases. Every four
normal releases—or  months—Ubuntu
releases a Long Term Support (LTS) release.
Long Term Support releases receive extra
effort from the developers so they are more
stable, and thus are used by companies that
need extra-reliable setups.

Here you can customize whi kind of system upgrades you will like to have
available.

‣ Never - Choose this if you don’t want to be notified about new Ubuntu
releases at all.

‣ Normal releases - Choose this if you always want to have the latest
Ubuntu release, no maer if it is Long Term Support or not. is option
is recommended for normal home users.

‣ Long Term Support releases only - Choose this option if you need a
release that will have—as the title suggests—support for a long time. If you
own a company and you have Ubuntu as the operating system for your
employees, you probably want to select this option.

Adding more soware repositories
Definition: A PPA is a Personal Package
Archive, or a third-party repository. The
PPAs are spaces where people host digital
projects, such as applications, documents,
and many more.

As you have probably read before in this apter, there is a way that you
can get soware, from a paage manager, from third-party—or non-Ubuntu
—repositories. ese “third-party repositories” are called PPAs.

To add a PPA to your soware sources, go to the Other Soware tab in the
Soware Sources window.

What you will need
. e PPA intelligent URL. To get it, go to the project owner’s launpad

page, whether it is a team or a single launpad user. When you are taken
to the page, look for a header labelled “Personal Paage Arives”; cli
on the link to the one that best mates the project you are trying to add a
repository of. en, you will be taken to a page titled “PPA for (…)”. Look
for a link below, in bold font, similar to this one: lp:paage. at’s your
PPA intelligent URL.

Note: The key file is the security method
used by Ubuntu to ensure that you are the
one who is adding the PPA. e key file. To get it, go to the same page where you got your PPA intel-

ligent URL. Now, instead of copying that URL, cli on Tenical details
about this PPA link. en cli the link below the “Signing key” header.
Aerwards, make your last cli on the -digit code. Copy all the text in
the page and save it as a text file. at file is your key file.
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M I S S I N G S C R E E N S H O T
Screenshot of PPA page on Launchpad.

Figure .: Screenshot of PPA page on
Launchpad.

Adding the PPA and authorizing the key
Aer you have the requirements, adding a PPA is a two step procedure:
. Add the PPA by cliing on the Add… buon, and copy the PPA intelligent

URL to the APT Line input box.
. Authorize the key by going to the Authentication tab (in the Soware

Sources window) and cliing the Import Key File… buon. at will
open up a browser for you; find your key file and you are done.
Before closing Soware Sources, read the next section.

Geing ready to use it
Because Ubuntu needs to keep tra of a large catalog of applications, it just
does not aempt to update it with every small ange you make. You have to
update it every time you ange a seing in Soware Sources, su as adding
a new repository/PPA.

Luily for you, upon closing Soware Sources you will be asked if you
want to reload the soware sources. To do so, cli the Reload buon. Aer
Soware Sources finishes reloading the database and closes itself, you will be
able to access your paage from any paage manager.





 The Command Line
Introduction to the Terminal
roughout this manual, we have focused primarily on the graphical desktop
user interface. However in order to fully realise the power of Ubuntu, you
may want to learn how to use the terminal.

What is the Terminal?
Most operating systems, including Ubuntu, have two types of user interfaces.
e first is a graphical user interface, also known as a GUI. is is the desktop,
windows, menus and toolbars that you cli to get things done. e second,
and mu older, type of interface is the command-line interface, also known
as a CLI.

e terminal is Ubuntu’s command-line interface. It is a method of con-
trolling some aspects of Ubuntu using only commands that you type on the
keyboard.

Why would I want to use the Terminal?
For the average Ubuntu user, most day-to-day activities can be completed
without ever needing to open the terminal. However the terminal is a pow-
erful and invaluable tool that can be used to perform many useful tasks. For
example:

‣ Troubleshooting any difficulties that may arise when using Ubuntu some-
times requires you to use the terminal.

‣ A command-line interface is sometimes a faster way to accomplish a task.
For example, it is oen easier to perform operations on many files at once
using the terminal.

‣ Learning the command-line interface is the first step towards more ad-
vanced troubleshooting, system administration, and soware develop-
ment skills. If you are interested in becoming a developer or an advanced
Ubuntu user, knowledge of the command-line will be essential.

In GUI environments the term “folder” is
commonly used to describe a place where
files are stored. In CLI environments the
term “directory” is used to describe the same
thing and this metaphor is exposed in many
commands (i.e. “cd” or “pwd”) throughout
this chapter.

Opening the Terminal

The terminal gives you access to what is
called a shell. When you type a command
in the terminal the shell interprets this
command, resulting in the desired action.
There are different types of shells that
accept slightly different commands. The
most popular is called “bash”, and is the
default shell in Ubuntu.

You can open the terminal by cliing Applications ‣Accessories ‣Terminal.
When the terminal window opens, it will be largely blank apart from some

text at the top le of the screen, followed by a blinking blo. is text is your
prompt—it displays your login name and your computer’s name, followed by



 getting started with ubuntu 10.04

the current directory. e tilde (~) means that the current directory is your
home directory. Finally, the blinking blo is the cursor—this marks where
text will be entered as you type.

To test things out, type pwd and press Enter. e terminal should display
“/home/your-username”. is text is called the “output”. You have just used
the “pwd” (print working directory) command, and the output that was dis-
played shows the current directory.

Figure .: The default terminal window.

All commands in the terminal follow the same approa. Type in the
name of a command, possibly followed by some parameters, and press Enter
to perform the specified action. Oen some output will be displayed that Parameters are extra segments of text,

usually added at the end of a command,
that change how the command itself is
interpreted. These usually take the form of
-h or --help, for example. In fact, --help
can be added to most commands to display
a short description of the command, as well
as a list of any other parameters that can be
used with that command.

confirms the action was completed successfully, although this depends on
the command. For example, using the “cd” command to ange your current
directory (see below) will ange the prompt, but will not display any output.

e rest of this apter covers some very common uses of the terminal,
however there are almost infinite possibilities available to you when using
the command-line interface in Ubuntu. roughout Part II of this manual we
will continue to refer to the command-line, particularly when discussing steps
involved in troubleshooting and the more advanced management of your
computer.

Ubuntu file system structure
Stuff about the file system goes here…
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Figure .: The file system structure in
Ubuntu

Geing started with the command line
Navigating directories
e pwd command is short for print working directory. It can be used to
display the directory you are currently in. Note that the prompt (the text
just before the blinking cursor) also displays your current directory, so this
command is not usually necessary.

$ pwd
/home/your-username/

e cd command is short forange directory. It allows you to ange
from one directory to another.

$ cd /directory/you/want/to/go/to/

For example:

$ cd " /Music/The Beatles/Sgt. Pepper's Lonely Hearts Club Band/"

Note the use of quotation marks around the command. We do this when
there are spaces in the file location or folder names, so that the command line
doesn’t interpret a space as the end of the name.

Geing a list of files
e ls command is used to get a list of all the files and directories that exist
inside the current directory.

$ ls
directory1
directory2
file1.txt
file2.txt
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Moving things around
Note that the terminal is case-sensitive.
For example, if you have a directory called
Directory, you must remember to include
the capital leer whenever referring to it in
the terminal, otherwise the command will
not work.

e mv command is used to move a file from one directory to another.

$ mv /move/this/file.txt /to/this/directory/

e cp command is used to copy a file from one directory into another.

$ cp /copy/this/file.txt /to/this/directory/

Creating directories
e mkdir command is short for make directory, and is used to create a new
directory in the current directory or another specified location. For example,
this command will make a directory called “newdirectory” inside the current
directory:

$ mkdir newdirectory

is command will ignore your current directory, and instead make one
called “newdirectory” inside a hypothetical directory called /tmp/example/ :

$ mkdir /tmp/example/newdirectory

You could then “move into” this new directory (i.e. make it your current
working directory), by using the cd command.

$ cd /tmp/example/newdirectory

Deleting files and directories
e rm command is used to delete files. For example, to delete a file located in
your current directory:

$ rm deleteme.txt

To delete a file located in another directory (i.e. not inside your current
working directory), you would need to include the path to the file. In other
words, you are specifying the file’s location. For example:

$ rm /tmp/example/deleteme.txt

e rmdir command is similar to the rm command, except it is used to
delete folders. For example, this command would delete the directory called
“newdirectory” that we created earlier.

$ rmdir /tmp/example/newdirectory/
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Introducing sudo
When Ubuntu is first installed two accounts are created; your primary user
account, and a “root” account that operates behind the scenes. is root ac-
count has the necessary privileges required for modifying system files and
seings, whereas your primary user account does not. Rather than logging
out of your primary user account and then logging ba in as root, the “sudo”
command can be used to borrow root account privileges for performing ad-
ministrative tasks su as installing or removing soware, creating or remov-
ing new users, and modifying system files.

For example, the following command would open Ubuntu’s default text
editor gedit with root privileges. is then allows you to edit important sys-
tem files that would otherwise be protected. Your sudo password is the same
password you use to login to your primary account, and is set up during the
Ubuntu install process. When using sudo in the terminal, you

will be prompted to enter your password.
You will not see any dots, stars or other
characters appearing in the terminal as you
type your password, however don’t be put
off—this is an extra security feature to help
protect you from any prying eyes.

$ gksudo gedit
[sudo] password for username:
Opening gedit...

e sudo command can give you virtually unlimited access to important
system files and seings. It is important you only use sudo if you understand
what you are doing. You can find out more about using sudo in Chapter :
Security.

Managing soware through the Terminal
In Ubuntu there are a number of ways to manage your soware. GUI tools
su as the Ubuntu Soware Center and Synaptic Paage Manager were
discussed in Chapter⁇: ⁇, however many people prefer to use the apt com-
mand (Advanced Paaging Tool) to manage their soware from within the
terminal. Apt is extremely versatile and encompasses several tools, however
the most commonly used apt tool is the aptitude command.

Using aptitude
Aptitude is used for installing and removing paages from your system. It
can also be used to refresh the list of paages available in the repositories, as
well as download and install any new updates for your soware.

Updating and upgrading
e aptitude update command can be used to quily refresh the list of pa-
ages that are available in the default Ubuntu repositories, as well as any addi-
tional repositories added by the user (see Chapter⁇: ⁇ for more information
on repositories).



 getting started with ubuntu 10.04

$ sudo aptitude update

You can then use aptitude safe-upgrade to download and install any avail-
able updates for your currently installed paages. It is best to run aptitude
update prior to running aptitude safe-upgrade, as this will ensure you are
geing the most recent updates available for your soware.

$ sudo aptitude safe-upgrade
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following packages will be upgraded:
tzdata
1 upgraded, 0 newly installed, 0 to remove and 0 not upgraded.
Need to get 683kB of archives.
After this operation, 24.6kB disk space will be freed.
Do you want to continue [Y/n]?

e terminal will give you a summary of what paages are to be up-
graded, the download size, and how mu extra disk space will be used (or
freed), and then ask you to confirm before continuing. Simply press “y” then
Enter, and the upgrades will be downloaded and installed for you.

Installing and removing
e following command would be used to install VLC media player using
aptitude: Notice the sudo command before the ap-

titude command. In most cases it will be
necessary to use sudo when installing
soware, as you will be modifying pro-
tected parts of your system. Many of the
commands we will be using from here on
require root access, so expect to see sudo
appearing frequently.

$ sudo aptitude install vlc
[sudo] password for username:

To remove VLC, you would type:

$ sudo aptitude remove vlc

Cleaning up your system
Oen soware in Ubuntu depends on other paages being installed on your
system in order to run correctly. If you aempt to install a new paage and
these dependencies are not already installed, Ubuntu will automatically down-
load and install them for you at the same time (provided the correct paages
can be found in your repositories). When you remove a paage in Ubuntu
however, any dependencies that were installed alongside the original pa-
age are not also automatically removed. ese paages sit in your system
and can build up over time, taking up disk space. A simple way to clean up
your system is to use the aptitude autoremove command. is will select and
remove any paages that were automatically installed but no longer required.
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$ sudo aptitude autoremove

Adding extra soware repositories
Sometimes you might want to install some soware that isn’t in the official
repositories but may be available in a whats called a PPA, ppa’s or Personal
Paage Arives contain soware that you can install simply by adding that
ppa to your system, in versions of Ubuntu prior to Ubuntu . adding a ppa
to your system meant typing several really long commands in to a terminal,
however in Ubuntu . and later adding a ppa is as easy as typing one short
command into a terminal.

$ sudo add-apt-repository ppa:example/ppa

Now that you have installed a ppa you can just install soware from it the
usual way using the aptitude install command.





 Security
is apter discusses ways to keep your Ubuntu computer secure.

Why Ubuntu is safe
Ubuntu is secure by default for a number of reasons:

‣ Ubuntu clearly distinguishes between normal users and administrative
users.

‣ Open source soware like Ubuntu allows security flaws to be easily de-
tected.

‣ Security pates for open source soware like Ubuntu are oen released
quily.

‣ Many viruses primarily target Windows-based systems and so do not affect
Ubuntu systems.

Security basics
is section describes basic security concepts and procedures.

Permissions
By default, Ubuntu includes a special user account, “root,” whi has full
administration privileges. While regular users can only access their own files,
they cannot make critical anges to the system. Even tasks su as installing
applications require users to input passwords before proceeding.

In Ubuntu, the root account has been disabled to improve security and can-
not be used directly. Instead, the initial user account created when installing
Ubuntu has permission to conduct administrative tasks by using the sudo
command. is command allows a user to temporarily become a “super-user”
and grants administrative privileges for a specific task.

e following example runs the apt-get “clean” command as a super-user:

$ sudo apt-get clean

sudo should only be used when needed. Operations that can be completed
without sudo should be executed as the normal user.

e Ubuntu Desktop has a graphical version of sudo for programs that
require administration permissions. For example: During a system update,
the desktop will fade out and a box asking for the user’s password will appear.
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Entering the password grants the user permission to perform actions that
require administrative privileges.

Users must be given permission to use the sudo command. is can be
done by adding users to the Admin group. See Users and groups for details on
how to do this.

Only users that need administration access should be given sudo permission.
We do not recommend granting administrative privileges to all users.

Basic security precautions
Separate user accounts
When Ubuntu is installed, it is automatically configured for a single per-
son to use. If more than one person will use the computer with Ubuntu on
it, ea person should her or his own user account. is way, ea user can
have separate seings, documents, and other files. If necessary, you can also
protect files from being viewed or modified by other users without adminis-
trative privileges. See Users and groups to learn how to create additional users
accounts.

Passwords
Using strong passwords is one of the simplest ways to increase the security
of your computer. Your password should not contain names, common words
or common phases. By default, the minimum length of a password in Ubuntu
is four aracters. We recommend a password with more than the minimum
number of aracters.

Locking the screen
When leaving your computer unaended, lo the screen. is prevents any-
one from using your computer. Unloing the screen requires your password.
To lo the screen:

‣ Cli the user switer in the right corner of the top panel, then select Lo
Screen, or

‣ Press Control+Alt+L to lo the screen. is keyboard shortcut can be
anged in System ‣ Preferences ‣Keyboard Shortcuts.

System updates
Ubuntu provides soware and security updates, and you should apply these
updates regularly. See Chapter ⁇: ⁇ for how to update your Ubuntu com-
puter with the latest security updates and pates.
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Trusting third party sources
Normally, you will add applications to your computer via the Soware Center,
whi downloads soware from the Ubuntu repositories as described in
Chapter⁇: ⁇. However, it is occasionally necessary to add soware from
other sources. For example, you may need to do this when an application is
not available in the Ubuntu repository, or when you need a newer version of
the one avaialble in the Ubuntu repository.

Additional repositories are available from sites su as getdeb.net and
Launpad PPAs, whi can be added as described in Chapter⁇: ⁇. You
can download the .deb paages for some applications from their respective
project sites on the Internet. Alternately, you can build applications from their
source code (an advanced method of installing and using applications).

Using only recognized sources su as a project’s site, PPA, or various
community repositories (su as getdeb.net) is more secure than downloading
applications from an arbitrary (and perhaps less reputable) source. When
using a third party source, consider how trustworthy you consider the source,
and be sure you know exactly what you’re installing on your computer.

Users and groups
Like most operating systems, Ubuntu supports multiple users accounts. is
feature allows ea person using your computer to have a separate user ac-
count. Ubuntu also supports user groups. Every user is a member of one or
more groups, and every user has a group with the same name as the user
(of whi the user is a member). You can configure some files and folders to
be accessible only by a user and a group. By default, a user’s files are only
accessible by that user; system files are only accessible by the root user.

Managing users
You can manage users and groups using the Users and Groups administra-
tion application. To find this application, cli:

System ‣Administration ‣Users and Groups
To adjust to user and group seings cli the keys icon next the phrase

“Cli to make anges.” You will need to input your password in order to
make anges to user and group seings.

Adding a user Cli the Add buon whi appears underneath a list of the
current user accounts that have already been created.

Type in the new username and select relevant options then cli OK.
A new dialog box will appear asking you to enter a password for the user

you have just created. Complete the relevant fields as you see fit, then cli
OK to proceed. Privileges you grant to the new user can be altered in “Users

http://getdeb.net
http://getdeb.net
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Figure .: Add, remove and change the user
accounts.

Seings”.

Modifying a user Cli on the name of a user in the list of users, then cli
on the Change… buon, whi appears next to ea of following options:

‣ Account type:
‣ Password:

For more advanced user options cli the Advanced Settings buon. Change
the details as required in the dialog box that appears. Cli OK to apply the
anges.

Deleting a user Select a user from the list and cli the Delete buon. is
will deactivate the user’s account, but not remove the user’s home folder.

Managing groups
Cli theManage Groups buon to open the group management dialog box.

Adding a group To add a group, cli the Add buon. In the dialog box that
appears, type the group name and select the names of users you’d like to add
to the group.

Modifying a group To alter the users in an existing group, select a group and
cli the Properties buon. Select and de-select the users as required, then
cli OK to apply the anges.

Deleting a group To delete a group, select a group and cli Delete.
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Applying groups to files and folders
To ange the group associated with a file or folder, open Nautilus and nav-
igate to the appropriate file or folder. en, either select the folder and use
the File ‣ Properties menu item, or right cli on the file / folder and select
Properties. In the Properties dialog that appears, cli the the Permissions
tab and select the desired group from the Groups dropdown box. en close
the window.

Using the command line
You can also modify user and group seings via the command line. We
recommended you use the graphical method above unless you have good
reason to use the command line. For more information on using the com-
mand line to modify users and groups, see the Ubuntu Server Guide at
hps://help.ubuntu.com/./ serverguide/C/user-management.html

Seing up a secure system
is section describes how to use additional security programs to increase the
security of your system.

Firewall
A firewall is an application that protects your computer against unauthorized
access by people on the Internet or local your network. Firewalls blo con-
nections to your computer from unknown sources. is helps prevent security
breaes.

Uncomplicated Firewall (UFW) is the standard firewall configuration
program in Ubuntu. It is a program that runs from the command line, but
a program called Gufw allows you to use it with a graphical interface. See
Chapter⁇: ⁇ to learn more about installing the Gufw paage.

Once it’s installed, start Gfuw by cliing System ‣Administration ‣
Firewall configuration. To enable the firewall, cli the Enableebox. By
default, all incoming connections are denied. is seing should be suitable
for most users.

If you are running servers on your Ubuntu system, then you will need to
open the ports these services use. If you do not know what this means, then
you are probably not running any servers and you should not open any ports.

To open a port cli the Add buon. For most purposes, the Preconfigued
tab is sufficient. Select Allow from the first box and then select the program
or service required.

e simpletab can be used to allow access on a single port, and the Ad-
vanced tab can be used to allow access on a range of ports.

https://help.ubuntu.com/9.10/serverguide/C/user-management.html
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Encryption
You may wish to encrypt your sensitive personal data—for instance, financial
records—by encrypting it. Encrypting a file or folder essentially “los” that
file or folder by encoding it with an algorithm that scrambles it until it’s
properly decoded with a password. Encrypting your personal data ensures
that no one can open your personal folders or read your private data without
your express permission.

Ubuntu includes a number of tools to encrypt files and folders. is ap-
ter will discuss two of these. For further information on using encryption
with either single files or email, see Ubuntu Community Help documents at
hps://help.ubuntu.com/community.

Home folder
When installing Ubuntu, it is possible to encrypt a user’s home folder. See
Chapter : Installation for more on doing this.

Private folder
If you have not osen to encrypt a user’s entire home folder, it is possible to
encrypt a single folder—called Private—in a user’s home folder. To do this:

. Install ecryptfs-utils.
. Run ecryptfs-setup-private to set up the private folder.
. Enter your login password when prompted.
. Either oose a mount passphrase or generate one.
. Record both passphrases in a safe location. ese are required if you ever

have to recover your data manually.
. Logout and Log ba in to mount the encrypted folder.

Aer the Private folder has been set up, any files or folders in it folder will
be encrypted when wrien to the disk.

If you need to recover your encrypted files manually see hps://help.ubuntu.com/community/EncryptedPrivateDirectory.

https://help.ubuntu.com/community
https://help.ubuntu.com/community/EncryptedPrivateDirectory


 Troubleshooting
Resolving problems
Sometimes, things simply do not work as they should. Luily, problems
encountered while working with Ubuntu are easily fixed. Below, we offer
a guide to resolving basic problems that users may encounter while using
Ubuntu. If you exhaust the troubleshooting advice below, see Geing more
help to learn about seeking support from the Ubuntu community.

Troubleshooting guide
e key to effective troubleshooting is working slowly and methodically,
documenting anges you make to your Ubuntu system at every step. is
way, you will always be able to roll ba your work—and give fellow users
information about your previous aempts, in the unlikely event that you
should need to turn to the community for support.

Ubuntu failing to start aer installing Windows
Occasionally you may install Ubuntu and then decide to install Microso
Windows as a second operating system running side-by-side with Ubuntu.
While this is supported by Ubuntu, you may find that aer installing Win-
dows you may no longer be able to start Ubuntu.

When you first turn on your computer, a program called a “bootloader”
must start Ubuntu or another operating system. When you installed Ubuntu, Definition: A bootloader is initial soware

that loads the operating system when you
turn on the computer.you installed an advanced bootloader called GRUB that allowed you to oose

between the various operating systems on your computer, su as Ubuntu,
Windows and others. However, when you installed Windows, you removed
GRUB, thus removing the ability to oose whi operating system you’d like
to use. You can easily restore GRUB—and regain the ability to oose your
operating system—by using the same CD you used to install Ubuntu.

First, insert your Ubuntu CD into your computer and restart it, making
sure to have your computer start the operating system that is on the CD
itself (see Chapter : Installation). Next, oose your language and select Try
Ubuntu. Wait while the soware loads. You will need to type some code to
restore your bootloader. On the Applications menu, cli Accessories, and
then cli the Terminal item. Enter the following:

$ sudo fdisk -l

Disk /dev/hda: 120.0 GB, 120034123776 bytes
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255 heads, 63 sectors/track, 14593 cylinders
Units = cylinders of 16065 * 512 = 8225280 bytes

Device Boot Start End Blocks Id System
/dev/sda1 1 1224 64228+ 83 Linux
/dev/sda2 * 1225 2440 9767520 a5 Windows
/dev/sda3 2441 14593 97618972+ 5 Extended
/dev/sda4 14532 14593 498015 82 Linux swap

Partition table entries are not in disk order Note: The device (/dev/sda, /dev/sda…)
we are looking for is identfied by the word
“Linux” in the System column. Modify the
instructions below if necessary, replacing
/dev/sda with the name of your Linux
device.

is output means that your system (Linux, on whi Ubuntu is based)
is installed on device /dev/sda, but your computer is booting to /dev/sda
(where Windows is located). We need to rectify this by telling the computer to
boot to the Linux device instead.

To do this, first create a place to manipulate your Ubuntu installation:

$ sudo mkdir /media/root

Next, link your Ubuntu installation and this new folder:

$ sudo mount /dev/sda1 /media/root

If you’ve done this correctly, then you should see the following:

$ ls /media/root
bin dev home lib mnt root srv usr
boot etc initrd lib64 opt sbin sys var
cdrom initrd.img media proc selinux tmp vmlinuz

Now, you can reinstall GRUB:

$ sudo grub-install --root-directory=/media/root /dev/sda
Installation finished. No error reported.
This is the contents of the device map /boot/grub/device.map.
Check if this is correct or not. If any of the lines is incorrect,
fix it and re-run the script ``grub-install''.
(hd0) /dev/sda

Finally, remove the Ubuntu disc from your CD-ROM drive, reboot your
computer, and enjoy your Ubuntu system once again.

Ubuntu doesn’t present the login screen on boot
e simplest and easiest way to correct this issue is to order Ubuntu to reset
the graphics configuration. Press and hold Control, Alt and F. You should
now see a bla and white screen with a prompt for your username and
password.
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M I S S I N G S C R E E N S H O T
Screenshot of a virtual terminal (i.e. ctrl-alt-F)

Figure .: Screenshot of a virtual terminal
(i.e. ctrl-alt-F)

Enter your username, press Enter, and then enter your password. (Char-
acters will not appear on the screen as you enter your password. Don’t worry
—this behavior is normal and was implemented for security purposes.) Next,
enter the following code and press enter:

$ sudo dpkg-reconfigure -phigh xserver-xorg

Enter your password at the prompt, as above. Allow Ubuntu to process the
command, then enter:

$ sudo reboot now

Ubuntu will reboot, and your login screen should be restored.

I forgot my password
If you forget your password in Ubuntu, you will need to reset it using the
“Rescue mode”.

To start Rescue mode, shut down your computer, then power it up. As the
computer starts up, press Esc when you see the white-on-bla screen with
a countdown (the GRUB prompt). Select the Rescue mode option using the
arrow keys on your keyboard. Rescue mode should be the second item in the
list.

Wait while Ubuntu starts up. You will not see a normal login screen. In-
stead, you will be presented with a terminal prompt that looks something
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M I S S I N G S C R E E N S H O T
GRUB screen with Rescue Mode option highlighted

Figure .: GRUB screen with Rescue Mode
option highlighted

like:

root@something#

To reset your password, enter:

$ passwd username

Replace “username” above with your username. Ubuntu will prompt you
for a new password. Enter your desired password, press enter and then type
your password again, pressing enter aer you are done. (Ubuntu asks for your
password twice to make sure you did not make a mistake while typing.) Once
you have restored your password, return to the normal system environment
by entering:

$ init 2

Login as usual and continue enjoying Ubuntu.

I can’t find my deleted files
If you’ve deleted a file by accident, you may be able to recover it from
Ubuntu’s “Trash” folder. is is a special folder where Ubuntu stores deleted
files before they are permanently removed from your computer.

To access the “Trash” folder, select the Places menu, and oose Com-
puter. Ubuntu will open the “Computer - File Browser” window. Choose
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Trash from the list of places in the le-hand sidebar of the window. To re-
move items from the trash and restore them to your computer, simply drag
them wherever you would like (we recommend a location su as your home
folder).

How do I clean Ubuntu?
Over time, Ubuntu’s soware paaging system can accumulate unused pa-
ages or temporary files. ese temporary files, also called caes, contain
paage files from all of the paages that you have ever installed. Eventu-
ally, this cae can grow quite large. Removing them allows you to reclaim
space on your computer’s hard drive for storing your documents, music,
photographs, or other files.

To clear the cae, you can use either the clean, or the autoclean option
for a command-line program called apt-get. e clean command will remove
every single caed item, while the autoclean command only removes caed
items that can no longer be downloaded (these items are oen unnecessary).
To run clean, open Terminal and type:

$ sudo apt-get clean

Paages can also become unused over time. If a paage was installed to
assist with running another program—and that program was subsequently
removed—you no longer need the supporting paage. You can remove it with
autoremove.

Load Terminal and type:

$ sudo apt-get autoremove

to remove the unnecessary paages.

I can’t play certain audio or video files
Many of the formats used to deliver ri media content are proprietary,
meaning they are not free to use, modify and distribute with an open source
operating system like Ubuntu. erefore, Ubuntu does not include the ca-
pability to use these formats by default; however, users can easily configure
Ubuntu to use these proprietary formats. For more information about the
differences between open source and proproetary soware, see Chapter :
Learning more.

If you find yourself in need of a proprietary format, you may install the
files necessary for using this format with one command. Before initiating this
command, ensure that you have Universe and Restricted repositories enabled.
See Synaptic Paage Manager (Configuring the Ubuntu Repositories) to learn
how to do this.
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Open the Ubuntu Soware Center by selecting it from Applications.
Sear for ubuntu-restricted-extras by typing “ubuntu restricted extras”
in the sear box on the right-hand side of the Ubuntu Soware Center’s
main window. When the Soware Center finds the appropriate soware, cli
the arrow next to its title. Cli Install, then wait while Ubuntu installs the
appropriate soware.

Once Ubuntu has successfully installed soware, your ri media content
should work properly.

How can I change my screen resolution?
e image on every monitor is composed of millions of lile colored dots
called pixels. Changing the number of pixels displayed on your monitor is
called “anging the resolution.” Increasing the resolution will make the dis-
played images sharper, but will also tend to make them smaller. e opposite
is true when screen resolution is decreased. Most monitors have a “native res-
olution”, whi is a resolution that most closely mates the number of pixels
in the monitor. Your display will usually be sharpest when your operating
system uses a resolution that mates your display’s native resolution.

e Ubuntu configuration utilityMonitors allows users to ange the
resolution. Open it by oosing System from the Main Menu, then oosing
Preferences and thenMonitors. e resolution can be anged using the
drop down list within the program. Piing options higher up on the list (for
example, those with larger numbers) will increase the resolution.

Figure .: You can change your display
seings.

You can experiment with various resolutions by cliing Apply at the bot-
tom of the window until you find one that’s comfortable for you. Typically
the highest resolution will be the native resolution. Selecting a resolution
and cliing Apply will temporarily ange the screen resolution to the se-
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lected value. A dialog box will also be displayed. It allows you to revert to
the previous resolution seing or keep the new resolution. e dialog box will
disappear in  seconds, restoring the old resolution.

Figure .: You can revert back to your old
seings if you need to.

is feature was implemented to prevent someone from being loed out of
the computer by a resolution that distorts their screen and makes it unusable.
When you have finished seing the screen resolution, cli Close.

Ubuntu is not working properly on my Apple MacBook or MacBook
Pro
When installed on notebook computers from Apple—su as the Macbook or
MacBook Pro—Ubuntu does not always enable all of the computer’s built-in
components, including the iSight camera and the Airport wireless Internet
adapter. Luily, the Ubuntu community offers documentation on fixing these
and other problems. If you are having trouble installing or using Ubuntu
on your Apple notebook computer, please follow the instructions at https:
//help.ubuntu.com/community/MacBook. You can select the appropriate guide
aer identifying your computer’s model number. For instructions on doing
this, visit the web page above.

Ubuntu is not working properly on my Asus EeePC
When installed on netbook computers from Asus—su as the EeePC—Ubuntu
does not always enable all of the computer’s built-in components, including
the keyboard hotkeys and the wireless Internet adapter. e Ubuntu com-
munity offers documentation on fixing these and other problems. If you are
having trouble installing or using Ubuntu on your Asus EeePC, please follow
the instructions at https://help.ubuntu.com/community/EeePC. is documen-
tation page contains information pertaining specifically to EeePC netbooks.

My hardware is not working properly
Ubuntu occasionally has difficulty running on certain computers, gener-
ally when hardware manufacturers use non-standard or proprietary com-
ponents. e Ubuntu community offers documentation to help you trou-
bleshoot many issues that may arise from this situation, including problems

https://help.ubuntu.com/community/MacBook
https://help.ubuntu.com/community/MacBook
https://help.ubuntu.com/community/EeePC
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with wireless cards, scanners, mice and printers. You can find the complete
hardware troubleshooting guide on Ubuntu’s support wiki, accessible at
https://wiki.ubuntu.com/HardwareSupport. If your hardware problems per-
sist, please see Geing more help for more troubleshooting options or infor-
mation on obtaining support or assistance from an Ubuntu user.

Geing more help
is guide does not cover every possible workflow, task or issue in Ubuntu.
If you require assistance beyond the information in the manual, you can find
a variety of support opportunities online. You can access extensive and free
documentation, buy professional support services, query the community for
free support or explore tenical solutions. More information is available here:
http://www.ubuntu.com/support

https://wiki.ubuntu.com/HardwareSupport
http://www.ubuntu.com/support


 Learning more
What else can I do with Ubuntu?
By now, you should be able to use your Ubuntu desktop for all your daily
activities—like browsing the web and editing documents. But you may be
interested in learning about other versions of Ubuntu you can integrate into
your digital lifestyle. In this apter, we’ll provide you with more detail about
versions of Ubuntu that are specialized for certain tasks. To do this, we’ll first
discuss the tenologies that make Ubuntu a powerful collection of soware.

Open Source soware
Ubuntu is open source soware. Simply put, open source soware is soware
whose source code isn’t owned exclusively by any one person, group or or-
ganization, but is rather made freely available for download. is makes Definition: The source code of a program

is the files that have been wrien to make
the program.Ubuntu different from proprietary soware, whi requires users to purase

licenses before they are able to use the soware on their computers. Mi- Definition: Proprietary soware is
soware that cannot be copied, modified, or
distributed freely.

croso Windows and Adobe Photoshop are examples of proprietary soware.
Computer users can share and distribute open source soware without

fear of breaking intellectual property laws. ey can also modify open source
soware to suit their individual needs, improve it, or translate it into other
languages—as long as they release their anges to others who might wish to
do the same. Because open source soware is developed by large communi-
ties of programmers distributed throughout the globe, it benefits from rapid
development cycles and speedy security releases (in the event that someone
discovers bugs in the soware). In other words, open source soware is up-
dated, enhanced, and made more secure every day as programmers all over
the world continue to improve it.

Aside from these tenical advantages, open source soware also has
economic benefits. Most open source programs cost nothing to obtain or run.
Users needn’t purase a license to run Ubuntu, for example.

To learn more about open source soware, see the Open Source Initia-
tive’s open source definition, available at http://www.opensource.org/docs/
definition.php

Distribution families
Ubuntu is one of several popular operating systems based on GNU/Linux
(an open source operating system). While other versions of GNU/Linux, or
“distributions,” may look different from Ubuntu at first glance, they share

http://www.opensource.org/docs/definition.php
http://www.opensource.org/docs/definition.php
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similar aracteristics because of their common roots. Distribution: A distribution, or “distro”, is
a operating system made from open source
programs, bundled together to make them
easier to install and use.

GNU/Linux distributions can be divided into two broad families: the
Debian family and the Red Hat family. Ea family is named for a distribution
on whi subsequent distributions are based. For example, “Debian” refers to
both the name of a distribution as well as the family of distributions derived
from Debian. Ubuntu is part of the Debian family of distributions, as are
Linux Mint, Xandros and Crunbang Linux. Distributions in the Red Hat
family include Fedora, OpenSUSE, and Mandriva.

e most significant difference between Debian-based and Red Hat-based
distros is the system ea uses for installing and updating soware. ese
systems are called “paage management systems.” Debian soware pa- Definition: Package management

systems are the means by which users
can install, remove, and organize soware
installed on computers with open source
operating systems like Ubuntu.

ages are .deb files, while Red Hat soware paages are .rpm files. For more
information about paage management, see Chapter⁇: ⁇.

You will also find distributions that have been specialized for certain tasks.
Next, we’ll describe these versions of Ubuntu and explain the uses for whi
ea has been developed.

Choosing amongst Ubuntu and its derivatives
Just as Ubuntu is based on Debian, several distributions are subsequently
based on Ubuntu. Some of these are made for general use, and ea differs
with respect to the soware included as part of the distribution. Others are
designed for specialized uses.

Four derivative distributions are officially recognized and supported by
both Canonical and the Ubuntu community. ese are:

‣ Ubuntu Netbook Edition, whi is optimized for netbook computers.
‣ Kubuntu, whi uses the KDE graphical environment instead of the
GNOME environment found in Ubuntu.

‣ Edubuntu, whi is designed for use in sools.
‣ Ubuntu Server Edition, whi is designed for use on servers, and typically
is not used as a desktop operating system (because users must interact with
it via the command line).

ree other officially recognized derivatives of Ubuntu are available. ese
include:

‣ Xubuntu, whi uses the XFCE graphical environment instead of the
GNOME environment used by Ubuntu.

‣ Ubuntu Studio, whi is designed for creating and editing multimedia.
‣ Mythbuntu, whi is designed for creating a home theater PC with
MythTV (an open source digital video recorder)

For more information about these derivative distributions, see http://www.
ubuntu.com/products/whatisubuntu/derivatives.

http://www.ubuntu.com/products/whatisubuntu/derivatives
http://www.ubuntu.com/products/whatisubuntu/derivatives
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Using Ubuntu Netbook Edition
Ubuntu Netbook Edition is a version of Ubuntu designed specifically for
netbook computers. It is optimized for computing devices with small screens
and limited resources (like the energy-saving processors and smaller hard
disks common among netbooks). Ubuntu Netbook Edition sports a unique
interface and features a collection of soware applications particularly useful
to on-the-go users.

Because many netbooks do not contain cd-rom drives, Ubuntu Netbook
Remix allows users to install it on their computers using USB flash drives. To
learn more about using a flash drive to install Ubuntu Netbook Edition on
a netbook computer, visit https://help.ubuntu.com/community/Installation/
FromImgFiles.

Using Ubuntu Server Edition
e Ubuntu Server Edition is an operating system optimized to perform multi-
user tasks. Su tasks include file sharing and website or email hosting. If you
are planning to use a computer to perform tasks like these, you may wish to
use a specialized server distribution in conjunction with server hardware. It
is possible to run a server distribution on a desktop computer, but we recom-
mend doing this only for testing purposes.

is manual does not cover the process of running a secure webserver or
performing other tasks possible with Ubuntu Server Edition. For details on us-
ing Ubuntu Server Edition, refer to the manual at (hp://www.ubuntu.com/products/whatIsubuntu/serveredition).

Using Ubuntu Studio
is derivative of Ubuntu is designed specifically for people who use comput-
ers to create and edit multimedia projects. For instance, it features applica-
tions to help users manipulate images, create musical compositions, and edit
video. While users can install these applications on computers running the
desktop version of Ubuntu, Ubuntu Studio makes them all available immedi-
ately upon installation.

If you would like to learn more about this derivative of Ubuntu (or obtain a
copy for yourself), visit http://ubuntustudio.org/home.

Using Mythbuntu
Mythbuntu allows users to turn their computers into entertainment systems.
It helps users organize and view various types of multimedia content—like
movies, television shows, or video podcasts. Users with TV tuners in their
computers can also use Mythbuntu to record live video.

To learn more about Mythbuntu, visit http://www.mythbuntu.org/.

https://help.ubuntu.com/community/Installation/FromImgFiles
https://help.ubuntu.com/community/Installation/FromImgFiles
http://ubuntustudio.org/home
http://www.mythbuntu.org/
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 bit or  bit?
As mentioned earlier in this manual, Ubuntu and its derivatives are available
in two versions: -bit and -bit. is difference refers to the way computers
process information. Computers capable of running -bit soware process
information using more memory than computers running -bit soware.
ese computers can gain performance enhancements by running -bit
soware.

Why oose one over another? Pay aention to the version you select in
the following cases:

‣ If your computer is fairly old (made before ), then you may want to
install the -bit version of Ubuntu. is is also the case for most netbooks.

‣ If your computer has more than GB of memory (ram), then you may need
to install the -bit version in order to use all the installed memory.

Learning even more
is manual is not intended as an introduction to everything you might
wish to do with your Ubuntu computer. For more information regarding
specialized tasks, please see the official Ubuntu documentation available either
through the blue help and support icon, or at http://help.ubuntu.com.

http://help.ubuntu.com


A License
THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF
THIS CREATIVE COMMONS PUBLIC LICENSE (“CCPL” OR “LICENSE”).
THE WORK IS PROTECTED BY COPYRIGHT AND/OR OTHER APPLI-
CABLE LAW. ANY USE OF THE WORK OTHER THAN AS AUTHORIZED
UNDER THIS LICENSE OR COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU
ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE.
TO THE EXTENT THIS LICENSE MAY BE CONSIDERED TO BE A CON-
TRACT, THE LICENSOR GRANTS YOU THE RIGHTS CONTAINED HERE
IN CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND
CONDITIONS.

. Definitions
(a) “Adaptation” means a work based upon the Work, or upon the Work

and other pre-existing works, su as a translation, adaptation, deriva-
tive work, arrangement of music or other alterations of a literary or
artistic work, or phonogram or performance and includes cinemato-
graphic adaptations or any other form in whi the Work may be recast,
transformed, or adapted including in any form recognizably derived
from the original, except that a work that constitutes a Collection will
not be considered an Adaptation for the purpose of this License. For the
avoidance of doubt, where the Work is a musical work, performance
or phonogram, the synronization of the Work in timed-relation with
a moving image (“syning”) will be considered an Adaptation for the
purpose of this License.

(b) “Collection” means a collection of literary or artistic works, su as
encyclopedias and anthologies, or performances, phonograms or broad-
casts, or other works or subject maer other than works listed in Sec-
tion (f) below, whi, by reason of the selection and arrangement of
their contents, constitute intellectual creations, in whi the Work is
included in its entirety in unmodified form along with one or more
other contributions, ea constituting separate and independent works
in themselves, whi together are assembled into a collective whole. A
work that constitutes a Collection will not be considered an Adaptation
(as defined below) for the purposes of this License.

(c) “Creative Commons Compatible License” means a license that is listed
at http://creativecommons.org/compatiblelicenses that has been ap-
proved by Creative Commons as being essentially equivalent to this
License, including, at a minimum, because that license: (i) contains

http://creativecommons.org/compatiblelicenses
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terms that have the same purpose, meaning and effect as the License
Elements of this License; and, (ii) explicitly permits the relicensing of
adaptations of works made available under that license under this Li-
cense or a Creative Commons jurisdiction license with the same License
Elements as this License.

(d) “Distribute” means to make available to the public the original and
copies of the Work or Adaptation, as appropriate, through sale or other
transfer of ownership.

(e) “License Elements” means the following high-level license aributes as
selected by Licensor and indicated in the title of this License: Aribu-
tion, ShareAlike.

(f) “Licensor” means the individual, individuals, entity or entities that
offer(s) the Work under the terms of this License.

(g) “Original Author” means, in the case of a literary or artistic work, the
individual, individuals, entity or entities who created the Work or if
no individual or entity can be identified, the publisher; and in addition
(i) in the case of a performance the actors, singers, musicians, dancers,
and other persons who act, sing, deliver, declaim, play in, interpret or
otherwise perform literary or artistic works or expressions of folklore;
(ii) in the case of a phonogram the producer being the person or legal
entity who first fixes the sounds of a performance or other sounds;
and, (iii) in the case of broadcasts, the organization that transmits the
broadcast.

(h) “Work” means the literary and/or artistic work offered under the terms
of this License including without limitation any production in the liter-
ary, scientific and artistic domain, whatever may be the mode or form
of its expression including digital form, su as a book, pamphlet and
other writing; a lecture, address, sermon or other work of the same na-
ture; a dramatic or dramatico-musical work; a oreographic work or
entertainment in dumb show; a musical composition with or without
words; a cinematographic work to whi are assimilated works ex-
pressed by a process analogous to cinematography; a work of drawing,
painting, aritecture, sculpture, engraving or lithography; a photo-
graphic work to whi are assimilated works expressed by a process
analogous to photography; a work of applied art; an illustration, map,
plan, sket or three-dimensional work relative to geography, topogra-
phy, aritecture or science; a performance; a broadcast; a phonogram; a
compilation of data to the extent it is protected as a copyrightable work;
or a work performed by a variety or circus performer to the extent it is
not otherwise considered a literary or artistic work.

(i) “You” means an individual or entity exercising rights under this License
who has not previously violated the terms of this License with respect to
the Work, or who has received express permission from the Licensor to
exercise rights under this License despite a previous violation.
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(j) “Publicly Perform” means to perform public recitations of the Work and
to communicate to the public those public recitations, by any means
or process, including by wire or wireless means or public digital per-
formances; to make available to the public Works in su a way that
members of the public may access these Works from a place and at a
place individually osen by them; to perform the Work to the public
by any means or process and the communication to the public of the
performances of the Work, including by public digital performance;
to broadcast and rebroadcast the Work by any means including signs,
sounds or images.

(k) “Reproduce” means to make copies of the Work by any means includ-
ing without limitation by sound or visual recordings and the right of
fixation and reproducing fixations of the Work, including storage of a
protected performance or phonogram in digital form or other electronic
medium.

. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or
restrict any uses free from copyright or rights arising from limitations or
exceptions that are provided for in connection with the copyright protec-
tion under copyright law or other applicable laws.

. License Grant. Subject to the terms and conditions of this License, Licensor
hereby grants You a worldwide, royalty-free, non-exclusive, perpetual (for
the duration of the applicable copyright) license to exercise the rights in the
Work as stated below:
(a) to Reproduce the Work, to incorporate the Work into one or more Col-

lections, and to Reproduce the Work as incorporated in the Collections;
(b) to create and Reproduce Adaptations provided that any su Adapta-

tion, including any translation in any medium, takes reasonable steps to
clearly label, demarcate or otherwise identify that anges were made
to the original Work. For example, a translation could be marked “e
original work was translated from English to Spanish,” or a modification
could indicate “e original work has been modified.”;

(c) to Distribute and Publicly Perform the Work including as incorporated
in Collections; and,

(d) to Distribute and Publicly Perform Adaptations.
(e) For the avoidance of doubt:

i. Non-waivable Compulsory License Semes. In those jurisdictions
in whi the right to collect royalties through any statutory or com-
pulsory licensing seme cannot be waived, the Licensor reserves the
exclusive right to collect su royalties for any exercise by You of the
rights granted under this License;

ii. Waivable Compulsory License Semes. In those jurisdictions in
whi the right to collect royalties through any statutory or com-
pulsory licensing seme can be waived, the Licensor waives the
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exclusive right to collect su royalties for any exercise by You of the
rights granted under this License; and,

iii. Voluntary License Semes. e Licensor waives the right to collect
royalties, whether individually or, in the event that the Licensor is a
member of a collecting society that administers voluntary licensing
semes, via that society, from any exercise by You of the rights
granted under this License.

e above rights may be exercised in all media and formats whether
now known or hereaer devised. e above rights include the right to
make su modifications as are tenically necessary to exercise the
rights in other media and formats. Subject to Section (f), all rights not
expressly granted by Licensor are hereby reserved.

. Restrictions. e license granted in Section  above is expressly made
subject to and limited by the following restrictions:
(a) You may Distribute or Publicly Perform the Work only under the terms

of this License. You must include a copy of, or the Uniform Resource
Identifier (URI) for, this License with every copy of the Work You Dis-
tribute or Publicly Perform. You may not offer or impose any terms on
the Work that restrict the terms of this License or the ability of the re-
cipient of the Work to exercise the rights granted to that recipient under
the terms of the License. You may not sublicense the Work. You must
keep intact all notices that refer to this License and to the disclaimer of
warranties with every copy of the Work You Distribute or Publicly Per-
form. When You Distribute or Publicly Perform the Work, You may not
impose any effective tenological measures on the Work that restrict
the ability of a recipient of the Work from You to exercise the rights
granted to that recipient under the terms of the License. is Section
(a) applies to the Work as incorporated in a Collection, but this does
not require the Collection apart from the Work itself to be made sub-
ject to the terms of this License. If You create a Collection, upon notice
from any Licensor You must, to the extent practicable, remove from the
Collection any credit as required by Section (c), as requested. If You
create an Adaptation, upon notice from any Licensor You must, to the
extent practicable, remove from the Adaptation any credit as required
by Section (c), as requested.

(b) You may Distribute or Publicly Perform an Adaptation only under the
terms of: (i) this License; (ii) a later version of this License with the
same License Elements as this License; (iii) a Creative Commons juris-
diction license (either this or a later license version) that contains the
same License Elements as this License (e.g., Aribution-ShareAlike .
US)); (iv) a Creative Commons Compatible License. If you license the
Adaptation under one of the licenses mentioned in (iv), you must com-
ply with the terms of that license. If you license the Adaptation under
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the terms of any of the licenses mentioned in (i), (ii) or (iii) (the “Ap-
plicable License”), you must comply with the terms of the Applicable
License generally and the following provisions: (I) You must include
a copy of, or the URI for, the Applicable License with every copy of
ea Adaptation You Distribute or Publicly Perform; (II) You may not
offer or impose any terms on the Adaptation that restrict the terms of
the Applicable License or the ability of the recipient of the Adaptation
to exercise the rights granted to that recipient under the terms of the
Applicable License; (III) You must keep intact all notices that refer to the
Applicable License and to the disclaimer of warranties with every copy
of the Work as included in the Adaptation You Distribute or Publicly
Perform; (IV) when You Distribute or Publicly Perform the Adapta-
tion, You may not impose any effective tenological measures on the
Adaptation that restrict the ability of a recipient of the Adaptation from
You to exercise the rights granted to that recipient under the terms of
the Applicable License. is Section (b) applies to the Adaptation as
incorporated in a Collection, but this does not require the Collection
apart from the Adaptation itself to be made subject to the terms of the
Applicable License.

(c) If You Distribute, or Publicly Perform the Work or any Adaptations
or Collections, You must, unless a request has been made pursuant to
Section (a), keep intact all copyright notices for the Work and provide,
reasonable to the medium or means You are utilizing: (i) the name of
the Original Author (or pseudonym, if applicable) if supplied, and/or if
the Original Author and/or Licensor designate another party or parties
(e.g., a sponsor institute, publishing entity, journal) for aribution
(“Aribution Parties”) in Licensor’s copyright notice, terms of service
or by other reasonable means, the name of su party or parties; (ii) the
title of the Work if supplied; (iii) to the extent reasonably practicable,
the URI, if any, that Licensor specifies to be associated with the Work,
unless su URI does not refer to the copyright notice or licensing
information for the Work; and (iv) , consistent with Ssection (b), in
the case of an Adaptation, a credit identifying the use of the Work
in the Adaptation (e.g., “Fren translation of the Work by Original
Author,” or “Screenplay based on original Work by Original Author”).
e credit required by this Section (c) may be implemented in any
reasonable manner; provided, however, that in the case of a Adaptation
or Collection, at a minimum su credit will appear, if a credit for all
contributing authors of the Adaptation or Collection appears, then
as part of these credits and in a manner at least as prominent as the
credits for the other contributing authors. For the avoidance of doubt,
You may only use the credit required by this Section for the purpose
of aribution in the manner set out above and, by exercising Your
rights under this License, You may not implicitly or explicitly assert or
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imply any connection with, sponsorship or endorsement by the Original
Author, Licensor and/or Aribution Parties, as appropriate, of You
or Your use of the Work, without the separate, express prior wrien
permission of the Original Author, Licensor and/or Aribution Parties.

(d) Except as otherwise agreed in writing by the Licensor or as may be
otherwise permied by applicable law, if You Reproduce, Distribute or
Publicly Perform the Work either by itself or as part of any Adaptations
or Collections, You must not distort, mutilate, modify or take other
derogatory action in relation to the Work whi would be prejudicial to
the Original Author’s honor or reputation. Licensor agrees that in those
jurisdictions (e.g. Japan), in whi any exercise of the right granted in
Section (b) of this License (the right to make Adaptations) would be
deemed to be a distortion, mutilation, modification or other derogatory
action prejudicial to the Original Author’s honor and reputation, the
Licensor will waive or not assert, as appropriate, this Section, to the
fullest extent permied by the applicable national law, to enable You to
reasonably exercise Your right under Section (b) of this License (right
to make Adaptations) but not otherwise.

. Representations, Warranties and Disclaimer
UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN
WRITING, LICENSOR OFFERS THE WORK AS-IS AND MAKES NO
REPRESENTATIONS OR WARRANTIES OF ANY KIND CONCERN-
ING THE WORK, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE,
INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE, MER-
CHANTIBILITY, FITNESS FOR A PARTICULAR PURPOSE, NONIN-
FRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS,
ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER
OR NOT DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW
THE EXCLUSION OF IMPLIED WARRANTIES, SO SUCH EXCLUSION
MAY NOT APPLY TO YOU.

. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY AP-
PLICABLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU
ON ANY LEGAL THEORY FOR ANY SPECIAL, INCIDENTAL, CONSE-
QUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES ARISING OUT OF
THIS LICENSE OR THE USE OF THE WORK, EVEN IF LICENSOR HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

. Termination

(a) is License and the rights granted hereunder will terminate automati-
cally upon any brea by You of the terms of this License. Individuals or
entities who have received Adaptations or Collections from You under
this License, however, will not have their licenses terminated provided
su individuals or entities remain in full compliance with those li-
censes. Sections , , , , , and  will survive any termination of this
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License.
(b) Subject to the above terms and conditions, the license granted here is

perpetual (for the duration of the applicable copyright in the Work).
Notwithstanding the above, Licensor reserves the right to release the
Work under different license terms or to stop distributing the Work at
any time; provided, however that any su election will not serve to
withdraw this License (or any other license that has been, or is required
to be, granted under the terms of this License), and this License will
continue in full force and effect unless terminated as stated above.

. Miscellaneous

(a) Ea time You Distribute or Publicly Perform the Work or a Collection,
the Licensor offers to the recipient a license to the Work on the same
terms and conditions as the license granted to You under this License.

(b) Ea time You Distribute or Publicly Perform an Adaptation, Licensor
offers to the recipient a license to the original Work on the same terms
and conditions as the license granted to You under this License.

(c) If any provision of this License is invalid or unenforceable under ap-
plicable law, it shall not affect the validity or enforceability of the re-
mainder of the terms of this License, and without further action by the
parties to this agreement, su provision shall be reformed to the mini-
mum extent necessary to make su provision valid and enforceable.

(d) No term or provision of this License shall be deemed waived and no
brea consented to unless su waiver or consent shall be in writing
and signed by the party to be arged with su waiver or consent.

(e) is License constitutes the entire agreement between the parties with
respect to the Work licensed here. ere are no understandings, agree-
ments or representations with respect to the Work not specified here.
Licensor shall not be bound by any additional provisions that may ap-
pear in any communication from You. is License may not be modified
without the mutual wrien agreement of the Licensor and You.

(f) e rights granted under, and the subject maer referenced, in this
License were draed utilizing the terminology of the Berne Conven-
tion for the Protection of Literary and Artistic Works (as amended on
September , ), the Rome Convention of , the WIPO Copyright
Treaty of , the WIPO Performances and Phonograms Treaty of 
and the Universal Copyright Convention (as revised on July , ).
ese rights and subject maer take effect in the relevant jurisdiction in
whi the License terms are sought to be enforced according to the cor-
responding provisions of the implementation of those treaty provisions
in the applicable national law. If the standard suite of rights granted
under applicable copyright law includes additional rights not granted
under this License, su additional rights are deemed to be included in
the License; this License is not intended to restrict the license of any
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rights under applicable law.

Creative Commons Notice
Creative Commons is not a party to this License, and makes no warranty
whatsoever in connection with the Work. Creative Commons will not be
liable to You or any party on any legal theory for any damages whatsoever,
including without limitation any general, special, incidental or consequential
damages arising in connection to this license. Notwithstanding the foregoing
two () sentences, if Creative Commons has expressly identified itself as the
Licensor hereunder, it shall have all rights and obligations of Licensor.

Except for the limited purpose of indicating to the public that the Work is
licensed under the CCPL, Creative Commons does not authorize the use by
either party of the trademark “Creative Commons” or any related trademark
or logo of Creative Commons without the prior wrien consent of Creative
Commons. Any permied use will be in compliance with Creative Commons’
then-current trademark usage guidelines, as may be published on its website
or otherwise made available upon request from time to time. For the avoid-
ance of doubt, this trademark restriction does not form part of the License.

Creative Commons may be contacted at http://creativecommons.org/.

http://creativecommons.org/


Glossary
Canonical Canonical, the financial baer of Ubuntu, provides support for

the core Ubuntu system. It has over  paid staff members worldwide
who ensure that the foundation of the operating system is stable, as well as
eing all the work submied by volunteer contributors. To learn more
about Canonical, go to http://www.canonical.com.. 

http://www.canonical.com
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